Revision Table

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Author</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Apr 14, 2004</td>
<td>JKC</td>
<td>Initial version of manual</td>
</tr>
<tr>
<td>1.1</td>
<td>Aug 5, 2004</td>
<td>JKC</td>
<td>Updated for version 5.0</td>
</tr>
<tr>
<td>1.2</td>
<td>Apr 7, 2005</td>
<td>JKC</td>
<td>Updated for version 5.1</td>
</tr>
<tr>
<td>1.3</td>
<td>Jan 3, 2006</td>
<td>JKC</td>
<td>Updated for version 5.2</td>
</tr>
<tr>
<td>1.4</td>
<td>Apr 3, 2007</td>
<td>JKC</td>
<td>Updated for version 5.3/6.0</td>
</tr>
<tr>
<td>1.5</td>
<td>Aug 13, 2007</td>
<td>JKC</td>
<td>Replaced Basic 3D plug-in for ResolutionMD 3D plug-in</td>
</tr>
<tr>
<td>1.6</td>
<td>July 31, 2008</td>
<td>JKC</td>
<td>Updated for version 6.1</td>
</tr>
<tr>
<td>1.7</td>
<td>Oct 8, 2009</td>
<td>JKC</td>
<td>Updated for version 6.2</td>
</tr>
<tr>
<td>1.8</td>
<td>Jul 13, 2011</td>
<td>JKC</td>
<td>Updated for version 7.0</td>
</tr>
<tr>
<td>1.9</td>
<td>Jan 13, 2012</td>
<td>JKC</td>
<td>Updated for version 7.1</td>
</tr>
<tr>
<td>2.0</td>
<td>Mar 13, 2013</td>
<td>JKC</td>
<td>Updated for version 7.2</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

**1 INTRODUCTION** ........................................................................................................... 1

1.1 **GENERAL SAFETY INFORMATION** ................................................................. 1

1.2 **INDICATIONS OF USE** ...................................................................................... 1

1.3 **PATIENT CONTACT** .......................................................................................... 1

1.4 **PRODUCT SAFETY** .......................................................................................... 2

1.5 **CONTACT INFORMATION** ............................................................................... 2

1.6 **ABBREVIATIONS** ............................................................................................. 2

1.7 **REFERENCES** .................................................................................................... 2

**2 GETTING STARTED** .................................................................................................... 3

2.1 **WORKSTATION SETUP** ..................................................................................... 3

2.1.1 **Adjusting Monitor Configuration** ............................................................... 4

2.1.2 **Configuring Multiple Monitors** ................................................................. 4

2.2 **ACCESSING eRAD PACS SERVER** ................................................................. 4

2.2.1 **Initiating a Browser Session** ...................................................................... 5

2.2.2 **Signing On From The Browser** ............................................................... 5

2.2.3 **Signing On From The Viewer** .................................................................. 6

2.3 **INSTALLING THE eRAD PACS VIEWER** .................................................... 6

2.3.1 **Administrator Assisted Viewer Installation** ............................................. 6

2.3.2 **Installing Active-X Viewer** .................................................................. 7

2.3.3 **Installing Standalone Viewer** ................................................................. 8

2.3.4 **Updating The Active-X Viewer** ............................................................. 8

2.4 **UNINSTALLING THE eRAD PACS VIEWER** .................................................. 8

**3 VIEWER OVERVIEW** .................................................................................................... 9

3.1 **TOOLBARS** ....................................................................................................... 9

3.1.1 **Standard Toolbar** ....................................................................................... 10

3.1.2 **Toolbox Toolbar** ......................................................................................... 11

3.1.3 **Orientation Toolbar** ................................................................................... 12

3.1.4 **Window/Level Toolbar** ............................................................................ 12

3.1.5 **Annotation Toolbar** .................................................................................. 13

3.1.6 **Grid Layout Toolbar** ................................................................................ 13

3.1.7 **Tile Layout Toolbar** .................................................................................. 14

3.1.8 **Template Toolbar** ...................................................................................... 14

3.1.9 **Report Formatting Toolbar** ...................................................................... 14

3.1.10 **Cine Control Toolbar** ............................................................................. 15

3.1.11 **Link Control Toolbar** ............................................................................. 15

3.1.12 **Audio Control Toolbar** .......................................................................... 15

3.1.13 **Presentation Toolbar** ............................................................................... 16

3.1.14 **Macro Toolbar** ......................................................................................... 16

3.1.15 **CTRM Toolbar** ....................................................................................... 16

3.1.16 **Status Bar** ............................................................................................... 17

3.2 **MENUS** .............................................................................................................. 17

3.2.1 **File Menu** .................................................................................................. 17

3.2.2 **View Menu** ............................................................................................... 17

3.2.3 **Settings Menu** .......................................................................................... 18

3.2.4 **Tools Menu** .............................................................................................. 19

3.2.5 **Cine Menu** ................................................................................................ 20

3.2.6 **Collaboration Menu** ................................................................................ 20

3.2.7 **Help Menu** ................................................................................................ 21

3.2.8 **Post-processing Menu** ............................................................................ 21

3.2.9 **Speech Recognition Menu** ..................................................................... 21

3.2.10 **Context Menu** ......................................................................................... 21
3.3 IMAGE VIEWING AREA .................................................................................................................. 21
3.4 THUMBNAIL PANEL ...................................................................................................................... 21
  3.4.1 Thumbnail Panel Headers ........................................................................................................... 23
3.5 STATUS BAR .................................................................................................................................. 23
3.6 INDEPENDENT POPUP PANELS .................................................................................................. 23
  3.6.1 Layout Manager .......................................................................................................................... 24
  3.6.2 Information Panel ....................................................................................................................... 24
  3.6.3 Report Panel ................................................................................................................................ 25
  3.6.4 Print Panel .................................................................................................................................. 26
  3.6.5 Patient Folder .............................................................................................................................. 26
3.7 PLUG-IN MODULES ....................................................................................................................... 29
3.8 DISPLAY MODES ............................................................................................................................ 29
  3.8.1 Full Screen Mode ....................................................................................................................... 29
  3.8.2 Calibration Mode ....................................................................................................................... 30
3.9 MOUSE OPERATIONS ..................................................................................................................... 30
  3.9.1 Cursor Modes ............................................................................................................................. 30
  3.9.2 Mouse Functions ......................................................................................................................... 32
3.10 HOT KEYS AND MACROS ............................................................................................................ 33
3.11 RUNNING THE VIEWER.................................................................................................................. 34
   3.11.1 Starting and Terminating the Active-X Viewer ......................................................................... 34
   3.11.2 Starting and Terminating the Standalone Viewer .................................................................... 34

4 CONFIGURATION SETTINGS AND OPTIONS .................................................................................... 37
  4.1 CUSTOMIZE SETTINGS WINDOW ................................................................................................ 37
   4.1.1 General Settings ......................................................................................................................... 37
   4.1.2 View Settings ............................................................................................................................. 39
   4.1.3 Layout Settings ......................................................................................................................... 40
   4.1.4 Image Settings .......................................................................................................................... 42
   4.1.5 DICOM Settings ....................................................................................................................... 43
   4.1.6 Hash Mark Settings ................................................................................................................... 45
   4.1.7 Prefetch Settings ....................................................................................................................... 46
   4.1.8 Cache Settings .......................................................................................................................... 47
   4.1.9 Color Settings ........................................................................................................................... 47
   4.1.10 Memory Settings ..................................................................................................................... 49
   4.1.11 Advanced Settings ................................................................................................................... 49
   4.1.12 Spine Tool Settings ................................................................................................................ 51
   4.1.13 Dictation Settings .................................................................................................................... 52
   4.1.14 Speech Recognition Settings .................................................................................................. 53
   4.1.15 Presentation State Settings .................................................................................................... 54
  4.2 USER PROFILES ........................................................................................................................... 54
   4.2.1 Creating User Profiles ............................................................................................................. 55
   4.2.2 Applying User Profiles ............................................................................................................. 55
  4.3 PRESETS .......................................................................................................................................... 55
   4.3.1 Window Width and Center ........................................................................................................ 55
   4.3.2 Hanging Protocols .................................................................................................................... 56
  4.4 KEYBOARD MACROS ................................................................................................................... 59
  4.5 PRESTAGING ............................................................................................................................... 60
   4.5.1 Prefetching ................................................................................................................................. 60
   4.5.2 Auto-Routing ............................................................................................................................ 61
  4.6 SYSTEM MANAGEMENT ................................................................................................................ 61
   4.6.1 Monitor Calibration .................................................................................................................... 61
   4.6.2 Emptying cache ........................................................................................................................ 62
   4.6.3 Running other programs ......................................................................................................... 62
   4.6.4 Licensing .................................................................................................................................. 62
   4.6.5 Permissions – open rights, report rights .................................................................................. 62
   4.6.6 Network Transfer Optimization ............................................................................................... 63
5 DISPLAYING IMAGES ........................................................................................................... 65

5.1 OPENING A STUDY ........................................................................................................... 65
5.1.1 Opening a Study from the Study List Panel ................................................................. 65
5.1.2 Opening a Study in the Active-X Viewer ................................................................. 66
5.1.3 Opening A Study From The Patient Folder ............................................................. 67
5.1.4 Opening Next and Previous Study ............................................................................ 67
5.1.5 Save Current Workspace to Open Another Study ..................................................... 67
5.1.6 Study Locking and Read-only Mode ........................................................................ 68

5.2 ORGANIZING THE STUDY DATA .................................................................................. 68
5.2.1 Loading Images from the Thumbnail Panel ............................................................... 68
5.2.2 Layout Manager ......................................................................................................... 69
5.2.3 Hanging Protocols ..................................................................................................... 70
5.2.4 Applying User-specified Prior to Current Layout ..................................................... 70

5.3 THE VIEWING AREA ....................................................................................................... 71
5.3.1 Grid Layouts ................................................................................................................ 71
5.3.2 Tile Layouts .................................................................................................................. 72
5.3.3 Full Screen Mode ......................................................................................................... 72

5.4 MANAGING SERIES ...................................................................................................... 73
5.4.1 Grouping and Ungrouping Series ............................................................................. 73
5.4.2 Sorting Series ............................................................................................................. 74
5.4.3 Linking Series ............................................................................................................. 74

5.5 MANAGING IMAGES .................................................................................................... 75
5.5.1 Stack Mode Scrolling ................................................................................................. 75
5.5.2 Windowing and Leveling ............................................................................................ 76
5.5.3 VOI LUTs ..................................................................................................................... 77
5.5.4 Presentation States ..................................................................................................... 78
5.5.5 Image Zoom ................................................................................................................ 80
5.5.6 Flip and Rotate ........................................................................................................... 82
5.5.7 Image Cropping ......................................................................................................... 82
5.5.8 Image Stitching .......................................................................................................... 82
5.5.9 Mask Subtraction ....................................................................................................... 84
5.5.10 Calibration ................................................................................................................ 84
5.5.11 Magic X Position Locators .................................................................................... 85
5.5.12 Post-processed Images ............................................................................................ 86

5.6 WARNING INDICATORS ............................................................................................... 87
5.6.1 Image Compression ................................................................................................... 87
5.6.2 Image Not Intended for Diagnostic Interpretation .................................................... 87

5.7 CLOSING A STUDY ........................................................................................................ 87
5.7.1 Terminating The Viewer ............................................................................................ 88

6 OVERLAYS AND ANNOTATIONS ....................................................................................... 89

6.1 OVERLAYS ....................................................................................................................... 89
6.1.1 Text Overlays ............................................................................................................. 89
6.1.2 Orientation Markers ................................................................................................. 90
6.1.3 Scale Rulers ............................................................................................................... 90
6.1.4 Localizers Lines and Hash Marks ........................................................................... 91
6.1.5 Embedded Overlays ................................................................................................ 91
6.1.6 Orthogonal Image Overlays ..................................................................................... 92
6.1.7 Mammography CAD Overlays ................................................................................. 92

6.2 ANNOTATIONS ................................................................................................................ 93
6.2.1 Text Annotations ....................................................................................................... 93
6.2.2 Measurement Annotations ....................................................................................... 94
6.2.3 Hounsfield Unit Annotations .................................................................................... 95
6.2.4 Report Image Numbering .......................................................................................... 95
6.2.5 Pointer Graphic Annotation ...................................................................................... 95
## 7 Plug-in Modules

### 7.1 Multi-planar Reconstruction Plug-in

### 7.2 AVI Plug-In

### 7.3 Image Fusion Plug-In

#### 7.3.1 Fusion Frame Layout

#### 7.3.2 Image Manipulation

#### 7.3.3 Annotations

#### 7.3.4 Saving Images

#### 7.3.5 Configuration

#### 7.3.6 Keyboard Control Summary

## 8 Reports

### 8.1 Displaying Reports

#### 8.1.1 Displaying Report Text

#### 8.1.2 Displaying Attachments

### 8.2 Creating a Report

#### 8.2.1 Text Reports

#### 8.2.2 Canned Report Templates

#### 8.2.3 Dictation

#### 8.2.4 Speech Recognition

#### 8.2.5 Addendums

#### 8.2.6 Restoring a Report

### 8.3 Key Images

#### 8.3.1 Attaching Key Images

#### 8.3.2 Modifying Key Images

#### 8.3.3 Printing Key Images

#### 8.3.4 Removing Key Images

### 8.4 Submitting Reports

## 9 User Collaboration

## 10 Saving Data

### 10.1 Saving JPEG Images

### 10.2 Saving DICOM Images

## 11 Printing

### 11.1 Print Panel

### 11.2 Print Layout Templates

#### 11.2.1 Creating a Print Layout Template

#### 11.2.2 Applying a Print Layout Template

#### 11.2.3 Deleting a Print Layout Template

### 11.3 DICOM Printing

#### 11.3.1 True Size Printing

### 11.4 Windows Printing

### 11.5 Printing Reports

## 12 Online Help and Troubleshooting

### 12.1 Online Help

### 12.2 Activity Logs

### 12.3 Crash Logs
1 Introduction

eRAD PACS™ is a picture archive and communication system (PACS) and teleradiology system used to receive DICOM images, scheduling information and text reports, organize and store them in an internal format, and make that information available across a network via web and customized user interfaces. eRAD PACS is for hospitals, imaging centers, radiologist reading practices and any user who requires and is granted access to patient image, demographic and report information. eRAD PACS provides information management and distribution services. The system is comprised of acquisition components, a central system manager component, diagnostic and review workstation components and an archiving component.

The sections that follow provide instructions on installing, configuring and using the eRAD PACS viewer. Operator instructions for all versions of the viewing application are contained in this document.

1.1 General Safety Information

eRAD PACS system components are not approved for direct patient contact applications.

Do not operate the eRAD PACS system components and associated cables in the presence of moisture.

To avoid excessive product leakage and maintain product compliance to medical protective guidance requirements, the PACS and workstations power cords shall be connected directly to hardwired AC receptacles.

Federal law prohibits this device from being sold to or used by anyone other than a medical professional.

Do not carry the eRAD PACS system components by the connecting cables.

Follow all safety labels on the equipment.

1.2 Indications of Use

eRAD PACS is a PACS software product used to receive DICOM images, scheduling information and textual report, organize and store them in an internal format, and to make that information available across a network via web and customized user interfaces.

The eRAD PACS viewer software is intended for use as a primary diagnostic and analysis tool for diagnostic images. eRAD PACS is for hospitals, imaging centers, radiologists, reading practices and any user who requires and is granted access to patient image, demographic and report information.

The eRAD PACS viewer displays images from CT, computed radiography, MRI, mammography, nuclear medicine, PET, secondary capture, ultrasound, x-ray angiography, x-ray fluoroscopy and visible light modalities.

Lossy compressed mammography images and digitized film screen mammography images must not be reviewed for primary image interpretations. Mammography images may only be interpreted using an FDA approved monitor that offers at least 5 mega-pixel resolution and meets other technical specifications reviewed and accepted by FDA.

1.3 Patient Contact

The PACS system components are not approved for direct patient contact applications. The user must follow hospital cleaning and decontamination policies and procedures.
1.4 Product Safety
The eRAD PACS system has been classified as an acceptable application of use in accordance with Medical Device regulations. The use of accessory equipment and/or hardware not complying with the equivalent product safety and EMC requirements of this product may lead to a reduced level of safety and/or EMC performance of the resulting system.

1.5 Contact Information
For more information concerning eRAD PACS, or to report a problem with this manual or the software, contact technical support.

United States/North America
9 Pilgrim Road
Greenville, SC 29607-5701
Office: +1.864.234.7430
Support: +1.866.414.3723
FAX: +1.864.234.7412

Europe
Varosmajor u. 13
Budapest H-1122, Hungary
Voice: +36.1.489.4700
FAX: +36.1.489.4709

1.6 Abbreviations
The following abbreviations are used throughout this document:

DICOM...... Digital Imaging Communications in Medicine
HL7 .......... Health Level 7
EP ............ eRAD PACS

1.7 References
The information contained in this manual references information from other sources, including eRAD PACS’s online help and other paper documents. Refer to the following sources of information for additional details on eRAD PACS viewer and server components.

- eRAD PACS Operator Manual
- eRAD PACS browser’s online help
- eRAD PACS viewer’s online help
2 Getting Started

The eRAD PACS viewer is an application that displays diagnostic quality medical images for review by radiologists, clinicians and other healthcare personnel. Access to the data generated during an imaging procedure requires a validated user session. The information in this section provides instructions for setting up your workstation for eRAD PACS and initiating a user session. The instructions that follow assume you have access to a workstation that satisfies the minimum required configuration.

eRAD PACS viewers have the following system requirements:

<table>
<thead>
<tr>
<th>System Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>32-bit or 64-bit Microsoft Windows 2000, XP or 7</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>512MB</td>
</tr>
<tr>
<td>Recommended RAM</td>
<td>1GB or twice the size of the largest study loaded into the viewer at one time. 2GB if the fusion or AVI plug-ins are used.</td>
</tr>
<tr>
<td>Recommended graphics controller features</td>
<td>For default EP viewer, Direct3D 9.0 and PixelShader 2.0, or later versions.</td>
</tr>
<tr>
<td>Browsers</td>
<td>IE 7.0 or later, Mozilla 5.0 or later</td>
</tr>
<tr>
<td>Network</td>
<td>A networked PC with a connection to the eRAD PACS server</td>
</tr>
</tbody>
</table>

eRAD PACS consists of two viewing applications. They are the active-X viewer and the standalone viewer. The active-X viewer is a viewing application a user downloads and installs on any compliant workstation. The active-X workstation executes alongside other applications running on the same workstation.

The standalone viewer is designed to operate without communicating with an eRAD PACS server. This version of the viewing application is used almost exclusively from a removable CD or DVD, and displays only the study information contained on the CD/DVD media.

Both viewing applications share the same graphical user interface and offer similar toolsets. With few exceptions, the instructions for setting up and controlling these viewing applications are the same. When the instructions for one differ from the other, this manual makes note of the exception and provides specific details concerning the feature.

2.1 Workstation Setup

Before starting, the workstation must be removed from its shipping package, assembled according to the manufacturer’s instructions, powered on, and configured to boot up and allow a user to log on. Furthermore, this manual assumes the workstation has access to the local area network or the Internet, whichever is required. If the workstation does not meet these minimum requirements, contact your system administrator, computer manufacturer or ISP for further assistance preparing your workstation for eRAD PACS.

The eRAD PACS viewer executes on supported Microsoft Windows platforms. The default workstation configuration is often suitable. The area that most often requires modification is the monitor and its display controller. eRAD PACS supports single and multiple monitor configurations, and a variety of bit depths and resolutions. The instructions in this section describe how to set up Microsoft Windows monitors to run eRAD PACS.

There are differences between Windows operating systems that may impact the information contained in this manual. By default, all Windows operations are shown for Windows 2000.
2.1.1 Adjusting Monitor Configuration

Before initiating eRAD PACS, make sure your Microsoft Windows monitor settings are configured for the best results. Your workstation should be configured for a 32-bit color map or the highest possible color map if 32-bit is not available. For a single landscape monitor, it is best to set the screen resolution for each monitor to at least 1280 by 1024. Smaller resolutions are supported if necessary.

To check or change the resolution on your Windows computer:

- Open the display settings panel from the desktop by right clicking on a blank area and selecting Properties. You can also open the display setting window from the Windows Control Panel.
- Select the Settings tab.
- Adjust the resolution with the slider bar under Screen Area. The recommended screen resolution is 1280 by 1024 pixels.
- Set the Colors drop down to 32-bit color, or the highest possible setting.
- Click Apply, and then OK. When prompted to save the settings, click OK.

If you are using a display controller with its own setup page, click on Advanced and then select the tab that corresponds to the display controller. Follow the instructions in the display controller documentation to set up the monitor.

2.1.2 Configuring Multiple Monitors

The eRAD PACS viewer supports one to four monitors. Each monitor can run at different resolutions. It is possible to mix color and grayscale monitors as well.

eRAD PACS uses the Microsoft Windows display settings to identify the monitors. In the Display Properties window, when more than one monitor is available, Windows labels them, starting with ‘1’ and continuing up to the maximum number available. Use these numeric labels when configuring monitors in eRAD PACS as described in section 4.1.1.

For multiple monitor configurations, you can set the display settings for multiple, independent Microsoft Windows environments on each monitor, or a single Windows environment that spans across all monitors. If you select the single Windows environment, you will have to configure the eRAD PACS viewer so it knows to split its user interface properly across the monitors. Refer to section 4.1.1 for information on configuring monitors in eRAD PACS.

2.2 Accessing eRAD PACS Server

eRAD PACS is a web-enabled system that the user accesses with a web browser. As a result, many of the familiar conventions you find when visiting other web sites are available in eRAD PACS. There is the home page, which is usually the first page you encounter when you gain access to the server. Most of the system’s information is collected in a hierarchy of other pages that you access by clicking on hyperlinks. You can click on the browser’s Back button to return to the previous page. You can save a particular page in your Favorites folder. You can even create a link to the eRAD PACS on another web page.

The eRAD PACS server is organized by a set of tabs displayed across the top of the browser window. The specific tabs that are available to you depend on the privileges your system administrator assigned to your user account. The first row of tabs provides access to the general functional areas. Examples include Worklist, Administration and Archive. The eRAD PACS viewer is available to the information displayed on the Worklist page.
2.2.1 INITIATING A BROWSER SESSION

To use the eRAD PACS active-X viewer, you need a workstation connected to a network with access to the eRAD PACS server, and a supported web browser. Launch the web browser and enter the URL of the eRAD PACS server into the address line. The URL depends on your facility’s configuration. If it is not configured as the browser’s home address, ask your system administrator for the URL. The URL can be a hostname or an IP address. The following examples are all acceptable eRAD PACS URLs:

pacs.hospital.com
http://pacs.hospital.com
https://192.168.0.1

When the browser reaches the eRAD PACS server, it displays the Main page. Figure 2.2-1 shows eRAD PACS’s default Main page. Note that your main page may appear different due to customization.

Regardless of which URL you entered, eRAD PACS forces your connection to use secure HTTP if the server is configured to provide secure communications to your workstation. If HTTPS is required, you may be prompted to verify the digital certificate. You can find instructions on how to accept the digital certificate and save it as a trusted key in your browser in the eRAD PACS Operator’s Manual.

2.2.2 SIGNING ON FROM THE BROWSER

To sign on to the eRAD PACS server, you must possess a unique user account, assigned by your system administrator. The user account is used to identify you throughout the system. This allows eRAD PACS to download your personal profile from the server, providing you with the same custom interface regardless of your location. eRAD PACS also uses your account information to tag your actions automatically, so you do not have to explicitly enter your identification information each time you create, modify or delete data.

All versions of the Main page contain sign on fields on the left side of the page as well as a series of tabs near the top and running the width of the page. The tabs are used to access different eRAD PACS pages. Before you sign on, the only pages available are the Main page and the Info page.

Enter your User ID and password in the fields on eRAD PACS’s Main page. Note that both the User ID and password are case sensitive. By default, eRAD PACS takes you to the Worklist page after it verifies your account information. If you wish to go to a different page, chose your preferred starting point from the pull-down menu just beneath the account ID and password fields. Click on Sign On, or press the return key, to continue.

**Instruction Summary – Signing On**

- Launch Internet Explorer or other supported browser.
- Enter your eRAD PACS server URL from your Favorites list, or by typing the IP address into the address textbox.
- Enter your User ID and password. Both are case sensitive.
- Click the Sign On Button.
2.2.3 Signing On From The Viewer

It is possible to log out of eRAD PACS while a study is displayed in the viewer. You can explicitly request to log out from the browser, or the eRAD PACS can automatically log you out after a period of inactivity. If the eRAD PACS viewer is open when this happens, a login prompt appears on your screen. To log into eRAD PACS, enter the password for the account displayed in the Name field, and click Sign On. Note that both the User ID and password are case sensitive.

If you want to change the user account, cancel the popup window, and log on from the browser, or use the Sign On item in the File menu.

2.3 Installing the eRAD PACS Viewer

The different eRAD PACS viewer applications have slightly differing installation procedures. The sections below provide instructions for downloading the viewer initially, and for upgrading to a new version when one is available.

The active-X viewer requires specific user privileges from eRAD PACS. These are defined in the user account section of the eRAD PACS Operator Manual. Differences exist when downloading the viewer setup package depending on the browser version or operating system you use. While the wording or figures may be different than shown in this manual, the general procedure is the same.

To install an application on a supported Windows workstation, the Windows user account must have Windows Administrator or Power User privileges. Sometimes it is easier to run the eRAD PACS viewer setup program as an administrator while logged on as the current user, rather than logging in as an admin. For instructions on how to run the setup program as an administrator in Windows, see section 2.3.1.

2.3.1 Administrator Assisted Viewer Installation

On Windows systems, your Windows user account must have administrator or power user privileges in order for you to install the eRAD PACS viewer. In most cases, the system administrator will log into Windows using an account with these privileges to install the viewer. Sometimes, it is easier to instruct Windows to install eRAD PACS viewer with an administrator account’s privileges using the current account. Windows provides this function with the Run As command.

To use the Run As command, you need to know the ID and password of an account with administrator privileges, but you do not have to log out of Windows. Follow these instructions to install eRAD PACS using the Run As command.

1. Download the eRAD PACS viewer by selecting the Download Viewer tab on the worklist page, and select to save it to your workstation.
2. Locate the file, eradsetup.exe, using Windows Explorer, the Microsoft Management Console (MMC), or the Control Panel.
3. Press and hold down the SHIFT key as you right-click the file icon, and select Run As from the popup menu.
4. In the dialog box, select the option Run the program as the following user, and enter the user name and password of a Windows account that has administrator privileges.
5. Click OK to start the installation process.

The install process proceeds as described in the section detailing the installation procedure for the specific viewer you are installing or upgrading.
2.3.2 Installing Active-X Viewer

To download and install the eRAD PACS active-X viewer, your eRAD PACS user account must have Open privileges, which your system administrator can assign to you. If you have Open privileges, eRAD PACS checks for the viewer on the workstation and attempts to install it automatically if it is not found.

After logging onto eRAD PACS, go to the Worklist page. A popup notice may appear on the screen. If you do not have Windows administrator rights, the notice informs you that the viewer is unavailable and instructs you to contact the system administrator to download and install a copy onto the workstation. If you have Windows administrator rights, the notice prompts you to download and install the latest viewer. When you consent to the upgrade, eRAD PACS downloads the viewer and invokes the installation wizard. Depending on your version of Windows, you have the option to download and store the eRAD PACS setup file and activate it manually, or download and activate (Open) it when complete. There is no need to save the setup file to disk. Select to open the file when the download completes.

In some instances, eRAD PACS initiates the viewer installation process without prompting the user. This occurs when the workstation is running certain versions of Microsoft Windows and when using certain versions of Microsoft Internet Explorer. When the download completes, the installation wizard starts automatically.

To manually download and install a copy of the eRAD PACS viewer, click the Download Viewer tab in the second row of tabs under the Worklist tab. eRAD PACS downloads the viewer and invokes the installation wizard. If prompted, chose to open the file when the download completes.

The eRAD PACS installation wizard takes you through the installation process step by step. Figure 2.3-1 shows the initial screen of the installation wizard. The process is as follows:

1. The installation wizard launches. Read the panel, take any necessary actions. Press the Ctrl and Esc keys simultaneously to view the task bar if you need to quit any other applications. It is not required to quit the browser. Click Next.
2. Read the License Agreement, check the box to accept the terms, and click Next.
3. If the default location for eRAD PACS is acceptable, click Next. Otherwise, select a new location and click Next.
4. Click Finish when the install is completed.

The viewer automatically starts. Its icon, 📞, appears in the system tray. If it didn’t start, either open a study or manually start the viewer by selecting it from the Program Files menu under the Start button in the task bar.

Instruction Summary – Downloading the Viewer

1. Log onto the eRAD PACS server and go to the Worklist page.
2. If prompted to download the viewer, click Yes. Otherwise, click the Download Viewer tab.
3. If prompted to save or open, select Open. When the download completes, select Open to run the setup program.
4. Installation wizard takes you through the setup. Accept the terms, click on the Next button to advance, and click Finish to complete.
5. Single-click on a patient name to launch the viewer and load the images.
2.3.3 Installing Standalone Viewer
The eRAD PACS standalone viewer is used most frequently to display images stored on removable DICOM media such as a CD or DVD. You can create removable media containing images, results, and an application to display them by following the instructions in the eRAD PACS Operator’s Manual. The information in this section assumes the media was created according to the instructions in that manual.

The eRAD PACS standalone viewer doesn’t get installed on the workstation. Instead, it loads directly from the media. Load the media onto your workstation. If you have the Windows auto play feature enabled, the standalone viewer automatically launches itself. If you have disabled auto play from launching the standalone viewer, start the viewer manually. Open a Windows Explorer window and browse through the removable media drive for the file named pbcdeview.exe. Click OK to start the eRAD PACS standalone viewer.

If a copy of the eRAD PACS active-X viewer resides on the same workstation, the eRAD PACS standalone viewer does not affect it. In order for the standalone viewer to execute properly, the media must remain in the drive at all times.

Note: Removing the media from the drive when running the eRAD PACS standalone viewer may cause the application to lock up. While the application is loaded, the media must remain in the drive at all times.

2.3.4 Updating The Active-X Viewer
Upgrades to eRAD PACS take place on the server. The workstation learns of an upgrade the next time it communicates with the server. This communication takes place when a user logs on to eRAD PACS, or even in the middle of an existing user session.

The first time you refresh your worklist after an eRAD PACS upgrade, a popup notice may appear on the screen for users with Windows administrator rights. The notice asks if you want to download and install the latest viewer. Perform the upgrade as soon as possible. The option to skip an upgrade is available so you can download and install it when convenient. If you clear the notice without installing the viewer, eRAD PACS will prompt you once each day until you do upgrade.

When you consent to the upgrade in this manner, eRAD PACS downloads the viewer and invokes the installation wizard. Follow the prompts on the screen to complete the upgrade.

For users without Windows administrator rights, the upgrade procedure is performed from the viewer itself. After opening a study, the viewer checks for a newer version. If one exists, a popup window prompts the user to download it. Check the box labeled Upgrade eRAD PACS Viewer version N, and click OK. Then proceed to work on the opened study. When you are finished and close the viewer, the upgrade procedure starts. Follow the prompts on the screen to complete the upgrade.

On occasion, an eRAD PACS viewer upgrade is mandatory in order for it to communicate with the upgraded server. When this condition exists, the prompt to upgrade is not displayed. The download and install process initiates immediately when you access the worklist the first time after the server has been upgraded.

2.4 Uninstalling the eRAD PACS Viewer
To remove the eRAD PACS viewer from your workstation, use the Windows Add/Remove Programs tool.
1. Open the Windows Control Panel. From Start, select Settings and then Control Panel.
2. Click Add or Remove Programs.
3. Select eRAD PACS Viewer on the list and click Remove. Follow any prompts that appear.
3 Viewer Overview

All versions of the eRAD PACS viewer contain the same basic components. They consist of the main screen workspace, which contains the area for displaying images, the menu bar, the docked toolbars, the thumbnail panel and the status bar. Figure 3-1 illustrates the basic parts of the eRAD PACS viewer.

The sections in this chapter provide information on the many components and constructs that make up the eRAD PACS viewer.

3.1 Toolbars

There is an assortment of toolbars in eRAD PACS viewer. Most of the toolbars are available from the main viewer workspace. A few are specific to one or more popup windows that you can display at various times when using the viewer. The toolbars are defined as follows:

- **Standard**: Basic study and file control tools
- **Toolbox**: Cursor modes and general viewer control tools
- **Orientation**: Image orientation tools
- **Window/Level**: Window width and center controls
- **Annotation**: Annotation modes
- **Grid layouts**: General grid layouts
- **Tile layouts**: Tile modes for each frame in a grid
- **Templates**: Hanging protocol template controls
- **Report formatting**: Format report text
- **Cine controls**: Cine display controls
- **Link controls**: Frame linking controls
- **Audio controls**: Audio controls for dictation tools
- **Status bar**: Dynamic status information
From the View menu, select the Toolbars item to display a list of available toolbars. If a check appears next to the label, the toolbar is displayed in the main workspace. The toolbar is either docked to the workspace’s border, or floating as a detached window somewhere on the monitor. Display toolbars on a more permanent basis by selecting them in the Settings panel in the Customize Settings window. (See section 4.1.1 for more information.) To hide a toolbar, select the item from the Toolbar item in the View menu to remove the check mark, or uncheck the setting on the Settings panel in the Customize Settings window.

Some toolbars are also available in different eRAD PACS viewer panels. To display a toolbar in the respective panel, select the toolbar from the View menu item in the panel. For more information, refer to the section in the manual that discusses the specific panel.

To relocate a toolbar in the eRAD PACS viewer’s main workspace, click the surrounding gray area and drag the toolbar to the desired location. To dock a toolbar to the workspace border, click and drag it back to any location outside the main image area. The toolbar snaps back into place.

To show/hide a toolbar for this session only:
1. From the View menu, click on Toolbars, and select the toolbar you want to display. A checkmark appears by the name when the toolbar is displayed on your screen.

To show/hide a toolbar for this and future sessions:
1. Select Customize Settings from the Settings menu.
2. Click the Settings tab to view the setting panel.
3. In the Toolbars section, click the checkbox to insert a check mark for the toolbar(s) you want to display.
4. To hide a toolbar, click the checkbox to clear the check mark for the toolbar(s) you want to hide.

3.1.1 Standard Toolbar

The Standard toolbar provides tools for opening and closing studies. It contains buttons to display a list of studies available for display, close a study, open the next and previous studies, bookmark the current study, and restore a bookmarked study. By default, the Standard toolbar is not displayed on the main screen. To display the Standard toolbar, select Standard from the Toolbar item in the View menu at the top of the main screen. All the functions controlled by the buttons on the Standard toolbar are also available from the File menu, and in some cases via hot key sequences.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show study list</td>
<td><img src="image" alt="Show study list" /></td>
<td>View→Study Panel</td>
<td>F2</td>
<td>Display the list of available studies. In the active-X viewer, this function displays the browser's worklist. In the standalone viewer and in registered active-X viewers, this function displays the Study List panel.</td>
</tr>
<tr>
<td>Close study</td>
<td><img src="image" alt="Close study" /></td>
<td>File→Close study</td>
<td></td>
<td>Close all the studies that are currently loaded in the viewer.</td>
</tr>
<tr>
<td>Bookmark study</td>
<td><img src="image" alt="Bookmark study" /></td>
<td>File→Bookmark</td>
<td>Ctrl-Alt-B</td>
<td>Save the display state of the current study or studies, and allow the user to open a new study. Refer to section 5.1.5 for more information. All works in progress, including report, dictation, key images, and annotations are preserved. Bookmarking is recursive, using a last-in, first-out order.</td>
</tr>
<tr>
<td>Restore bookmarked study</td>
<td><img src="image" alt="Restore bookmarked study" /></td>
<td>File→Restore</td>
<td>Ctrl-Alt-R</td>
<td>Close the current study and restore the last bookmarked study.</td>
</tr>
</tbody>
</table>
3.1.2 TOOLBOX TOOLBAR

The Toolbox toolbar provides tools for setting the eRAD PACS viewer’s cursor mode, adjusting the image magnification ratio, resetting the display characteristics of an image frame, and displaying the report panel. The various buttons are grouped into two main groupings, the cursor modes and the display characteristics. To display the Toolbox toolbar, select Toolbox from the Toolbar item in the View menu at the top of the main screen. The functions available in the Toolbox toolbar are also available from the Settings and Tools menus, and in some cases via hot key sequences.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal mode</td>
<td></td>
<td>Settings→Cursor→Normal</td>
<td>Ctrl-N</td>
<td>This is the general cursor mode, used to select an image or object within the display. Refer to section 3.9.1.1 for more information.</td>
</tr>
<tr>
<td>Magnify mode</td>
<td></td>
<td>Settings→Cursor→Magnify</td>
<td>Ctrl-M</td>
<td>Magnify the image. Left-click to apply an automatic zoom factor. Right-click to define a zoom region. Refer to section 3.9.1.2 for more information.</td>
</tr>
<tr>
<td>Key image mode</td>
<td></td>
<td>Settings→Cursor→Report attachment</td>
<td></td>
<td>Attach the selected image along with its current display settings and annotations to the report. Refer to section 3.9.1.3 for more information.</td>
</tr>
<tr>
<td>Link mode</td>
<td></td>
<td>Settings→Cursor→Cine link</td>
<td></td>
<td>Link one or more image frames together. Double-click the Link mode button to automatically link all related frames. Single-click the Link mode button, and then click and drag the cursor between two frames to manually link the data. Refer to section 3.9.1.4 for more information.</td>
</tr>
<tr>
<td>ROI with W/L mode</td>
<td></td>
<td>Settings→Cursor→ROI with W/L</td>
<td></td>
<td>Define a region of interest and apply the calculated window/level curve within it to the image(s) in the frame. Click and drag the mouse to define the region of interest. Drag the region around to position it. Refer to section 3.9.1.5 for more information.</td>
</tr>
<tr>
<td>Crop mode</td>
<td></td>
<td>Settings→Cursor→Cropping</td>
<td></td>
<td>Remove extraneous information from the viewable image in the frame. Click and drag the mouse to define the area to keep. Resize the area by dragging the region’s borders. Double-click on the image to restore the original image. Refer to section 3.9.1.6 for more information.</td>
</tr>
<tr>
<td>Magic X mode</td>
<td></td>
<td>Settings→Cursor→Magic X</td>
<td></td>
<td>Locate a defined point in one image on all other images that share the same frame of reference. Refer to section 3.9.1.7 for more information.</td>
</tr>
<tr>
<td>Magic glass mode</td>
<td></td>
<td>View→Magic Glass</td>
<td>Alt-M</td>
<td>Display a floating magnifying glass for zooming in on the image data behind it. Refer to section 3.9.1.8 for more information.</td>
</tr>
<tr>
<td>Fit image to window</td>
<td></td>
<td>Tools→Zoom→Fit to window</td>
<td>Ctrl-F</td>
<td>Fit the selected image to the size of the frame. This is also useful to reset the image size after using magnification and cropping tools.</td>
</tr>
</tbody>
</table>
### 3.1.3 Orientation Toolbar

The Orientation toolbar provides tools for flipping and rotating images. To display the Toolbox toolbar, select Orientation Tools from the Toolbar item in the View menu at the top of the main screen. The functions available in the Orientation toolbar are also available from the Tools menus, and via hot key sequences.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip horizontal</td>
<td></td>
<td>Tools→Transform→Flip horizontally</td>
<td>Ctrl-H</td>
<td>Flip image(s) in selected frame horizontally.</td>
</tr>
<tr>
<td>Flip vertical</td>
<td></td>
<td>Tools→Transform→Flip vertically</td>
<td>Ctrl-U</td>
<td>Flip image(s) in selected frame vertically</td>
</tr>
<tr>
<td>Rotate right</td>
<td></td>
<td>Tools→Transform→Rotate right</td>
<td>Ctrl-R</td>
<td>Rotate image(s) in selected frame to the right 90°.</td>
</tr>
<tr>
<td>Rotate left</td>
<td></td>
<td>Tools→Transform→Rotate left</td>
<td>Ctrl-L</td>
<td>Rotate image(s) in selected frame to the left 90°.</td>
</tr>
<tr>
<td>Flip overlay text</td>
<td></td>
<td>Tools→Transform→Flip image info</td>
<td></td>
<td>Flip the text overlay horizontally.</td>
</tr>
</tbody>
</table>

### 3.1.4 Window/Level Toolbar

The Window/Level toolbar provides tools for adjusting an image’s window center and window width. The toolbar consists of text boxes for reporting the current window/level settings and explicitly defining them, sliders for quickly adjusting them, and a text box for creating and applying preset window/level settings. To display the Window/Level toolbar, select Window/Level from the Toolbar item in...
the View menu at the top of the main screen. Adjusting the window and level setting is also available through mouse controls.

The left slider bar controls the window width. The right slider bar controls the window center. The drop-down menu allows you to select a predefined window/level settings and create a label for the current settings. Some defaults always exist, including Initial, and Actual Range. See section 4.3.1 for information on creating and applying preset window and level values.

### 3.1.5 Annotation Toolbar

The Annotation toolbar provides tools for adding graphics and measurements to images. You can add annotated text to a key image attached to a report, identify a specific region of interest (ROI), and calculate the average Hounsfield unit within a region of interest. In addition, you can draw pointers to a specific viewing area within an image, and use the measuring tools for determining the distance and angle between two points on an image. To display the Annotations toolbar, select Annotation Tools from the Toolbar item in the View menu at the top of the main screen. The functions available in the Annotation toolbar are also available from the Settings menus, and via mouse controls.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation mode</td>
<td></td>
<td>Settings→Cursor→Annotation→Select</td>
<td>General annotation mode, used for adding new annotation, and for selecting existing ones for editing and deleting. When in this cursor mode, spin the middle mouse button to flip through the individual annotation tools. Refer to section 6.1.5 for more information.</td>
</tr>
<tr>
<td>Distance measurement</td>
<td></td>
<td>Settings→Cursor→Annotation→Measure distance</td>
<td>Perform linear measurements. The image must be calibrated in order for the results to appear in units of distance.</td>
</tr>
<tr>
<td>Angle measurement</td>
<td></td>
<td>Settings→Cursor→Annotation→Measure angle</td>
<td>Perform angular measurements.</td>
</tr>
<tr>
<td>Cobb angle measurement</td>
<td></td>
<td>Settings→Cursor→Annotation→Measure Cobb angle</td>
<td>Calculate and display a Cobb angle.</td>
</tr>
<tr>
<td>Hounsfield value</td>
<td></td>
<td>Settings→Cursor→Annotation→Hounsfield value</td>
<td>Calculates and displays the average pixel value within the defined area.</td>
</tr>
<tr>
<td>Region of interest area</td>
<td></td>
<td>Settings→Cursor→Annotation→Region of interest</td>
<td>Calculates the area within the defined region of interest. The image must be calibrated in order for the results to appear in units of area.</td>
</tr>
<tr>
<td>Free form region of interest area</td>
<td></td>
<td>Settings→Cursor→Annotation→Freehand region</td>
<td>Calculates the area within the defined region of interest. The image must be calibrated in order for the results to appear in units of area.</td>
</tr>
<tr>
<td>Add pointer</td>
<td></td>
<td>Settings→Cursor→Annotation→Pointer</td>
<td>Add a point graphic and an optional text string to the image.</td>
</tr>
<tr>
<td>Add text</td>
<td></td>
<td>Settings→Cursor→Annotation→Text</td>
<td>Define a text string and place it on the image.</td>
</tr>
<tr>
<td>Key image index number</td>
<td></td>
<td>Settings→Cursor→Annotation→Report figure number</td>
<td>Display a sequential number on the key image. This annotation tool is available only when applied to a key image in the report panel.</td>
</tr>
<tr>
<td>Spine labeling tool</td>
<td></td>
<td>Settings→Cursor→Annotation→Spine labeling tool</td>
<td>Display labels identifying vertebral disks and interspaces.</td>
</tr>
</tbody>
</table>

### 3.1.6 Grid Layout Toolbar

The Grid Layout toolbar provides preset matrices for displaying series in the main viewing workspace. This toolbar is available by default in the layout manager, and can be displayed in the main viewing area as well. The majority of the preset matrix options...
split the screen into symmetrical groups of image frames. The custom grid button, ✎, pops up a window so you can define a custom grid by specifying the number of rows and columns you want to appear in the workspace area. The ✎ button is used to apply a single grid layout across multiple monitors. For example, if you use a 1-up grid layout with a 12-up tile layout, you get 12 images displayed on the current screen, similar to a sheet of film displaying CT images. If you want the 12-up to continue onto a second monitor, select the span multiple monitor button, and the second monitor displays the second set of 12 images.

To display the Grid Layout toolbar, select Grid layouts from the Toolbar item in the View menu at the top of the main screen. In the layout manager, select Grid layouts from the View menu.

### 3.1.7 **Tile Layout Toolbar**

![Tile Layout Toolbar](image)

The Tile Layout toolbar applies a tile pattern to a selected frame, controlling the number of images displayed in the frame. This toolbar is available by default in the layout manager, and can be displayed in the main viewing area as well. With a 1-up tile mode, the image frame displays the images in stack mode, facilitating cine operations. For any other tile mode, the specified number of images appears in the frame. When you scroll through the images, one image is removed from the displayed set, the remaining images shift up or down, and one image is added. The custom tile button, ✎, allows you to define a custom tile setting by specifying the number of rows and columns you want to appear in the workspace.

To display the Tile Layout toolbar, select Tile layouts from the Toolbar item in the View menu at the top of the main screen. In the layout manager, select Tile layouts from the View menu.

### 3.1.8 **Template Toolbar**

![Template Toolbar](image)

The Template toolbar contains a list of available hanging protocol templates and template sets. To display the Template toolbar, select Templates from the Toolbar item in the View menu at the top of the main screen. In the layout manager, select Templates from the View menu.

To apply a template to the loaded study, click the pull-down list and select the template. To save the current layout as a template, click in the text box, enter the label, and click to save. To create a hanging protocol set, click the create HP set button, select the templates to add to the set, enter a label, and save. To advance to the next template in an applied set, click the next HP set button.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>✎</td>
<td>Save the current layout as a hanging protocol template.</td>
</tr>
<tr>
<td>Create HP set</td>
<td>✎</td>
<td>Create a hanging protocol set from existing hanging protocol templates.</td>
</tr>
<tr>
<td>Modify HP set</td>
<td>✎</td>
<td>Edit an existing hanging protocol set.</td>
</tr>
<tr>
<td>Next HP set</td>
<td>✎</td>
<td>Go to the next template in this applied hanging protocol set.</td>
</tr>
<tr>
<td>Previous HP set</td>
<td>✎</td>
<td>Go to the previous template in this applied hanging protocol set.</td>
</tr>
</tbody>
</table>

### 3.1.9 **Report Formatting Toolbar**

![Report Formatting Toolbar](image)

The Report Formatting toolbar exists in the report panel, and contains text format controls. The available controls are the text font type and size, bold, italic, underline, strikethrough, superscript, subscript, text alignment, bulleted and numbered lists, indentation, color, separator, tables and show encoded source. The formatting toolbar appears above any rich-text area, such as the report's observation area.
3.1.10 CINE CONTROL TOOLBAR

The Cine toolbar provides controls for automatic playback of a cine loop. This toolbar consists of a Play/Stop button, speed controls and a loop direction control. To display the Cine toolbar, select Cine control from the Toolbar item in the View menu at the top of the main screen. The Cine toolbar is also available from the Cine menu, along with menu items for the functions found on the toolbar.

3.1.11 LINK CONTROL TOOLBAR

The Link toolbar provides controls for linking one or more image frames together. Section 5.4.3 contains information on creating and using links.

To display the Link toolbar, select Link controls from the Toolbar item in the View menu at the top of the main screen. Link controls are also available from the mouse.

<table>
<thead>
<tr>
<th>Function</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto link state</td>
<td>Auto</td>
<td>Auto link state is active. Series automatically link when loaded into image frames.</td>
</tr>
<tr>
<td>Link group</td>
<td>&lt;pull down list&gt;</td>
<td>The link group assigned to the selected frame.</td>
</tr>
<tr>
<td>Mirror mode</td>
<td>Mirror</td>
<td>The cursor movement in linked frames mirror each other.</td>
</tr>
<tr>
<td>Magic glass mode</td>
<td>Magic glass</td>
<td>Each linked frame displays a Magic Glass panel.</td>
</tr>
<tr>
<td>Unhook link</td>
<td>Unhook</td>
<td>Temporarily suspend link functions for the frame.</td>
</tr>
</tbody>
</table>

3.1.12 AUDIO CONTROL TOOLBAR

The Audio toolbar on the full report panel provides controls for recording and playing back dictation.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Audio</td>
<td>Start and stop recording.</td>
<td></td>
</tr>
<tr>
<td>Activate speech recognition</td>
<td>Audio</td>
<td>Activate third-party speech recognition system by writing the XML control file to the configured location.</td>
<td></td>
</tr>
<tr>
<td>Activate speech recognition and record dictation</td>
<td>Audio</td>
<td>Activate third-party speech recognition system by writing the XML control file to the configured location and start and stop recording dictation.</td>
<td></td>
</tr>
<tr>
<td>Play</td>
<td>Audio</td>
<td>Play the recording from the current position, or from the beginning if already at the end.</td>
<td></td>
</tr>
<tr>
<td>Pause</td>
<td>Audio</td>
<td>Pause the recording at its current position.</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Audio</td>
<td>Delete from the current position to the end of the recording.</td>
<td></td>
</tr>
<tr>
<td>Position</td>
<td></td>
<td>The position in the recording in seconds</td>
<td></td>
</tr>
<tr>
<td>Speed</td>
<td></td>
<td>The playback speed. A value of 1.00 replays at the acquired rate. Slow down/speed up playback by shifting the gauge to the left/right, respectively.</td>
<td></td>
</tr>
<tr>
<td>Strength</td>
<td></td>
<td>The strength of the input signal the software is receiving. If an acceptable level is detected, the gauge displays green. Otherwise, no data is being recorded.</td>
<td></td>
</tr>
</tbody>
</table>
3.1.13 PRESENTATION TOOLBAR

The presentation toolbar provides access to a number of image presentation tools. To display the presentation toolbar, select Presentation tools from the Toolbar item in the View menu at the top of the main screen.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show all localizer lines</td>
<td>✎</td>
<td>Settings→Localizers→Show localizer lines on all images</td>
<td>F12</td>
<td>Display the localizer line(s) of selected images on orthogonal images</td>
</tr>
<tr>
<td>Hide all localizer lines</td>
<td>✎</td>
<td>Settings→Localizers→Hide localizer lines on all images</td>
<td>F12</td>
<td>Hide localizer lines</td>
</tr>
<tr>
<td>Show all hash marks</td>
<td>✎</td>
<td>Settings→Localizers→Show hash marks on all images</td>
<td>Alt+F12</td>
<td>Display the localizer lines for all images in the selected series on orthogonal images</td>
</tr>
<tr>
<td>Hide all hash marks</td>
<td>✎</td>
<td>Settings→Localizers→Hide hash marks on all images</td>
<td>Alt+F12</td>
<td>Hide all localizer lines</td>
</tr>
<tr>
<td>Show image info</td>
<td>☰</td>
<td>View→Show image info</td>
<td>F10</td>
<td>Show/hide the demographic overlay data</td>
</tr>
<tr>
<td>Show scout overlays</td>
<td>☰</td>
<td>View→Show scout overlays</td>
<td>Ctrl+F11</td>
<td>Show/hide scout images a overlays on select images in an image frame</td>
</tr>
<tr>
<td>Show orientation</td>
<td>☰</td>
<td>View→Show orientation</td>
<td>F11</td>
<td>Show/hide the orientation markers on images in an image frame</td>
</tr>
<tr>
<td>Show orientation cube</td>
<td>☰</td>
<td></td>
<td>Alt+F11</td>
<td>Show/hide the orientation cube on images in an image frame</td>
</tr>
<tr>
<td>Step scale rulers</td>
<td>☰</td>
<td>View→Show scale</td>
<td>Ctrl+F10</td>
<td>Show/hide the scale rulers in image frames</td>
</tr>
<tr>
<td>Show annotations</td>
<td>☰</td>
<td>View→Show annotations</td>
<td>F9</td>
<td>Show/hide annotations</td>
</tr>
<tr>
<td>Show mammography CAD</td>
<td>☰</td>
<td></td>
<td></td>
<td>Show/hide mammography CAD markers</td>
</tr>
<tr>
<td>Show overlays</td>
<td>☰</td>
<td>View→Show overlays</td>
<td>Ctrl+F9</td>
<td>Show/hide image overlays defined for images displayed in an image frame</td>
</tr>
<tr>
<td>Show presentation state</td>
<td>☰</td>
<td>File→Create presentation state</td>
<td></td>
<td>Show/hide presentation state details (overlays, annotations, etc.) for images displayed in an image frame</td>
</tr>
</tbody>
</table>

3.1.14 MACRO TOOLBAR

The macro toolbar provides access to the macro manager panel and tools for recording macros. Display the macro toolbar by selecting Macro Tools from the Toolbar item in the View menu. The macro tools are also available from the Settings menu’s Macros submenu.

<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start recording</td>
<td>☰</td>
<td>Settings→Macros→Start recording</td>
<td>Start recording input sequence.</td>
</tr>
<tr>
<td>Stop recording</td>
<td>☰</td>
<td>Settings→Macros→Stop recording</td>
<td>Stop recording input sequence.</td>
</tr>
</tbody>
</table>

3.1.15 CTRM TOOLBAR

The CTRM toolbar provides access to the critical test results management tools. It consists of a single button that launches the CTRM panel. The CTRM toolbar exists if the server is licensed for CTRM support and the user is assigned the CTRM user permission.

For details about the CTRM feature, refer to the Radar Critical Test Results Management section.
3.1.16 STATUS BAR

The Status Bar displays status messages as eRAD PACS performs some action. The status bar location is fixed, at the bottom of the screen. It displays the current working state, the loading progress, and the coordinates of the cursor in an image. Section 3.4.1 explains the information available on the Status Bar.

3.2 Menus

The eRAD PACS viewer menus at the top of the application window organize all of the functions and configuration tools. The list includes the File menu, View menu, Settings menu, Tools menu, Cine menu, Collaboration menu, and the Help menu. Additional menus may exist depending on the plug-in modules eRAD PACS loads when it initializes. An example is the Post-processing menu. Information on conditional menus is available in Chapter 7. Other menus exist in the different eRAD PACS panels, although many of them are repeated or subsets from the main application window, included on the panel for convenience. Using the mouse, left-click on the menu label at the top of the screen to reveal the available options and submenus.

The eRAD PACS viewer menus are available as a popup menu, accessible from anywhere in the main viewer workspace. To display a popup menu, position the cursor over the main workspace and click the right mouse button. The popup menu disappears when you click any mouse button. If you are using a single-button mouse, hold down the Shift key and click the mouse button to display a popup menu.

3.2.1 FILE MENU

eRAD PACS’s File menu provides access to functions to sign on and off, open and close study files, bookmarking and restoring bookmarked sessions, saving images to files, printing images to Microsoft Windows and DICOM-compatible printers, clearing the eRAD PACS viewer cache, connect to collaboration session, and terminate the viewer session.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>For details, see …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open previous study</td>
<td>Ctrl+Alt+Up</td>
<td>Section 5.1.3</td>
</tr>
<tr>
<td>Open next study</td>
<td>Ctrl+Alt+Down</td>
<td>Section 5.1.3</td>
</tr>
<tr>
<td>Close study</td>
<td></td>
<td>Section 5.7</td>
</tr>
<tr>
<td>Close views</td>
<td></td>
<td>Section 5.7</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Ctrl+Alt+B</td>
<td>Section 5.1.5</td>
</tr>
<tr>
<td>Restore</td>
<td>Ctrl+Alt+R</td>
<td>Section 5.1.5</td>
</tr>
<tr>
<td>Create presentation state</td>
<td></td>
<td>Section 5.5.4</td>
</tr>
<tr>
<td>Send presentation state</td>
<td></td>
<td>Section 5.5.4</td>
</tr>
<tr>
<td>Update plug-ins</td>
<td></td>
<td>Section 7</td>
</tr>
<tr>
<td>Send image/series</td>
<td></td>
<td>Section 5.5.12.1</td>
</tr>
<tr>
<td>Delete image/series</td>
<td></td>
<td>Section 5.5.12.1</td>
</tr>
<tr>
<td>Save image</td>
<td>Ctrl+Shift+I</td>
<td>Section 10.1</td>
</tr>
<tr>
<td>Save series</td>
<td>Ctrl+Shift+S</td>
<td>Section 10.1</td>
</tr>
<tr>
<td>Copy image to clipboard</td>
<td>Ctrl+Shift+C</td>
<td>Section 10.1</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
<td>Section 11</td>
</tr>
<tr>
<td>Empty cache</td>
<td></td>
<td>Section 4.1.8</td>
</tr>
<tr>
<td>Sign on …</td>
<td></td>
<td>Section 2.2.3</td>
</tr>
<tr>
<td>Sign off</td>
<td></td>
<td>Section 2.2.3</td>
</tr>
<tr>
<td>Connect to collaboration …</td>
<td>Ctrl+Alt+C</td>
<td>Section 9</td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl+Q</td>
<td>Section 5.7.1</td>
</tr>
</tbody>
</table>

3.2.2 VIEW MENU

eRAD PACS’s View menu provides access to the toolbars, individual panels, the panning magnifying glass, and controls for displaying and hiding different image overlays.
### 3.2.3 Settings Menu

eRAD PACS’s Settings menu provides access to the customized settings window where you can customize the viewer characteristics, select a cursor mode, calibrate the image and monitor, change the grid and tile layouts, modify the localizer lines settings, and set series-specific settings.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>For details, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize Settings</td>
<td></td>
<td>Section 4.1</td>
</tr>
<tr>
<td>Cursor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td>Ctrl+N</td>
<td>Section 3.9.1.1</td>
</tr>
<tr>
<td>Magnifier</td>
<td>Ctrl+M</td>
<td>Section 3.9.1.2, 5.5.5</td>
</tr>
<tr>
<td>Report attachment</td>
<td></td>
<td>Section 3.9.1.3, 8.3.1</td>
</tr>
<tr>
<td>Cine link</td>
<td></td>
<td>Section 3.9.1.4, 5.4.3</td>
</tr>
<tr>
<td>ROI with W/L</td>
<td></td>
<td>Section 3.9.1.5, 5.5.2</td>
</tr>
<tr>
<td>Cropping</td>
<td></td>
<td>Section 3.9.1.6, 5.5.7</td>
</tr>
<tr>
<td>Magic X</td>
<td></td>
<td>Section 3.9.1.7, 5.5.11</td>
</tr>
<tr>
<td>Annotations</td>
<td></td>
<td>Section 3.9.1.9</td>
</tr>
<tr>
<td>Distance</td>
<td></td>
<td>Section 6.2.2</td>
</tr>
<tr>
<td>Angle</td>
<td></td>
<td>Section 6.2.2</td>
</tr>
<tr>
<td>Cobb angle</td>
<td></td>
<td>Section 6.2.2</td>
</tr>
<tr>
<td>Hounsfield value</td>
<td></td>
<td>Section 6.2.3</td>
</tr>
</tbody>
</table>
### Menu Item | Shortcut | For details, see ...
--- | --- | ---
Region of interest |  | Section 6.2.2
Freehand region of interest |  | Section 6.2.2
Pointer |  | Section 6.2.5
Text |  | Section 6.2.1
Report figure number |  | Section 6.2.4
Spine labeling tool |  | Section 6.2.6
Multiple monitor |  | Section 4.1.3
Calibration
Monitor |  | Section 4.6.1
Image |  | Section 5.5.10
Grid layouts
Tile across monitors |  | Section 5.3.1
1-up, 2-up, etc., Custom |  | Section 5.3.1
Split/Join selected cell |  | Section 5.4.1.3
Tile layouts
2-up, 4-up, etc., Custom |  | Section 5.3.2
Link properties
Auto link |  | Section 5.4.3
Mirror |  | Section 5.4.3
Magic glass |  | Section 5.4.3
Localizers
Auto find localizers |  | Section 4.1.3
Show localizer lines on selected image |  | Section 6.1.4
Show hash marks on selected image |  | Section 6.1.4
Show/Hide localizer lines on all images | F12 | Section 6.1.4
Show/Hide hash marks on all images | Alt+F12 | Section 6.1.4
Series
Auto split series |  | Section 5.4.1.1
Auto sort series |  | Section 5.4.2, 4.1.3
Macros |  | Section 4.3.2.4
Macro manager |  | Section 4.3.2.4
Start/Stop recording |  | Section 4.3.2.4
Selected study assigned |  | Section 8.2.3
Warn when dictating to an addendum |  | Section 8.2.5

### 3.2.4 TOOLS MENU

eRAD PACS's Tools menu provides access to various tools that control the screen layout and the manner in which it renders the images. This includes the ability to reset the image characteristics, apply a zoom factor and an interpolation algorithm, invert the grayscale slope, apply color to the LUT, reorient the image, and customize the set of images in a series.

| Menu Item | Shortcut | For details, see ...
--- | --- | ---
Reset
Image size |  | Section 3.1.2, 5.5.5
Image position |  | Section 3.1.2, 5.5.5
Image orientation |  | Section 3.1.2, 5.5.5
Window/Level |  | Section 3.1.2, 5.5.2
Transform
Flip horizontally | Ctrl+H | Section 5.5.6
Flip vertically | Ctrl+U | Section 5.5.6
Rotate right | Ctrl+R | Section 5.5.6
### 3.2.5 CINE MENU

The eRAD PACS Cine menu provides controls for displaying stack views. The menu includes controls for cycling through the images in the stack view, which simulates playing a cine loop, controlling the looping mode, altering the playback speed, and displaying the cine controls as a floating or docked toolbar.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>For details, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate left</td>
<td>Ctrl+L</td>
<td>Section 5.5.6</td>
</tr>
<tr>
<td>Flip image info</td>
<td></td>
<td>Section 5.5.6</td>
</tr>
<tr>
<td><strong>Zoom</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual size</td>
<td>Ctrl+Alt+A</td>
<td>Section 5.5.5.4</td>
</tr>
<tr>
<td>N:1</td>
<td>Ctrl+&lt;N&gt;</td>
<td>Section 5.5.5.1</td>
</tr>
<tr>
<td>1:N</td>
<td>Alt+&lt;N&gt;</td>
<td>Section 5.5.5.1</td>
</tr>
<tr>
<td>Fit to window</td>
<td>Ctrl+F</td>
<td>Section 4.1.4, 5.5.5</td>
</tr>
<tr>
<td>Full screen</td>
<td>F5</td>
<td>Section 5.5.5</td>
</tr>
<tr>
<td><strong>Interpolation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nearest pixel</td>
<td></td>
<td>Section 4.1.4, 5.5.5</td>
</tr>
<tr>
<td>Bilinear interpolation</td>
<td></td>
<td>Section 4.1.4, 5.5.5</td>
</tr>
<tr>
<td><strong>Invert</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Greyscale</td>
<td></td>
<td>Section 5.5.2</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orientation</td>
<td></td>
<td>Section 5.5.6</td>
</tr>
<tr>
<td>Zoom factor</td>
<td></td>
<td>Section 5.5.5.1</td>
</tr>
<tr>
<td>Window/Level</td>
<td></td>
<td>Section 5.5.2</td>
</tr>
<tr>
<td>Invert</td>
<td></td>
<td>Section 5.5.2</td>
</tr>
<tr>
<td>Greyscale</td>
<td></td>
<td>Section 5.5.2</td>
</tr>
<tr>
<td><strong>Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find all localizers</td>
<td></td>
<td>Section 4.1.3</td>
</tr>
<tr>
<td>Find series localizer</td>
<td></td>
<td>Section 4.1.3</td>
</tr>
<tr>
<td>Split all series</td>
<td></td>
<td>Section 4.1.3</td>
</tr>
<tr>
<td>Split series</td>
<td></td>
<td>Section 4.1.3</td>
</tr>
<tr>
<td>Sort all series</td>
<td></td>
<td>Section 4.1.3, 5.4.2</td>
</tr>
<tr>
<td>Sort series</td>
<td></td>
<td>Section 4.1.3, 5.4.2</td>
</tr>
<tr>
<td>Invert series</td>
<td></td>
<td>Section 5.4.1</td>
</tr>
<tr>
<td>Cut series</td>
<td></td>
<td>Section 5.4.1</td>
</tr>
<tr>
<td>Join series forwards/backwards</td>
<td></td>
<td>Section 5.4.1</td>
</tr>
</tbody>
</table>

### 3.2.6 COLLABORATION MENU

The eRAD PACS collaboration menu enables a user to create a collaborations session, connect to an established collaboration session, and disconnect from a collaboration session. Refer to section 9 for complete details on collaboration sessions.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>For details, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect</td>
<td>Ctrl+Alt+C</td>
<td>Section 9</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Ctrl+Alt+D</td>
<td>Section 9</td>
</tr>
</tbody>
</table>
3.2.7 HELP MENU

eRAD PACS’s Help menu provides access to information about the eRAD PACS viewer. It contains detailed information on the available features, a summary of the newest features added in the last upgrade installed on your server, plus details about its version, which is helpful in the event you need to contact customer support. For complete details on eRAD PACS Help, refer to section 12.

3.2.8 POST-PROCESSING MENU

The Post-processing menu is a conditional menu that exists if you have certain licensed plug-in modules installed on your workstation. Examples of post-processing plug-in modules include multi-planar reconstruction, fusion and image stitching. After the plug-in module downloads onto your workstation, the respective sub-menu is added to the Post-processing menu. If no post-processing plug-in module exists, then the Post-processing menu does not appear on your viewer’s title bar. For details on each of the sub-menus listed in the Post-processing menu, refer to the respective section in chapter 5 or chapter 7.

3.2.9 SPEECH RECOGNITION MENU

The Speech Recognition menu is a conditional menu that exists if you have the embedded speech recognition plug-in module installed on your workstation. For details on this menu, refer to Section 8.2.4.1.

3.2.10 CONTEXT MENU

Users can assign tools to the context menu that appears when right-clicking the mouse. To assign a tool, create a keyboard macro and assign it to the custom context menu. For details, refer to section 4.3.2.6.

3.3 Image Viewing Area

The eRAD PACS image viewing workspace makes up the majority of the user interface, as shown in Figure 3-1. This is the area that renders the full fidelity image data, along with applied annotations, overlays, and other enhancements to the image data set. The main viewing area is the one area of the eRAD PACS viewer that you cannot hide or close.

The user can customize the image viewing workspace. The area can be subdivided into multiple areas called image frames. On multiple-monitor workstations, it is possible to define one image frame that spans across all the monitors. Each image frame can display the images in a number of tile modes. The default tile mode is 1-up, also called stack mode, meaning only one image appears in the frame. A 4-up tile mode displays two rows and two columns of images, displaying four successive images loaded into the frame. By scrolling through the image frame, the user can display all the full-fidelity images loaded into the image frame. Section 5.2.4 contains information on modifying the grid and tile modes.

To load an image into the main viewing workspace, you need to drop a thumbnail image into it. See section 5.2.1 for details on loading images from the thumbnail panel and the layout manager.

3.4 Thumbnail Panel

The eRAD PACS viewer includes a panel in the main viewing workspace for displaying the thumbnail images of each series. When displayed, the thumbnail panel is located on the left border of the main viewing workspace, as shown in Figure 3-1.

A thumbnail image is a sub-sampled rendering of an image in the study used for quick identification of the full-resolution image. The thumbnail panel consists of one or more columns of thumbnail images, scrolling off the bottom of the panel if too many exist. Each image in the thumbnail panel corresponds to a single series in the study, a group of post-processed images, presentation states, or a collection of key images. The image group contains an optional header. If multiple studies are loaded, a study identification header, listing the patient name and study date, separates each study.
To display the thumbnail panel, place the cursor over the leftmost border of the main viewing workspace until the cursor changes to a bi-directional arrow, click the left mouse button and drag the border to the right, revealing the thumbnail panel. You can also show and hide the thumbnail panel by clicking on View menu and selecting Thumbail Panel, or by entering Alt-T on the keyboard. Change the thumbnail image size with the magnification tool, , by applying it directly to the thumbnail image, or by setting the default thumbnail size on the Customize Settings’ Layout page.

Each image cell in the thumbnail panel consists of the following markers, as shown in Figure 3.4-1.

1. A key image indicator if the image is selected as a key image in the report.
2. A series indicator if the series contains more than the displayed image.
3. An image viewed indicator if the image has not been rendered at full resolution during the viewer session.
4. A blue progress bar along its bottom edge showing the status of the image loads.

Load a thumbnail into the main viewing workspace before or after the progress bar completes. eRAD PACS displays the data that has downloaded from the server, and automatically updates the image when the rest of it data arrives. The download completion percentage is available as part of the overlay data.

On the upper left edge of the thumbnail image is a multiple-image series indicator. Three lines intersect the left edge of the thumbnail image when the series consists of multiple images. Scroll through multiple-image thumbnails by selecting the frame and moving the mouse’s wheel.

If the image represented by the thumbnail image is stored as a key image, the top left corner contains a key image indicator. Key images are also displayed as a separate series in the thumbnail image. This series contains a key image icon on top of the thumbnail image.

The red dot in the top right corner indicates the image has not been displayed at full resolution in the main viewing area. A red circle applies only to a series of images, and means at least one image in the series remains unviewed in the main viewing area. Once all images have been fully rendered, the red circle disappears.

The color of the frame surrounding each of the thumbnail images is for visual delineation only with one exception. The thumbnail corresponding to the image in the selected image frame is highlighted in white. Section 4.1.7 contains additional information on thumbnail frame colors.

Presentation state thumbnail images appear in the thumbnail panel under the Presentation Group header and have a presentation state icon, , on top. One thumbnail series exists for each series containing an image with a defined presentation state. Load the thumbnail into an image frame to render the series. Double-click the presentation group header in the thumbnail panel while pressing the Ctrl button to render all presentation groups for the study in a single image frame. Hide presentation state series from the Presentation Group by clearing the Show Presentation Thumbnails box under the Settings tab in the Customize Settings panel.

Key images appear in the thumbnail panel after the Presentation Group header and have a key image icon, , on top. One thumbnail series exists for each report component containing key images. Load the thumbnail into an image frame to render the series like other images. Double-click the presentation group header in the thumbnail panel while pressing the Ctrl button to render all presentation groups for the study, including the key images, in a single image frame. Hide key image series from the Presentation Group by clearing the Show Presentation Thumbnails box under the Settings tab in the Customize Settings panel.
For information on loading images from the thumbnail panel into the main viewing workspace, refer to section 5.2.1.

3.4.1 Thumbnail Panel Headers
The series thumbnails displayed in the Thumbnail panel contains an options header. The header can be positioned above or below the thumbnail, or as information at the top or bottom of the thumbnail image.

To configure the header, do the following:

1. From the Settings menu, select Customize Settings.
2. Select the DICOM Fields tab.
3. Select the position from the Display Location list. The available options are
   a. Thumbnail Header – Header appears above the thumbnail image
   b. Thumbnail Footer – Header appears below the thumbnail image
   c. Thumbnail Top – Header appears as image information at the top of the thumbnail image
   d. Thumbnail Bottom – Header appears as image information at the bottom of the thumbnail image
4. Define the value displayed in the header by selecting a field in the Tag or Info sections and clicking the respective Add button. The fields appear in the area on the left.
5. Click OK.

By default, the thumbnail header appears above the thumbnail image and contains the Series Description value.

When displayed as image information at the top or bottom of the thumbnail image, the value subject to the Show/Hide Image Info setting. When image information is hidden, so are the thumbnail headers.

Each of the available header positions supports a single line of text. If more information is needed, activate additional header positions. Additionally, multiple field values can be concatenated onto a single line. As with the study header, if the header value exceeds the width of the header area, position the mouse over the header and the field will be extended to display the full value.

3.5 Status Bar
The status bar, located at the bottom of the eRAD PACS viewer, displays the current status of an action. When the viewer is idle, the status bar displays Ready. When the viewer is downloading images from the eRAD PACS server, the status bar displays a blue progress bar. The progress bar moves across the status bar, indicating the percentage of the study information transmitted. When the progress bar completes, the thumbnail images are available for viewing. Note that when using image compression, the images may arrive at your station in waves of increasing fidelity. The individual progress bars in the thumbnail images indicate the progress of the individual image decompression.

On the far right side of the status bar is a quantitative indication of the download completion. When this value reports 0%, the transmission has not begun. In some cases, the eRAD PACS server may take some time to collect the selected study from its storage location. Once the data is ready for download, this field shows the progress.

3.6 Independent Popup Panels
A number of control panels exist in the eRAD PACS viewer. These include the layout manager, the report panel, the object information panel, and the print control panel.
Each of the control panels appears as an independent popup window. You can display or hide them as needed. Most of them contain a setting to keep the window on top of the other eRAD PACS windows, including the main viewing workspace. If you want to keep the window displayed while you click on buttons and menus outside the window, pull down the first menu in the popup window and select Keep on Top. If a checkmark appears next to this item, the window will remain in the foreground. Clear the checkmark to allow the window to move to the background when you select another window on your workstation.

3.6.1 Layout Manager

The eRAD PACS layout manager is a popup panel for previewing images loaded into the viewer, and organizing them in the main viewing workspace. The layout manager provides controls to select the monitors to use, the grid to apply to each monitor, the tile mode of each image frame, and the images to load into each image frame. After defining a layout, the layout manager can store the configuration as a hanging protocol template, which you can apply when loading a subsequent study, making it unnecessary to define the configuration again.

The layout manager window has three sections. The top part of the window contains the menus and toolbars. These are the same toolbars available in the main viewer, as described in section 3.1. The menus are similar to those in the main viewer as described in section 3.2, although some reorganization has been applied.

The center section of the layout manager contains an emulated display. These emulated monitors look and behave like the main viewer screens, but appear in the layout manager for simplicity. There is one emulated monitor for each real monitor. You have almost all the functionality present in the main viewer as you do in each of the emulated monitors, including window and level, scrolling and resizing.

The bottom section of the Layout Manager contains all the images as stacked thumbnails. This section has the same functionality as the thumbnail panel, as described in section 3.4.

When you load a study into the eRAD PACS viewer, the layout manager automatically appears unless you explicitly instructed the viewer not to do so, or eRAD PACS automatically applied a hanging protocol. To manually display the layout manager, select Layout Manager from the View menu, or press the F6 function key. You can close the layout manager by clicking the Close button in the top right corner of the window, pressing the F6 function key, or, if the Keep on Top setting in the Layout Manager menu is unchecked, clicking outside the layout manager window.

For information on loading the images from the layout manager, see section 5.2.2.

3.6.2 Information Panel

The eRAD PACS information panel contains a dump of all the attributes in each of the images loaded in the viewer. The information panel is primarily used for support and debug purposes, although the information is available to users as well. There may be times when you need to investigate the image object’s technical data. Perhaps you need to find the field used to store a particular data value you want to display in the overlay information. You can also use the information panel to see how some numeric data changes from one image to the next, without having to make changes to the overlay configuration.
To display the information panel, select an image currently loaded into the main viewing workspace, and press the F7 function key, or select **Info Panel** from the View menu. The information panel is a text dump of the object's attribute list, sorted alphabetically. Private attributes inserted by the device that created the object that eRAD PACS does not interpret appear with a DICOM tag rather than an attribute label. To locate a particular field in the information panel, use the scroll bar on the right to move through the data. To hide the information panel, press the F7 function key again, or, if the **Keep on Top** setting in the **Info Panel** menu is unchecked, clicking outside the layout manager window.

### 3.6.3 Report Panel

The eRAD PACS report panel displays reports associated with prior studies opened in the viewer, as well as records reports for the new studies. The report panel includes the text of the main report, the text of the addendums to the report, the original dictations, if available, and the key images.

To open the report panel, click the report button, ` `, in the toolbox toolbar, press the F8 function key, or select **Report Panel** from the View menu. By default, the report panel appears in the Full mode. A smaller version exists using compact mode.

![Report Panel](image)

The full report panel contains the report and access to reporting functions. In the full report panel, users can record and edit a voice dictation, type and edit report and addenda text, review the patient demographic information, obtain information on who created the report, update the study state, and perform simple management functions such as submitting the report manually to the server, clearing all the changes and starting over. The full view report panel also provides access to the study's key images.

The full report panel layout is defined by a customizable template. Your report panel template may appear with more or less information than this manual describes.

The full report panel's report toolbar provides support to general reporting tools as described below.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compact panel</td>
<td>Toggle between the compact report panel and the full report panel.</td>
</tr>
<tr>
<td>Send Report</td>
<td>Submit the report to the eRAD PACS server.</td>
</tr>
<tr>
<td>Reload Report</td>
<td>Erase all the changes and restore the original report.</td>
</tr>
<tr>
<td>Save report locally</td>
<td>Save the report to your workstation's hard disk.</td>
</tr>
<tr>
<td>Restore saved report</td>
<td>If you previously saved a report to your local workstation (using the <strong>Save to hard disk</strong> tool), read it from disk and load it in this report panel.</td>
</tr>
<tr>
<td>Spell check</td>
<td>Perform spell checking on the report's text fields.</td>
</tr>
</tbody>
</table>

The full report panel's report template toolbar creates, modified and applies canned report templates. This toolbar is described in section 8.2.2. The report panel also supports an audio control, annotation, toolbox and orientation toolbar. These toolbars are described in detail in section 3.1.

The full report panel contains the reports for each of the studies loaded into the viewer. A tab at the top of the panel displays the patient's name, study date and modality. Click the tab to see or edit the report for the corresponding study.

The full report panel displays the main report, addenda and attachments as defined by the customizable XML template. Generally, these components appear sequentially on a scrollable web page or under
individual tabs available immediately below the study identification tab. If tabs are available, click one to display the specified data.

The compact view report panel is a smaller version of the report panel, consisting primarily of the most common tools needed to dictate and submit a report. If using embedded speech recognition, the compact report panel also includes a text box showing the converted text. For less image frame obstruction, dock the compact view report panel as a toolbar by dragging it to the outside of the main viewing workspace.

The compact report panel contains the following tools:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Toggle between the compact report panel and the full report panel.</td>
</tr>
<tr>
<td>Send Report</td>
<td>Submit the report to the eRAD PACS server.</td>
</tr>
<tr>
<td>Audio toolbar</td>
<td>Start and stop dictation, play dictation, edit dictation.</td>
</tr>
<tr>
<td>State</td>
<td>Select the study state.</td>
</tr>
<tr>
<td>Report text</td>
<td>Displays the last few words of the report text. Available when configured</td>
</tr>
<tr>
<td></td>
<td>to use embedded speech recognition.</td>
</tr>
<tr>
<td>Input strength indicator</td>
<td>Audio input strength indicator.</td>
</tr>
</tbody>
</table>

Configure the default report panel mode by selecting Compact or Full in the Report Panel section of the View tab in the Customize Settings window.

### 3.6.4 Print Panel

The eRAD PACS print panel is a staging area used to collect images and format sheets of film for printing. The print panel provides tools for selecting and organizing the images, specifying the film sheet layout, and selecting a Windows-based or DICOM compatible printer along with its respective print parameters. The images in the print panel have most of the functional characteristics of images in the thumbnail panel and main viewing workspace, allowing you to enhance the display characteristics, such as change the window or level and adjust an annotation, prior to submitting the print job to the printer.

To open the print panel, select **Print...** from the **File** menu. By default, no images are loaded, unless you have already selected one of the series in the main viewing workspace. The process is to load the selected images into the print panel from either the thumbnail panel or the main viewing workspace, adjust them as necessary, select the print parameters, which differ depending on whether you are printing to a DICOM or Window printer, and then submitting the print job. The print panel remains displayed until you submit the print job. Close the print panel without submitting the print job by clicking on **Cancel** or the close button on the top right corner of the window.

Refer to section 11 for detailed instructions on how to build a film sheet and submit a print job.

### 3.6.5 Patient Folder

A patient folder lists details about the patient history including a list of prior and future orders and studies, technologist notes, reports, scanned documents and demographic information. The patient folder can be launched by clicking the Patient Folder button. The button exists in the following locations:

- **Worklist page** In the button section on the left of each study row.
The patient folder is a templated web page. It consists of three independent templates. Refer to the eRAD PACS XML Template Customization Manual for details on customizing web pages.

The default patient folder consists of the following sections:

- **Tabs:** Available when launched from the viewer, each tab represents the patient folder for each unique patient with a study loaded.
- **Buttons:** Available when launched from the browser, these buttons are links to available web pages.
- **Study list:** The selected study and all related orders and prior exams, as defined by the relevant exam matching criteria. Studies are listed by procedure date starting with the current date or future date if there are pending orders.
- **Patient demographics:** Specific patient information such as name, date of birth and history.
- **Study information:** Specific study information pertaining to the selected study in the Study List, such as exam date, modality and study description.
- **Attachments:** List of attachments pertaining to the selected study in the Study List.
- **Reports:** All report components pertaining to the selected study in the Study List.
- **Notes:** Notes pertaining to the selected study in the Study List.
- **Image area:** Readable view of the selected attachment, report component or note.

The properties of each section are described in the table below.

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tabs</td>
<td>Left-click</td>
<td>Display the information for the patient listed on the tab.</td>
</tr>
<tr>
<td>Buttons</td>
<td></td>
<td>Go to the Quick View page for the selected study. Available from browser-launched patient folder only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Retrieve the selected study from the archive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open the selected study in the viewer. Available from browser-launched patient folder only.</td>
</tr>
<tr>
<td>Section</td>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Load the selected study to the current viewer session. Available from</td>
</tr>
<tr>
<td></td>
<td></td>
<td>viewer-launched patient folder only.</td>
</tr>
<tr>
<td>Study list</td>
<td></td>
<td>Return to the worklist page. Available from browser-launched patient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>folder only.</td>
</tr>
<tr>
<td>Study list</td>
<td>Left-click</td>
<td>Make the study the selected study. Updates the study information, attachments,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>reports and notes sections.</td>
</tr>
<tr>
<td></td>
<td>Left-click+drag</td>
<td>Available in the viewer only. Load the study into the current viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>session. The study is loaded when the series appear in the thumbnail panel.</td>
</tr>
<tr>
<td>Folded top-right cell</td>
<td></td>
<td>Primary study. This is the study selected from the worklist. All prior</td>
</tr>
<tr>
<td>frame corner</td>
<td></td>
<td>exams and orders are relevant to this study.</td>
</tr>
<tr>
<td>Red border</td>
<td></td>
<td>The selected study</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Relevant by modality to the Primary study.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Relevant by matching criteria to the Primary study.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Relevant by body part to the Primary study.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Study contains a Final report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Study contains an attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Study contains a note</td>
</tr>
<tr>
<td>Bar on left edge</td>
<td></td>
<td>Final study.</td>
</tr>
<tr>
<td>Grey background</td>
<td></td>
<td>Study is not loaded in the viewer and not available on the server.</td>
</tr>
<tr>
<td>Light blue background</td>
<td></td>
<td>The study cell represents a pending order.</td>
</tr>
<tr>
<td>Blue</td>
<td></td>
<td>Study is not loaded in the viewer.</td>
</tr>
<tr>
<td>Yellow</td>
<td></td>
<td>Study is loaded in the viewer.</td>
</tr>
<tr>
<td>Dark Yellow</td>
<td></td>
<td>Study is loaded in the viewer and is currently displayed in the selected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>image frame.</td>
</tr>
<tr>
<td>Patient demographics</td>
<td></td>
<td>If expand/collapse buttons exist in this section, click to show/hide</td>
</tr>
<tr>
<td></td>
<td></td>
<td>patient information obtained from the RIS. An interface must be configured</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to use this feature.</td>
</tr>
<tr>
<td>Study information</td>
<td></td>
<td>If expand/collapse buttons exist in this section, click to show/hide study</td>
</tr>
<tr>
<td></td>
<td></td>
<td>information obtained from the RIS. An interface must be configured to use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>this feature.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Mouse-over</td>
<td>Position the mouse over the attachment icon to display a larger view of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>attachment when the attachment is an image objects, such as JPEG or DICOM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Non-image objects, such as PDF display the attachment’s filename.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display the attachment in the image area.</td>
</tr>
<tr>
<td></td>
<td>Left-click+drag</td>
<td>Available in the viewer only. Drag the attachment to an image cell in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>viewer.</td>
</tr>
<tr>
<td></td>
<td>Left/Right arrow</td>
<td>Scroll the attachments list to the left or right.</td>
</tr>
<tr>
<td>Reports</td>
<td>Mouse-over</td>
<td>Position the mouse over the report icon to display a larger view of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>report component.</td>
</tr>
<tr>
<td></td>
<td>Left-click</td>
<td>Display the full report, including all components and key images, in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>image area.</td>
</tr>
<tr>
<td></td>
<td>Left-click+drag</td>
<td>Available in the viewer only. Drag the report to an image cell in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>viewer.</td>
</tr>
<tr>
<td></td>
<td>Left/Right arrow</td>
<td>Scroll the report components list to the left or right.</td>
</tr>
<tr>
<td>Notes</td>
<td>Mouse-over</td>
<td>Position the mouse over the report icon to display a larger view of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>report component.</td>
</tr>
<tr>
<td></td>
<td>Left-click</td>
<td>Display the full report, including all components and key images, in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>image area.</td>
</tr>
<tr>
<td></td>
<td>Up/Down arrow</td>
<td>Scroll the notes list up or down.</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Section</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a note to the study. A text field appears in the image section. Enter your note and click Save. The note gets tagged with timestamp and your account ID, and appears at the bottom of the Notes list.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image area</td>
<td>Left-click</td>
<td>Available when displaying an attachment in the image area only. Click to toggle through the available image sizes: fit-to-window: fit-width; and full-resolution.</td>
</tr>
<tr>
<td>Available when displaying a note in the image area only. If the user has Admin permissions, click the Delete button to permanently remove the note from the study.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When displayed from the Viewer, the patient folder automatically updates to reflect additions to the relevant studies.

To force the patient folder to the foreground independent of other viewer panels, open the Customize Settings panel from the Settings menu, click the View tab, and check the *Patient Folder on Top* box in the General section.

When launching the viewer, the patient folder initializes in the state and location used when the viewer was last closed.

### 3.7 Plug-in Modules

eRAD PACS supports independently licensed plug-in modules that offer a suite of functions not available in the baseline viewer. An example of a plug-in module is multiplanar reconstruction. When you install an eRAD PACS viewer on your workstation, it queries the server for a list of licensed plug-ins. If the viewer determines you are licensed to use a plug-in, or if a newer version of the plug-in exists on the server, the eRAD PACS viewer prompts you to download and install it. The prompt window is shown to the left. The window displays the available plug-ins, along with their respective version numbers. To install or update a plug-in, check the box to the left of the plug-in module and click OK. Note that some plug-in modules consist of an extra install process. If this is necessary, another prompt may appear asking if you want to install the additional component. Click on OK to install the application.

To see a list of available plug-ins, select *Update plug-ins* from the File menu. Once installed, the plug-in automatically initializes and makes its functions available.

You can find a complete list of eRAD PACS viewer plug-ins in section 7. Refer to the relevant subsection for specific details on how to use the features in the plug-in.

### 3.8 Display Modes

Normally, the eRAD PACS viewer shows the default display mode, consisting primarily of the main viewing workspace. Additional display modes exist. These display modes offer an alternative view of the data, usually for a specific, short-term purpose.

#### 3.8.1 Full Screen Mode

eRAD PACS offers a full screen display mode that eliminates all extraneous information from the monitor and uses all the space for displaying the image. When active, the menus and toolbars disappear from the screen, but all mouse controls remain available and you can apply them to the image.
Full screen display mode applies to an image frame. First load the image or series into an image frame, and apply a tile mode if necessary. To active full screen mode, select the image frame and press F5. To return to the normal display mode, press F5 again, or hit the Esc button.

### 3.8.2 Calibration Mode

One of eRAD PACS viewer's zoom modes supports rendering the image using a real-world scale. To support this zoom mode, both the image and the monitor must contain calibration information. If either is not calibrated, the eRAD PACS viewer notifies you and invokes a wizard to collect the requisite information. You can also run this wizard manually. The calibration wizard uses two display modes, each different from the default display mode. The monitor calibration display mode consists of a set of rulers you adjust to indicate the actual size of an object on the monitor. The image calibration display mode displays the image in need of spacing information, and a tool for defining measured objects on the image, which eRAD PACS uses to define the physical size of the pixels.

Section 4.6.1 contains detailed information on the monitor calibration and instructions for calibrating one or more monitors. Section 5.5.9 contains additional information on image calibration and the image calibration display mode.

### 3.9 Mouse Operations

The mouse is a powerful tool in the eRAD PACS viewer. A large number of the most common functions available from menus, toolbars and function keys are also available from the mouse. With a little practice and some dexterity, you should be able to accomplish the majority of your task simply through the use of a three-button mouse with a wheel.

eRAD PACS is able to support a large number of functions on the mouse because it supports multiple cursor modes. Each cursor mode assigns specific functions to each of the mouse buttons. By changing the cursor mode, the different eRAD PACS functions become active. The following section outlines each of eRAD PACS’s cursor modes.

#### 3.9.1 Cursor Modes

eRAD PACS viewer has a number of cursor modes available to control which functions get applied when clicking one of the three supported mouse buttons. The cursor icon identifies the active cursor mode. There are a few ways to activate a cursor mode.

- Select the cursor mode from the Cursor submenu in the Settings menu.
- Select the cursor button in the Toolbox toolbar.
- Press the hot key combination (available for a limited number of cursor modes).
- Click the middle mouse button to toggle through the cursor modes.

Some users select a cursor mode and want to use it until they explicitly select another cursor mode. Others prefer the cursor mode automatically reset to the default mode after applying an action. eRAD PACS lets the user specify whether the mode resets to the default or persists in the selected mode. When clicking the mouse button, the cursor mode automatically resets to the default when you release the button. If you hold down the ALT key while pressing the mouse button, the cursor mode remains active after performing the action. This is useful when adding annotations or attaching multiple key images to a report.

Hold down the Alt key to remain in the cursor mode for magnify, key image, link, ROI with W/L, crop, magic X. The annotation cursor mode persists automatically, although it retains the specific annotation tool if you hold down the Alt key.

#### 3.9.1.1 Normal Cursor

![Normal Cursor Icon]

Use the Normal (arrow) Cursor to click and select menus, menu items, buttons, slider bars, images, and to click and drag to relocate toolbars and resize the Image and Thumbnail Windows. This is
the default cursor mode.

### 3.9.1.2 Magnification Cursor

The magnification cursor mode is for zooming in and out on images. The magnification is based on the position of the cursor, so position the cursor over the point of interest before clicking the mouse.

When magnifying an image, a small plus sign (+) is attached to the cursor and a dotted white line appears in the image in the thumbnail panel, indicating the viewable magnified image in relation to the original image. Click the left mouse button to apply a 2x magnification to the displayed image, centered on the cursor location. Hold the Shift key down when clicking to double the magnification to 4x. The cursor displays two plus signs to indicate the 4x zoom factor.

To decrease the image size incrementally, hold down the Ctrl key when clicking the mouse. The icon includes a small minus sign (-) next to the cursor. Hold the Shift key with the Ctrl key to zoom out by a factor of 4x.

Clicking the right mouse button draws a zoom region. When you release the mouse, an image in the defined region is magnified to fit into the image frame.

Reset the image size by reloading the image into the frame from the thumbnail panel, clicking on the Reset Image Size button or menu item, or use the magnification mode to apply a reverse zoom.

### 3.9.1.3 Key Image Selection Cursor

The key image selection cursor lets you attach an image to a report. When activated, the cursor looks like a paper clip. To attach an image to a report, click on the image. When attached to the report, a key image icon is displayed in the top left corner of the image to denote the image is attached to the report exactly as rendered in the image frame. A paperclip icon appears in the top left corner of the image to denote the image is attached to the report, but not as it appears in the image frame. Click the key or paper clip icon on the image to remove it from the report.

### 3.9.1.4 Link Cursor

The link cursor is for linking one or more studies together so a single scroll command applies to all linked image frames. When auto-link is active, series in the same plane and sharing the same frame of reference are linked automatically. Double-click the link cursor button to automatically link all series in the same plane and within the same frame of reference. To manually link image frames together, select the Link cursor mode, move the cursor to the first image frame, press and hold down the left mouse button, drag the cursor to the frame you want to link, and release the mouse button. To link a third frame to the first two, repeat by starting with one of the two original frames, and releasing the mouse when the cursor is in the third image frame. To remove a link, double-click on the link icon in the top-left corner of the image.

### 3.9.1.5 ROI With Window/Level Adjustment

A user can set the window width and center values for an entire image or study based on the dynamic range of a specified region of an image using the ROI with window/level adjustment cursor mode. After selecting the ROI with W/L mode, position the cursor over the image, and click and drag to define the region of interest. When you release the cursor, the pixels within the region are used to define the window width and center. These values are applied to the entire image. The region defining the area remains on the screen. Resize it and drag it around to change the window and level settings. Click anywhere on the image outside the region of interest to remove it.

### 3.9.1.6 Crop Image Cursor Mode

Remove extraneous information from the viewable image in the frame with the crop image cursor mode. Click the image and drag the mouse to define the image region. When you release the mouse, all image data outside the defined region disappears from view. Click on the region border
and drag it to resize the crop region. Select the Fit to Window mode to display the image as large as possible in the image frame. Double-click anywhere in the image frame to remove the crop region.

### 3.9.1.7 Magic X Cursor Mode

Locate a defined point in one image on all other images that share the same frame of reference using the Magic X cursor mode. Select Magic X mode, and click on an image. All series currently displayed in other frames scroll to the image closest to the selected point. If you click and hold the mouse button, the Magic X marker is displayed in each image frame. If you drag the mouse while holding down the button, the images update dynamically as the reference point moves.

### 3.9.1.8 Magic Glass Cursor Mode

Magic Glass cursor mode is actually a panning magnifying glass, zooming the image behind it. After activating the magic glass window, click on the popup window and drag it to move it around. The area under the image is magnified by a factor defined in your customize settings table. Only image data is magnified. Clear the magnifying glass by left-clicking anywhere outside of the zoom area.

Resize the magic glass window positioning the mouse over the edge of the window until it changes to a bi-directional arrow. Click the left mouse button and drag to resize the window. A large Magic Glass window may result in ghosting as you drag it around. If you find this distracting, reduce the size of the magic glass window.

### 3.9.1.9 Annotation Cursor Mode

The annotation cursor mode is the general cursor mode for all annotation tools. The general annotation mode is needed to move and edit existing annotations. To apply a specific annotation, select the desired annotation from the annotation toolbar, or spin the wheel on the mouse when general annotation mode is active.

### 3.9.2 Mouse Functions

The following table lists eRAD PACS viewer’s default mouse functions and actions based on the location of the cursor when the action is requested.

<table>
<thead>
<tr>
<th>Cursor Mode</th>
<th>Mouse Location</th>
<th>Left Button</th>
<th>Middle Button</th>
<th>Right Button</th>
<th>Left + Right Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>Main Viewing Workspace</td>
<td>Click: Select image frame</td>
<td>Click: Toggle cursor</td>
<td>Click: Features popup menu</td>
<td>Not used</td>
</tr>
<tr>
<td>Image</td>
<td></td>
<td>Click: Select image/series</td>
<td>Click: Toggle cursor</td>
<td>Click: Features popup menu</td>
<td>Drag: Dynamic zoom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drag: Scroll images (image fit-to-window), or Pan (resized image)</td>
<td>Drag: Scroll images</td>
<td>Drag: W/L image/series</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ctrl-Drag: Scroll images</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout Manager</td>
<td>Click: Select image/study</td>
<td></td>
<td>Click: Toggle cursor</td>
<td>Click: Features popup menu</td>
<td>Drag: Dynamic zoom</td>
</tr>
<tr>
<td></td>
<td>Dbl-click: Load image/series</td>
<td></td>
<td>Roll: Scroll images</td>
<td>Drag: W/L thumbnail image(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Drag: Load image/series</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toolbars</td>
<td>Click: Select</td>
<td></td>
<td>Click: Toggle cursor</td>
<td>Click: Features popup menu</td>
<td>Not used</td>
</tr>
<tr>
<td></td>
<td>Dbl-click: Detach/attach toolbar</td>
<td></td>
<td>Roll: Scroll images</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Drag: drag toolbar</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elsewhere</td>
<td>Click: Select</td>
<td></td>
<td></td>
<td>Click: Popup menu</td>
<td>Not used</td>
</tr>
<tr>
<td>Magnifying Glass</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drag: Dynamic zoom</td>
</tr>
<tr>
<td>Image</td>
<td>Click: Zoom up and center</td>
<td></td>
<td>Click: Toggle cursor</td>
<td>Click: Features popup menu</td>
<td>Drag: Size zoom area</td>
</tr>
<tr>
<td></td>
<td>Shift-click: Zoom up 2x and center</td>
<td></td>
<td>Roll: Scroll images</td>
<td>Drag: Size zoom area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CTX-click: Zoom down</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shift-CTX-click: Zoom down 2x</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ALT+&lt;cmd&gt;: Stay in magnify mode after click</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Page 32
<table>
<thead>
<tr>
<th>Cursor Mode</th>
<th>Mouse Location</th>
<th>Left Button</th>
<th>Middle Button</th>
<th>Right Button</th>
<th>Left + Right Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Manager</td>
<td>Click: Zoom up&lt;br&gt;Shift-click: Zoom up 2x&lt;br&gt;CTRL-click: Zoom down&lt;br&gt;Shift-CTRL-click: Zoom down 2x&lt;br&gt;ALT+&lt;cmd&gt;: Stay in magnify mode after click</td>
<td>Click: Toggle cursor&lt;br&gt;Roll: Scroll images</td>
<td>Click: Features popup menu</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>Annotation Mode</td>
<td>Image</td>
<td>Click: Apply annotation graphic&lt;br&gt;Drag: Reposition annotation graphic/move graphic endpoint/move annotation label/text</td>
<td>Click: Toggle cursor&lt;br&gt;Roll: Scroll images&lt;br&gt;Drag: Scroll images</td>
<td>Click: Annotation popup menu&lt;br&gt;Drag: W/L image/series</td>
<td>Drag: Dynamic zoom</td>
</tr>
<tr>
<td>Key Image Selector</td>
<td>Image</td>
<td>Click: Select image as key image&lt;br&gt;ALT-click: Stay in key image mode after click</td>
<td>Click: Toggle cursor&lt;br&gt;Roll: Scroll images</td>
<td>Click: Features popup menu&lt;br&gt;Drag: W/L image/series</td>
<td>Not used</td>
</tr>
<tr>
<td>Layout Manager</td>
<td>Click: Select image as key image&lt;br&gt;ALT-click: Stay in key image mode after click</td>
<td>Click: Toggle cursor&lt;br&gt;Roll: Scroll images</td>
<td>Click: Features popup menu&lt;br&gt;Drag: W/L image/series</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>Magic X</td>
<td>Image</td>
<td>Click: Display location of image in all displayed frames&lt;br&gt;Drag: Dynamically display location of images is all displayed frames&lt;br&gt;ALT-click: Stay in Magic X mode after click</td>
<td>Click: Toggle cursor&lt;br&gt;Drag: Scroll images</td>
<td>Click: Features popup menu&lt;br&gt;Drag: W/L image/series</td>
<td>Drag: Dynamic zoom</td>
</tr>
<tr>
<td>Link</td>
<td>Image / Layout Manager</td>
<td>Click-Drag-Release: Click on first series, drag to series to link, and then release&lt;br&gt;ALT-click: Stay in Link mode after click</td>
<td>Click: Toggle cursor&lt;br&gt;Drag: Scroll images</td>
<td>Click: Features popup menu&lt;br&gt;Drag: W/L image/series</td>
<td>Not used</td>
</tr>
<tr>
<td>Cursor Toolbar</td>
<td>Dbl-click: Auto-link all series in same plane</td>
<td>Not used</td>
<td>Not used</td>
<td>Not used</td>
<td>Not used</td>
</tr>
<tr>
<td>Magic Glass</td>
<td>Image</td>
<td>Drag: Move the magnification window</td>
<td>Not used</td>
<td>Not used</td>
<td>Drag: Dynamic zoom</td>
</tr>
</tbody>
</table>

1 Middle mouse click action applies when Advanced Middle Button Tools setting is enabled.
2 Middle mouse drag action applies when Advanced Middle Button Tools setting is disabled.

### 3.10 Hot Keys and Macros

A number of default accelerator key combinations are available. The eRAD PACS accelerator keys operate within eRAD PACS viewer, and may be in conflict with hot keys employed by other application installed on your PC. By default, the following hot keys are included in the eRAD PACS viewer.

- **F2**: Show study list (Ded. WS only)
- **F5**: Full-screen mode
- **F6**: Show layout manager
- **F7**: Show image information dump
- **F8**: Show report and key images
- **F9**: Show annotations
- **Ctrl-F9**: Show embedded overlay
- **Ctrl-1**: Zoom 1:1
- **Ctrl-2**: Zoom 2:1
- **Ctrl-4**: Zoom 4:1
- **F10**: Show image overlay info
- **F11**: Show orientation
- **Alt-F11**: Show orientation cube
- **F12**: Show localizer line
- **Alt-F12**: Show hash marks
- **Alt-T**: Show thumbnail panel
- **Alt-2**: Zoom 1:2
- **Alt-4**: Zoom 1:4
- **Alt-8**: Zoom 1:8
3.11 Running the Viewer

Each of the eRAD PACS viewers uses a different mechanism to start and terminate.

3.11.1 Starting and Terminating the Active-X Viewer

As the name indicates, the active-X viewer uses Windows Active-X controls to start. When you install the software, a file type is registered in Microsoft Windows. The default application for that file type is the eRAD PACS viewer. When you select certain items on the eRAD PACS worklist, the browser downloads a file of the registered type. As a result, Windows automatically launches the viewer.

To get to the worklist so you can load a study in the active-X viewer, you must log onto eRAD PACS. Select the hyperlink that is the patient’s name on the worklist, or click on the Open button, and the viewer starts. If you run the viewer in Standby mode, as described in section 4.1.1, the viewer is always loaded in memory and launches faster than it otherwise would.

To start the eRAD PACS active-X viewer without loading a study, go to the Windows Start button, and select Programs. A list of available programs appears. Select eRAD PACS, and eRAD PACS again from its submenu. If configured to run in Standby mode the viewer loads, but remains minimized in the system tray.

To terminate a viewing session, close the viewer application by selecting Exit from the File menu or clicking on the Close button in the top right corner of the application window. If running in configured for Standby mode, the active-X viewer doesn’t really terminate. It closes the open study and then returns to Standby mode. To completely terminate the active-X viewer, find the eRAD PACS icon in the system tray, right click on it, and select Exit.

3.11.2 Starting and Terminating the Standalone Viewer

The eRAD PACS standalone viewer is found on DICOM-compliant media such as CD and DVD. To launch the viewer, load the media onto your workstation. If you have Windows autorun enabled, the viewer automatically loads. If this does not happen, open a Windows Explorer window and browse to d:\pbuild.exe, where “d:” is the drive label for your removable media.

When the standalone viewer initiates, the study panel appears. The studies listed in the media’s DICOMDIR file appear in the study panel. If no DICOMDIR file is found, use the browse button on the study panel to find a DICOMDIR file or the DICOM object files. Refer to section 5.1.1 for details.
To terminate the standalone viewer, select Exit from the File menu, or click on the close button in the top right corner of the application window.
4 Configuration Settings and Options

The eRAD PACS viewer supports a customizable graphical user interface (GUI). The user has the ability to define the screen layouts, toolbar arrangements, preset values, custom handing protocol templates, network settings, overlays, and other settings that make the GUI better suited to specific uses. eRAD PACS records much of a user’s specific profile on the server, and downloads it to the workstation when a user logs in. This permits each user to customize their workspace without imposing their preferences on other users.

The sections in this chapter provide details for customizing the eRAD PACS viewer settings. These settings are available on all versions of the eRAD PACS viewer, except when noted otherwise.

4.1 Customize Settings Window

The customized settings window contains settings governing the viewer’s default behavior and appearance. Open the customized settings panel by selecting Customize Settings from the Settings menu. The customize settings window consists of tabs for each settings group plus an OK, Cancel, and Reset All button. The Reset All button resets all the viewer’s settings on that page to their original settings.

4.1.1 General Settings

The general settings page in the customize settings window contains parameters that affect the way specific functions behave in the eRAD PACS viewer. To display the general settings page, select Customize Settings from the Settings menu, and click on the Settings tab.

In many cases, the general settings toggle the behavior of functions that different users prefer to be enabled or disabled, depending on the manner in which they use eRAD PACS. Specifically, the general settings are follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable standby mode</td>
<td>Enabled</td>
<td>Standby mode starts the viewer when Windows starts, and loads it in memory. This permits the viewer to launch quicker when opening a study. When disabled, Windows load the viewer from disk each time the user opens a study.</td>
</tr>
<tr>
<td>Use HTTP proxy</td>
<td>Enabled</td>
<td>If a proxy server exists between the workstation and the server, certain communications actions are needed. This setting should be enabled at all times.</td>
</tr>
<tr>
<td>Show tool tips</td>
<td>Enabled</td>
<td>Tool tips are popup text strings that help identify the function of a tool. When enabled, tool tips appear one second after you place the cursor over a button, field or gauge in the viewer. When disabled, no tool tips appear.</td>
</tr>
<tr>
<td>Show ant line marker</td>
<td>Enabled</td>
<td>The ant line marker is the moving, dotted white line that marks the view area in a thumbnail image. When enabled, the ant line marker denotes the location and size of the image area displayed in the window when a zoom factor is being applied to the image. If disabled, the markers appear as a solid line the thumbnail image.</td>
</tr>
<tr>
<td>Show annotation indices</td>
<td>Enabled</td>
<td>Image annotations include indices for reference. When enabled, an automatically incremented index is displayed with every annotation applied to an image. When disabled, the index is not displayed. Override this setting on an individual basis by right clicking on a specific annotation and select Show Index to toggle the setting.</td>
</tr>
<tr>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show ruler tick marks</td>
<td>Disabled</td>
<td>Linear measurement annotations support tick marks to assist in calculating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>distances. When <em>tick marks</em> are enabled, the marks appear on linear</td>
</tr>
<tr>
<td></td>
<td></td>
<td>measurement annotations. Override this setting on an individual basis by</td>
</tr>
<tr>
<td></td>
<td></td>
<td>right clicking on the specific annotation and select <em>Show tick marks</em> to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>toggle the setting.</td>
</tr>
<tr>
<td>Show report note</td>
<td>Enabled</td>
<td>Pop up report note if present and Impression and Observation are empty.</td>
</tr>
<tr>
<td>Show radiologist</td>
<td>Enabled</td>
<td>Include the radiologist selection menu on the report panel.</td>
</tr>
<tr>
<td>Show transcriptionist</td>
<td>Enabled</td>
<td>Include the transcriptionist selection menu on the report panel.</td>
</tr>
<tr>
<td>Persistent frame settings</td>
<td>Disabled</td>
<td>Frame settings remain applied after dropping a new thumbnail set into an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>initialized image frame.</td>
</tr>
<tr>
<td>Center zoom region</td>
<td>Enabled</td>
<td>The <em>center zoom region</em> setting defines the focal point location when</td>
</tr>
<tr>
<td></td>
<td></td>
<td>establishing a zoom region. When enabled, the location of the cursor when</td>
</tr>
<tr>
<td></td>
<td></td>
<td>you first click is set as the center of the defined region. When disabled,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the location of the cursor when you first click is set as the corner of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>defined region.</td>
</tr>
<tr>
<td>Enable dictated study listing</td>
<td>Enabled</td>
<td>When multiple studies are loaded and the report panel is opened, display a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>selection list so the user can choose which report to edit.</td>
</tr>
<tr>
<td>Select primary study as default</td>
<td>Enabled</td>
<td>When <em>Enable dictated study listing</em> setting is active, enabling this setting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sets the primary study as the default in the Study Selection panel. When</td>
</tr>
<tr>
<td></td>
<td></td>
<td>disabled, set the study associated with the selected image as the default in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Study Selection panel.</td>
</tr>
<tr>
<td>External level allowed</td>
<td>Disabled</td>
<td>The <em>external level allowed</em> setting provides you with the ability to set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>your window center value outside the defined region.</td>
</tr>
<tr>
<td>Advanced middle button tools</td>
<td>Enabled</td>
<td>When enabled, click the middle mouse button to toggle through the cursor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>modes. When enabled and cursor mode is Annotation, spin the middle mouse</td>
</tr>
<tr>
<td></td>
<td></td>
<td>wheel to toggle through the annotation tools.</td>
</tr>
<tr>
<td>Continuous image scrolling</td>
<td>Disabled</td>
<td>Scrolling through images in an image frame can progress smoothly by</td>
</tr>
<tr>
<td></td>
<td></td>
<td>rendering every image, or quickly by skipping through the images at a rate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>based on the speed the user scrolls. When <em>continuous image scrolling</em> is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>enabled, the viewer displays every image in the stack. When disabled, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>viewer may skip images to keep up with the scroll speed.</td>
</tr>
<tr>
<td>Keep cursor</td>
<td>Disabled</td>
<td>When checked, the cursor mode persists after applying the function. When</td>
</tr>
<tr>
<td></td>
<td></td>
<td>unchecked, cursor mode returns to Normal mode. Default is unchecked.</td>
</tr>
<tr>
<td>Show document thumbnails</td>
<td>Disabled</td>
<td>When checked, display DICOM image objects marked as scanned documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(ConversionType=WSD) in the thumbnail panel.</td>
</tr>
<tr>
<td>Show presentation thumbnails</td>
<td>Enabled</td>
<td>When checked, display presentation state objects as independent series in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Presentation Group section of the thumbnail panel.</td>
</tr>
<tr>
<td>Show key image thumbnails</td>
<td>Enabled</td>
<td>When checked, display all key images (per report component) in an independent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>series in the Presentation Group section of the thumbnail panel.</td>
</tr>
<tr>
<td>Create log files</td>
<td>Disabled</td>
<td>Record user actions in an activity log file.</td>
</tr>
<tr>
<td>Create crash dump</td>
<td>Enabled</td>
<td>When the viewer crashes, dump the details to a crash log file.</td>
</tr>
<tr>
<td>Proposed states</td>
<td>--</td>
<td>The <em>Proposed states</em> button opens the window used to set the states to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>propose when closing a study. See section 4.1.1.1 for more information.</td>
</tr>
<tr>
<td>Magic glass zoom factor</td>
<td>2:1</td>
<td>The <em>magic glass zoom factor</em> defines the magnification applied to the data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>inside the magic glass window. The default is a 2x magnification.</td>
</tr>
</tbody>
</table>

### 4.1.1.1 Proposed States

When closing a study, eRAD PACS attempts to set the study state to its new state based on the information added during the viewer session. For example, if you opened a study that was in the *Unviewed* state, and you dictated a report, you can automatically set the state to *Dictated* when you close the viewer.

To set the states, open the proposed states window and select the state for each of the conditions. The conditions available for setting the state are as follows:
4.1.2  **VIEW SETTINGS**

The view settings page contains monitor configuration parameters, plus controls for setting viewing characteristics of the many panels available in eRAD PACS. To display the view settings page, select **Customize Settings** from the Settings menu, and click on the View tab.

The majority of the settings on the view page determine how eRAD PACS uses the monitors. In a multiple monitor workstation, the eRAD PACS viewer can appear on one or more of the monitors. By identifying the primary monitor and which others to enable, the user can run eRAD PACS while leaving other applications, such as the procedure order information or the patient history, displayed on the remaining monitors.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitors</td>
<td>Number of monitors</td>
<td>1x1</td>
<td>The number of viewer windows to display on the current monitor. Useful to split a single 2560x1024 Windows monitor into two 1280x1024 monitors. Only active on single-monitor workstations.</td>
</tr>
<tr>
<td>Monitor #</td>
<td></td>
<td>--</td>
<td>Select the monitor to configure. Numeric index refers to the Windows monitor number. See Windows Display properties.</td>
</tr>
<tr>
<td>Auto/BW/Color</td>
<td></td>
<td>Auto</td>
<td>Set the monitor type to greyscale, color, or auto detected.</td>
</tr>
<tr>
<td>Primary Monitor</td>
<td></td>
<td>Monitor #1</td>
<td>The selected monitor is the primary monitor, and will display the popup windows, display the thumbnail panel, and handle other functions. Primary Monitor can be selected for only one monitor.</td>
</tr>
<tr>
<td>Disable</td>
<td></td>
<td>Disabled</td>
<td>Do not display the viewer on the selected monitor.</td>
</tr>
<tr>
<td>Templates</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the templates toolbar on selected monitor.</td>
</tr>
<tr>
<td>Window/Level</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the window/level toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the presentation toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Annotation</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the annotation toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Grid Layouts</td>
<td></td>
<td>Disabled</td>
<td>Show/Hide the grid layouts toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Tile Layouts</td>
<td></td>
<td>Disabled</td>
<td>Show/Hide the tile layouts toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Link</td>
<td></td>
<td>Disabled</td>
<td>Show/Hide the link toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Cine</td>
<td></td>
<td>Disabled</td>
<td>Show/Hide the cine toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Macro</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the macro toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Toolbox</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the toolbox toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Orientation</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the orientation toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td>Disabled</td>
<td>Show/Hide the standard toolbar on the selected monitor.</td>
</tr>
<tr>
<td>Status bar</td>
<td></td>
<td>Enabled</td>
<td>Show/Hide the status bar on the selected monitor.</td>
</tr>
<tr>
<td>General</td>
<td>Show Thumbnail Panel</td>
<td>Disabled</td>
<td>Show/Hide the thumbnail panel on the primary monitor.</td>
</tr>
<tr>
<td></td>
<td>Layout Manager on top</td>
<td>Enabled</td>
<td>Keep the layout manager displayed on top of other windows.</td>
</tr>
<tr>
<td></td>
<td>Info Panel on top</td>
<td>Enabled</td>
<td>Keep the information panel displayed on top of other windows.</td>
</tr>
<tr>
<td></td>
<td>Report Panel on top</td>
<td>Enabled</td>
<td>Keep the report panel displayed on top of other windows.</td>
</tr>
<tr>
<td>Section</td>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Panel</td>
<td>Print Panel on top</td>
<td>Enabled</td>
<td>Keep the print panel displayed on top of other windows.</td>
</tr>
<tr>
<td></td>
<td>Collaboration Panel on top</td>
<td>Enabled</td>
<td>Keep the collaboration panel displayed on top of other windows.</td>
</tr>
<tr>
<td></td>
<td>Patient folder on top</td>
<td>Enabled</td>
<td>Keep the patient folder displayed on top of other windows.</td>
</tr>
<tr>
<td>Report Panel</td>
<td>Full</td>
<td>Selected</td>
<td>Default to the full report panel when opening the report panel.</td>
</tr>
<tr>
<td></td>
<td>Compact</td>
<td>Unselected</td>
<td>Default to the compact report panel when opening the report panel.</td>
</tr>
<tr>
<td></td>
<td>Audio</td>
<td>Enabled</td>
<td>Show/Hide the audio toolbar on the report panel.</td>
</tr>
<tr>
<td></td>
<td>Annotation</td>
<td>Enabled</td>
<td>Show/Hide the annotation toolbar on the report panel.</td>
</tr>
<tr>
<td></td>
<td>Report</td>
<td>Enabled</td>
<td>Show/Hide the report toolbar on the report panel.</td>
</tr>
<tr>
<td></td>
<td>Orientation</td>
<td>Enabled</td>
<td>Show/Hide the orientation toolbar on the report panel.</td>
</tr>
<tr>
<td></td>
<td>Template</td>
<td>Enabled</td>
<td>Show/Hide the canned report templates toolbar on the report panel.</td>
</tr>
<tr>
<td></td>
<td>Toolbox</td>
<td>Disabled</td>
<td>Show/Hide the toolbox toolbar on the report panel.</td>
</tr>
<tr>
<td>Layout</td>
<td>Templates</td>
<td>Enabled</td>
<td>Show/Hide canned report templates toolbar on the layout manager.</td>
</tr>
<tr>
<td>Manager</td>
<td>Grid Layouts</td>
<td>Enabled</td>
<td>Show/Hide the grid layouts toolbar on the layout manager.</td>
</tr>
<tr>
<td></td>
<td>Tile Layouts</td>
<td>Enabled</td>
<td>Show/Hide the tile layouts toolbar on the layout manager.</td>
</tr>
<tr>
<td>Image overlay</td>
<td>Size</td>
<td>25%</td>
<td>Size of orthogonal image displayed as an overlay in image frame.</td>
</tr>
<tr>
<td></td>
<td>Bottom Left/Right</td>
<td>Right</td>
<td>Default location of orthogonal image overlay</td>
</tr>
<tr>
<td>Button size</td>
<td>Auto/Big/Small</td>
<td>Auto</td>
<td>Button size used on the selected monitor. Auto tells the viewer to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>automatically apply large buttons and thumbnail images when the monitor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>size is greater than the value defined in MPx.</td>
</tr>
<tr>
<td></td>
<td>MPx</td>
<td>2.5</td>
<td>The point at which Auto button size uses the Big button size, specified</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>as mega pixels.</td>
</tr>
</tbody>
</table>

### 4.1.3 Layout Settings

The layout settings page contains settings for presenting information in the eRAD PACS viewer. The page provides parameters for properly organizing series and image data, default sizes for thumbnail and report images, selecting default grid layouts, and identifying default hanging protocol templates. To display the layout settings page, select Customize Settings from the Settings menu, and click on the Layout tab.

The settings on the layout page apply to specific image types. eRAD PACS identifies an image type by the modality values stored in the series object. To assign settings to a particular image type, you must first select the modality type from the pull-down menu on the layout page. A general image type, called Default, appears at the beginning of the pull-down menu. When this value appears in the pull-down menu, the setting applies to all image types unless overridden with a specific setting. There are checkboxes on this page labeled Use Default. When checked, eRAD PACS uses the default setting for the selected image type. In other cases, a gray check appears in the checkbox, indicating the selection is actually defined by the default setting.

The table below provides detailed information on each of the settings on the layout page. There are two settings that apply to the entire page, and therefore are not assigned to any single section. The Settings For: menu contains all of the supported modality types that the settings on this page can apply to. The Use hanging protocol assistant checkbox enables and disables a number of the sections on this page. If the hanging protocol assistant is enabled, the hanging protocol template defines many of the settings. When disabled, the user settings take precedence.
<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel</td>
<td>Settings for:</td>
<td>--</td>
<td>Select the modality the settings on this page apply to. Select the modality type Default to set the default settings for all the undefined parameters.</td>
</tr>
<tr>
<td>Monitor setting</td>
<td>Multiple monitor</td>
<td>Enabled</td>
<td>Permit the viewer to appear on all enabled monitors for the selected modality type. This setting is effective only when multiple viewer monitors are configured enabled, or the number of monitors configured on the view page is greater than 1.</td>
</tr>
<tr>
<td>Automatic settings</td>
<td>Find localizers</td>
<td>Enabled</td>
<td>When enabled, separate localizer images grouped in series with non-localizer images into their own series. When disabled, localizer images are grouped as specified by the object data.</td>
</tr>
<tr>
<td></td>
<td>Split series</td>
<td>Disabled</td>
<td>Some series contain images in different planes, or using different acquisition parameters. The viewer can sometimes identify these series. When Split series is enabled, the images are grouped together into individual series and made available to the user. When disabled, the series are grouped as specified by the object data.</td>
</tr>
<tr>
<td></td>
<td>Sort series</td>
<td>Disabled</td>
<td>When enabled, always sort the images by image position, or slice number when position information is unavailable. When disabled, the series is ordered as it arrived at the server.</td>
</tr>
<tr>
<td></td>
<td>Series split length</td>
<td>0</td>
<td>For series with fewer images than specified in the Series split length setting, separate all images into their own series. Useful for separating CR series into single images. Maximum value is 12.</td>
</tr>
<tr>
<td>Thumbnail size</td>
<td>Use default size</td>
<td>Enabled</td>
<td>Use the default thumbnail size.</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>--</td>
<td>Override the default thumbnail size for the selected modality. The value is defined in pixels-squared.</td>
</tr>
<tr>
<td>Report figure size</td>
<td>Use default size</td>
<td>Enabled</td>
<td>Use the default image size.</td>
</tr>
<tr>
<td></td>
<td>Size</td>
<td>--</td>
<td>Override the default figure size for the selected modality. The value is defined in pixels-squared.</td>
</tr>
<tr>
<td>Report panel</td>
<td>Use default setting</td>
<td>Enabled</td>
<td>Use the default BIRAD setting</td>
</tr>
<tr>
<td></td>
<td>Show BIRADS</td>
<td>--</td>
<td>Display BIRADs list on the report panel for the selected modality.</td>
</tr>
<tr>
<td>Image Layout</td>
<td>Use default setting</td>
<td>Enabled</td>
<td>Use the default image layout setting.</td>
</tr>
<tr>
<td></td>
<td>Tile across monitors</td>
<td>--</td>
<td>When selected, the selected tile mode is applied across all enabled monitors.</td>
</tr>
<tr>
<td>Template</td>
<td>Use default template</td>
<td>Enabled</td>
<td>Use the default hanging protocol template setting.</td>
</tr>
<tr>
<td></td>
<td>Template menu</td>
<td>--</td>
<td>Select the hanging protocol template to apply to studies of the selected modality type.</td>
</tr>
<tr>
<td></td>
<td>Show layout manager</td>
<td>Enabled</td>
<td>When enabled, display the layout manager after applying a hanging protocol template. When disabled and a template was automatically applied, do not show the layout manager.</td>
</tr>
<tr>
<td>General</td>
<td>Auto-load localizers</td>
<td>Enabled</td>
<td>When enabled, include localizer images when automatically loading series into image frames.</td>
</tr>
<tr>
<td></td>
<td>Use hanging protocol assistant</td>
<td>Enabled</td>
<td>When enabled, the hanging protocol assistance attempts to select the best-defined hanging protocol template based on previous usage. When disabled, the Template settings take precedence.</td>
</tr>
<tr>
<td></td>
<td>Reset hanging protocol rules</td>
<td>--</td>
<td>Reset the learned hanging protocol rules to the default values.</td>
</tr>
</tbody>
</table>
### 4.1.4 IMAGE SETTINGS

The customize setting window’s image settings page contains image communication and interpretation information, including defaults for compression modes, interpolation algorithms, and default window and level settings. To display the image settings page, select **Customize Settings** from the **Settings** menu, and click on the **Image** tab.

These settings apply to specific image types, identified by the modality parameter stored in the series objects. To assign settings to a particular image type, select the modality type from the pull-down menu on the image page. A general image type, called **Default**, appears at the beginning of the menu. When selected, the settings apply to all image types except those overridden with a specific setting. The **Use Default** checkboxes on this page refer to these default settings.

The table below provides detailed information on each of the settings on the image page. There is one setting that applies to the entire page, and therefore is not assigned to any single section. The **Settings For** menu contains all of the supported modality types that the settings on this page can apply to.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel</td>
<td>Settings for:</td>
<td></td>
<td>The modality settings on this page apply to. Select <strong>Default</strong> to set the default settings for all the undefined parameters.</td>
</tr>
<tr>
<td></td>
<td>Apply VOI LUT</td>
<td>Enabled</td>
<td>When checked, apply the VOI LUT, if present, to the image when displayed. Default is checked.</td>
</tr>
<tr>
<td>Use W/L Range</td>
<td>Min</td>
<td>0</td>
<td>When overriding the defined window/level setting for an image, this is the lower window width setting. Total range cannot exceed 32K.</td>
</tr>
<tr>
<td></td>
<td>Max</td>
<td>4096</td>
<td>When overriding the defined window/level setting for an image, this is the upper window width setting. Total range cannot exceed 32K.</td>
</tr>
<tr>
<td></td>
<td>Automatic</td>
<td>Enabled</td>
<td>When enabled, use the actual pixel range as the window width and automatically calculate the level. When disabled, use the values defined in Min and Max. This setting applies only when no default window width and center value exists in the image object.</td>
</tr>
<tr>
<td>Interpolation</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use the default interpolation algorithm.</td>
</tr>
<tr>
<td></td>
<td>Nearest pixel</td>
<td></td>
<td>Use pixel replication to create pixels.</td>
</tr>
<tr>
<td></td>
<td>Bilinear</td>
<td>Default</td>
<td>Use a bilinear interpolation algorithm to create pixels.</td>
</tr>
<tr>
<td>Compression</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use the default compression algorithm.</td>
</tr>
<tr>
<td></td>
<td>Uncompressed</td>
<td></td>
<td>Do not use any compression on the image data.</td>
</tr>
<tr>
<td></td>
<td>Wavelet</td>
<td></td>
<td>Compress the image data using a progressive wavelet algorithm.</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>Default</td>
<td>The viewer selects the best compression setting based on network configuration and utilization.</td>
</tr>
<tr>
<td>Auto W/L Setting</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use the default auto W/L override setting.</td>
</tr>
<tr>
<td></td>
<td>No override</td>
<td>Default</td>
<td>Do not override the W/L setting defined in the image object.</td>
</tr>
<tr>
<td></td>
<td>Override by</td>
<td></td>
<td>When the entire study defines a full window width, replace it in each image with a calculated histogram equalization value.</td>
</tr>
<tr>
<td></td>
<td>study</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override by</td>
<td></td>
<td>When the entire series defines a full window width, replace it in each image with a calculated histogram equalization value.</td>
</tr>
<tr>
<td></td>
<td>series</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override by</td>
<td></td>
<td>When the image is defined with full window width, replace it with a calculated histogram equalization value.</td>
</tr>
<tr>
<td></td>
<td>image</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Override all</td>
<td></td>
<td>Replace the W/L values for each image in the study with its auto range value, regardless of the default values.</td>
</tr>
<tr>
<td>Wavelet Quality</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use the default wavelet quality setting.</td>
</tr>
<tr>
<td></td>
<td>Lossless</td>
<td>Default</td>
<td>When using wavelet compression, use bit conserving quality factor.</td>
</tr>
<tr>
<td></td>
<td>N:1 Lossy</td>
<td></td>
<td>When using wavelet compression, terminate the decompression when the selected ratio is achieved.</td>
</tr>
<tr>
<td>Auto W/L Range</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use the default automatic window/level range.</td>
</tr>
<tr>
<td>Section</td>
<td>Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Distribution</td>
<td>95%</td>
<td></td>
<td>To eliminate the noise that may exist at the extreme ends of the distribution curve, reduce the data set to the defined distribution range.</td>
</tr>
<tr>
<td>Zoom mode</td>
<td>Use default</td>
<td>Enabled</td>
<td>Use default zoom mode.</td>
</tr>
<tr>
<td></td>
<td>Fit to window</td>
<td>Default</td>
<td>Fit the image to the image frame. Use the interpolation algorithm selected for this modality type to create additional pixels.</td>
</tr>
<tr>
<td></td>
<td>1:1</td>
<td></td>
<td>Display only original pixel data, with no zoom factor applied.</td>
</tr>
<tr>
<td>Actual size</td>
<td></td>
<td></td>
<td>Display the image in the actual image size. This requires the monitors be calibrated for size before opening a study, and the image objects include pixel size information.</td>
</tr>
</tbody>
</table>

### 4.1.4.1 Ignore Default Window/Level Setting

Some modalities explicitly define a window width that reflects the full range of the pixel data, or a center value outside the window range, even if these settings result in poor image quality. By default, eRAD PACS applies predefined window width and center values, regardless of the results. To avoid applying bad window and level values, use the Auto W/L Setting tool to ignore the predefined values and use its own histogram analysis to set the initial window and level.

On the image settings page, go to the Auto W/L Setting area, select one of the override settings. No Override instructs eRAD PACS to use the window and level setting predefined in the image object. Override by Study/Series/Image means use the internal histogram analysis algorithm when the entire study, series or image defaults to a full window width. (The optimal setting is Override by Series).

### 4.1.4.2 Correcting Invalid Window and Level Settings

Some imaging modalities and PACS systems change the original image data, causing rendering problems in a third party system. If this occurs when using eRAD PACS, you can force a correction that adjusts the window and level settings. From the image settings page, go to the Use W/L Range field, and set the minimum and maximum window and level settings for each modality. If you need to use the defined range, select Automatic, in which case eRAD PACS uses whatever the image object has defined for itself.

### 4.1.5 DICOM Settings

The DICOM fields settings page contains tools for defining the overlays that appear on the images in the viewer and on printed film. To display the DICOM fields settings page, select Customize Settings from the Settings menu, and click on the DICOM Fields tab.

The settings on the DICOM fields page apply to specific image types, identified by the modality parameters stored in the series object. To assign settings to a particular image type, select the modality type from the pull-down menu on the DICOM fields page. A general image type, called Default, appears at the beginning of the pull-down menu. When this value is selected, the settings apply to all image types except those overridden with a specific setting. When checked, the box Use the default list for this display location instructs eRAD PACS to use the default setting for the selected image type.

The table below provides detailed information on each of the settings on the image page.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for:</td>
<td>Select the modality the settings on this page apply to. Select the modality type Default to set the default settings for all the undefined parameters.</td>
</tr>
</tbody>
</table>
**Setting** | **Description**
--- | ---
Use the default list for this display location | Instructs the viewer to use either the default setting for the specified Display Location, or to customize the Display Location for the selected modality type. When checked, the default settings are used. When cleared, the control panel is activated and you can customize the attributes. The default is checked.

[Control panel] | Work area for organizing the selected attributes to display in the area specified in Display Location. Clear the check in the Use the default list... box to activate this area.

Display Location: | The areas of the image and film that you can place demographic and study information. The available options include top-left, top-right, bottom-left and bottom-right corners of an image, and the header on a printed sheet of film. Select the appropriate location from the menu before making changes to the control panel.

Character Size: | The font size of the overlay data. The font type is not configurable.

Tag: | List of available attributes tags from the DICOM object. This list is created from the attributes defined in the object loaded in the viewer. If the attribute does not exist in this list, it is not defined in the DICOM object.

Info: | List of calculated values that can be used in overlays.

Add Tag | Click this button to add an attribute from the Tag list.

Add Info | Click this button to add a value from the Info list.

Add Text | Click this button to add a text string.

Break | Click this button to insert a carriage return (new-line) character.

Remove | Click this button to remove the item selected in the control panel.

Up/Down arrow | Move the selected item in the control panel up or down the list.

Defining overlays for images and film consists of selecting the area of the image or film on which you want to display some data, selecting the information you want to display, and then formatting the information. eRAD PACS comes with a default overlay defined for all modality types. You can modify the general overlay specification, and also customize each overlay for specific modality types. The rules for doing either are the same.

Start by selecting the modality type from the Settings for: menu, or chose the default if you want to change the common overlay definition. Then, select the location of the overlay from the Display Location: menu. The control panel updates to show the current settings for that location. If the control panel is inactive, remove the check from the Use the default list for this display location box. The control panel can contain literal stings, such as labels, patient demographics, study information, calculated values, and new-line characters. Use the buttons to the right of the control panel to add and remove these fields.

When you want to insert an attribute, find it in the Tag or Info list, and click on the respective Add button. To insert a literal string, click on the Add Text button. A popup window appears. Enter the text, and click OK. The string appears in the control panel in quotation marks. Move the fields around the control panel by selecting the attribute and clicking on the up and down arrows to the right of the control panel. To insert a carriage return between two attributes, insert a new-line character by clicking on the Break button and moving it to the appropriate location. Remove any attribute in the control panel by selecting it and clicking on the Remove button.

The Info list contains calculated values, generated by eRAD PACS and based on the loaded study. The list of available values in the Info list is as follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Augmentation</td>
<td>Processed keyword value used by hanging protocol assistant to identify the series description.</td>
</tr>
<tr>
<td>Completion</td>
<td>The percentage of the image that has already downloaded to the viewer.</td>
</tr>
<tr>
<td>Compression</td>
<td>The compression ratio applied to the image.</td>
</tr>
<tr>
<td>Current Annotation</td>
<td>If an annotation is currently selected, the value of that annotation (i.e., the length, area, text string, etc.) appears in the overlay.</td>
</tr>
<tr>
<td>HP Series Info</td>
<td>Hanging protocol’s matching criteria information.</td>
</tr>
</tbody>
</table>
Image Index | The position of the image in the series. This is different from the Instance Number in the Tag list. The Instance Number is a value defined by the modality, and is not guaranteed to be sequential. The Image Index uses the position in the series, and therefore is always sequential.

<table>
<thead>
<tr>
<th>Level</th>
<th>Current window center setting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packet Size</td>
<td>Size of the network packets in the download transmission.</td>
</tr>
<tr>
<td>Renderer</td>
<td>Image rendering method: sw (software), bd (hardware) or d3d (Direct3D).</td>
</tr>
<tr>
<td>Series Size</td>
<td>Total number of images in the series.</td>
</tr>
<tr>
<td>Window</td>
<td>Current window width setting.</td>
</tr>
<tr>
<td>Zoom</td>
<td>The zoom factor currently applied to the image.</td>
</tr>
</tbody>
</table>

The example of the overlay settings shown here includes the control panel for the top right and bottom right image areas, and the resulting image. In the top-right, a carriage return separates each of the three fields, and there are no literal strings displayed. As a result, in the event the value is empty, the field on the image will be blank. Sometimes it is better to include a label so when no value exists, it is more obvious to the user.

In the bottom-right, a literal string exists to separate the two fields. With no carriage return included, all three fields appear on a single line when displayed on the image.

### 4.1.6 Hash Mark Settings

The hash mark settings page defines the parameters the eRAD PACS viewer uses to calculate spacing limits for hash marks and other positioning features. You can define the distance that defines intersecting image planes and when the Magic X positioning tool is out of range. This setting page also sets the defaults for which kind of hash marks to display. To display the hash mark settings page, select Customize Settings from the Settings menu, and click on the Hash Marks tab.

eRAD PACS makes a distinction between hash marks and localizer lines. A localizer line is graphic that shows the intersection of one image on another. This setting applies to the selected image and results in a single line on the intersecting images. Hash marks are the collection of multiple localizer lines. This setting applies to all the series of images in the selected frame. The result is one or more lines draw in the intersecting images, with the displayed image (in the stack frame) displayed using a bold line.

The following table describes the fields that appear on the hash mark settings page.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hash Mark Spacing</td>
<td>Minimum distance between hash marks</td>
<td>0 mm</td>
<td>Too many hash marks in a small area obscure the radiograph behind them. This setting defines the minimum spacing permitted between hash marks.</td>
</tr>
<tr>
<td>Localization Criteria</td>
<td>Minimum angle between image planes</td>
<td>90°</td>
<td>Some images are not completely orthogonal to others. This setting defines the angle of incidence between two intersecting planes that qualifies for displaying a localizer line denoting the intersection. If the two planes intersect at an angle greater than that defined, the localizer line appears on the image.</td>
</tr>
</tbody>
</table>
### 4.1.7 Prefetch Settings

The prefetch settings page in the customize settings window configures the server setup for prefetching images. The page contains the server address, the protocol used to communicate with the server, prefetch settings and compression settings. To display the prefetch settings page, select Customize Settings from the Settings menu, and click on the Prefetch tab. Refer to section 4.5.1 for information about setting up prefetch.

The Compression section settings apply to specific image types, identified by the modality parameters stored in the series object. To assign compression settings to a particular image type, select the modality type from the pull-down menu in the Compression section. A general image type, called Default, appears at the beginning of the pull-down menu. When Default is selected, the settings apply to all image types except those overridden with a specific setting. There are checkboxes on this page labeled Use Default. When checked, eRAD PACS uses the default setting for the selected image type.

The table below provides detailed information on each of the settings on the prefetch page.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Server (protocol)</td>
<td>http</td>
<td>Use a secure (HTTPS) or open (HTTP) connection to the server.</td>
</tr>
<tr>
<td></td>
<td>Server (address)</td>
<td>NULL</td>
<td>The server address. This value can be a hostname, such as pacs.hospital.com, or an IP address, such as 10.0.0.1. Note: The format (IP address or domain name) of this address must match the format used in the URL line of the browser.</td>
</tr>
<tr>
<td></td>
<td>Cycle time</td>
<td>30</td>
<td>The time between queries for new studies. The more frequent the query cycle, the more traffic that results on the network.</td>
</tr>
<tr>
<td></td>
<td>Intensity</td>
<td>Max</td>
<td>The amount of available bandwidth to use while prefetching.</td>
</tr>
<tr>
<td></td>
<td>Enable prefetch</td>
<td>Disabled</td>
<td>Turn prefetching on and off. When checked, the workstation queries the server once every cycle for new studies as defined by the prefetch worklist filter. When unchecked, no checking occurs.</td>
</tr>
<tr>
<td></td>
<td>Prefetch in standby mode only</td>
<td>Enabled</td>
<td>When prefetching is enabled, the query and subsequent downloads can take CPU cycles away from other viewer activities. On slower machines, this can impact the GUI performance. When Prefetch in standby mode only is checked, the query executes when the viewer is inactive and in standby mode. Clear this checkbox to continue to query and download studies when the viewer is open.</td>
</tr>
<tr>
<td></td>
<td>Check server</td>
<td>--</td>
<td>This button checks to see if the configured server is available. Use it to verify your configuration of the server.</td>
</tr>
<tr>
<td>Study Data</td>
<td>Settings for:</td>
<td>--</td>
<td>The modality the settings in this section apply to. Select Default to set the default settings for all the undefined parameters.</td>
</tr>
<tr>
<td>Download/Image</td>
<td>Same as</td>
<td>Enabled</td>
<td>When checked, the viewer ignores the compression settings on this page and defaults to those on the Image settings page. To activate the settings on this page, clear the checkmark.</td>
</tr>
<tr>
<td></td>
<td>Image settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compression</td>
<td>Use default</td>
<td>Disabled</td>
<td>Use the default compression algorithm.</td>
</tr>
</tbody>
</table>
### 4.1.8 Cache Settings

The cache settings page defines the parameters the eRAD PACS viewer’s cache uses to manage the study and image data. The page contains the location of the disk cache, its size and some control parameters. To display the cache settings page, select Customize Settings from the Settings menu, and click on the Cache tab.

The workstations’ data storage cache uses a portion of the available disk space. When you open or prefetch a study the first time, eRAD PACS transfer the data from across the network and stores the data in the cache. For subsequent opens, eRAD PACS uses the data in the cache, eliminating the network transfer. Unless you have a complete understanding of the ramifications of changing the size of the disk cache, ask your administrator for assistance.

eRAD PACS manages the cache itself, so user maintenance is not required. The cache settings page allows you to change the default cache settings, and to reclaim the cache space by clearing it. If you clear the cache, the data downloads across the network from the server the next time you open the study. Note that when upgrading the viewer to a new version, the cache may be cleared automatically.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache</td>
<td>Directory name</td>
<td>C:\Program Files\PracticeBuilder\PBCache</td>
<td>The directory used for the disk cache. If the default directory does not contain enough disk space, change the setting to a disk drive that does. Create the directory before entering it.</td>
</tr>
<tr>
<td></td>
<td>Directory size</td>
<td>10 GB</td>
<td>The size of the disk cache. It should be large enough to store all the images you want to be available locally at any one time. If too small, redundant image downloads result. If too large, other applications on the workstation may not have the disk space they need.</td>
</tr>
<tr>
<td></td>
<td>Sync cache</td>
<td>--</td>
<td>Rebuild the cache directory.</td>
</tr>
<tr>
<td></td>
<td>Empty cache</td>
<td>--</td>
<td>This function empties the cache. Use it to recoup disk space taken up by cached data.</td>
</tr>
<tr>
<td></td>
<td>Purge files from cache</td>
<td>Enabled, set to 3 days</td>
<td>To purge the data from the local disk cache on a regular basis, check in the box and enter the number of days between purges. Minimum setting is 1 day.</td>
</tr>
</tbody>
</table>

### 4.1.9 Color Settings

The color settings page contains tools for customizing the colors of the different parts of the viewer. To display the color settings page, select Customize Settings from the Settings menu and click on the Colors tab.
You can customize many of the colors used in the eRAD PACS viewer. The list below defines each of the areas. When you select an area, the current color setting appears to the right of the area list. The color panel that pops up contains a list of predefined colors, and an option for defining custom colors.

<table>
<thead>
<tr>
<th>Annotations</th>
<th>Image annotations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>Viewer background</td>
</tr>
<tr>
<td>Calibration rulers</td>
<td>Calibration ruler annotations</td>
</tr>
<tr>
<td>Current image</td>
<td>Frame color of selected frame’s thumbnail image</td>
</tr>
<tr>
<td>Grid splitter</td>
<td>Image grid border</td>
</tr>
<tr>
<td>Hash line shadow</td>
<td>Used when only part of the localizer line intersects the image</td>
</tr>
<tr>
<td>Hash lines</td>
<td>Localizer lines and hash marks</td>
</tr>
<tr>
<td>HP series info</td>
<td>Hanging protocol’s matching criteria information</td>
</tr>
<tr>
<td>Image background</td>
<td>Color of the image frame that does not contain image data</td>
</tr>
<tr>
<td>Information overlay text</td>
<td>Color of the overlay text displayed on an image</td>
</tr>
<tr>
<td>Information panel background</td>
<td>Background color of the information (info) panel</td>
</tr>
<tr>
<td>Information panel text</td>
<td>Color of the text in the information (info) panel</td>
</tr>
<tr>
<td>Marker line</td>
<td>View area border displayed on thumbnail images, when Ant Line Marker setting is disabled</td>
</tr>
<tr>
<td>Orientation information</td>
<td>Color of the orientation (left-right) markers overlaid on the image</td>
</tr>
<tr>
<td>Overlay #1-16</td>
<td>The 1st through 16th embedded overlay</td>
</tr>
<tr>
<td>Report panel background</td>
<td>Background color of the report panel</td>
</tr>
<tr>
<td>Report panel text</td>
<td>Color of the text in the report panel</td>
</tr>
<tr>
<td>Scale markers</td>
<td>Rulers indicating image size</td>
</tr>
<tr>
<td>Selected annotations</td>
<td>The active annotation, when creating or editing</td>
</tr>
<tr>
<td>Selected image</td>
<td>Grid border color of the selected image frame</td>
</tr>
<tr>
<td>Series #1-4</td>
<td>Color of the thumbnail border for 1st through 4th series. Colors repeat starting with the 5th series.</td>
</tr>
<tr>
<td>Tab text deselected</td>
<td>Tab text color for unselected patient folder and report panel tabs.</td>
</tr>
<tr>
<td>Tab text selected</td>
<td>Tab text color for the selected patient folder and report panel.</td>
</tr>
<tr>
<td>Viewed marker</td>
<td>Image viewed indicator on thumbnail image border</td>
</tr>
<tr>
<td>Visible image</td>
<td>Color of the thumbnail image border for a series loaded in the selected image frame</td>
</tr>
</tbody>
</table>

The table below provides detailed information on each of the settings on the colors page.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Settings</td>
<td>Area list</td>
<td>A list of areas that can be customized.</td>
</tr>
<tr>
<td></td>
<td>Change</td>
<td>This button pops up a window from which you can set the color.</td>
</tr>
<tr>
<td></td>
<td>Reset selected color</td>
<td>Resets the selected area to the default value.</td>
</tr>
</tbody>
</table>
4.1.10 MEMORY SETTINGS
Memory settings control EP’s memory allocation. They impact the performance of the viewer and its interaction with other applications executing on the workstation. Do not modify these settings without some understanding of Microsoft Windows’ memory management system. To display the memory settings page, select Customize Settings from the Settings menu, and click the Memory tab.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override default mapping limit</td>
<td>Check this box to define a memory allocation limit different from the default 16MBs.</td>
</tr>
<tr>
<td>Try to map no more than N MBytes</td>
<td>The value of N specifies the total amount of memory allocated. Additional memory will be allocated only as needed.</td>
</tr>
<tr>
<td>Limit mapped memory used by temporary images</td>
<td>Check this box to define a memory allocation limit different from the default 953MBs.</td>
</tr>
<tr>
<td>Try to use no more than N MBytes</td>
<td>The value of N specifies the amount of memory allocated for image bitmaps. Additional memory will be allocated only as needed.</td>
</tr>
</tbody>
</table>

4.1.11 ADVANCED SETTINGS
The advanced settings page defines miscellaneous eRAD PACS viewer parameters. To display the advanced settings page, select Customize Settings from the Settings menu, and click on the Advanced tab.

The data packet size settings define the network packet size best suited for fast data transfers. The study data download section controls the compression used on the control data downloaded to the workstation each time you open a study. The progress of the control data download is denoted by a blue progress bar displayed in the Status bar along the bottom of the main viewing area. The following table explains these settings and the others on this page.

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Settings for:</td>
<td>=</td>
<td>Select the modality the settings on this page apply to. Select the modality type Default to set the default settings for all the undefined parameters.</td>
</tr>
<tr>
<td>Annotation font size</td>
<td>8 point</td>
<td></td>
<td>Font size for the text used for annotations.</td>
</tr>
<tr>
<td>Keep last N DICOM print logs</td>
<td>25</td>
<td></td>
<td>Keep the specified number of print logs on the workstation. Print logs show the results of a DICOM print request, and may be useful in the event a problem occurred.</td>
</tr>
<tr>
<td>Keep last N text annotations</td>
<td>20</td>
<td></td>
<td>Keep the specified number of text annotations in the annotation text list.</td>
</tr>
<tr>
<td>Connect to collaboration peer directly</td>
<td>Disabled</td>
<td></td>
<td>When a proxy server is involved in the routing between two collaborating workstations, the viewer needs to know to attempt to connect directly. When a check appears in the box, the workstation attempts to connect to the other workstation directly.</td>
</tr>
</tbody>
</table>
### 4.1.11.1 Automatic Communication Optimization

eRAD PACS attempts to optimize the communications between the server and the viewer according to the available bandwidth, the network speed, location of the workstation, etc. You have the ability to override the optimization, but it is not recommended. To have eRAD PACS automatically perform this optimization, set the Data Packet Size to Auto and the Study Download Data to Auto.

When set to optimize the communications, eRAD PACS packages the initial study information it sends to the viewer when loading the study based on the network performance. For example, if the Server detects that the workstation is located on the same local area network (as defined in the LAN-accessible IP Addresses section of the System Options on the Server page), the study information is transferred uncompressed in large data blocks, which improves the delivery time over a fast LAN. If the connection between the server and viewer is across a slow wide area network, eRAD PACS opts for compressed data and smaller packet sizes.

### 4.1.11.2 Thread Priorities

The eRAD PACS viewer consists of multiple threads, or processes, that perform specific functions. The system assigns a priority to each of these threads that the operating system uses to know which one to execute before the other. Since every platform is affected by numerous issues such as other running programs, amount of RAM, free disk space, and network performance and reliability, it may be necessary for a user to override the default priorities and customize them for the specific environment.

eRAD PACS’s default thread priorities are set to work best across all supported platforms. This generally means the default settings are not optimal for any specific platform. Tweaking the thread priorities may improve your viewer’s performance.

The thread priority setup tool is available from the customize settings’ advanced page. Click on the Adjust Thread Priorities button to display the configuration window. The window contains two color-coded bars and a number of actions, as shown in the image to the right. The left bar controls the rendering and loading functions. The right bar controls the decompression process. The colors in the bars indicate the priority. Blue indicates the lowest thread priority, red the highest. The actions are listed in the table below.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load visible images</td>
<td>Loading images that are visible in the viewer, such as on the top of a stack in an image frame.</td>
</tr>
<tr>
<td>Load opened images</td>
<td>Loading all images in the selected frame, including those that are not currently visible on the user interface.</td>
</tr>
<tr>
<td>Load images</td>
<td>Loading all other images in a study.</td>
</tr>
<tr>
<td>Prefetch images</td>
<td>Prefetching studies from the EP server to the workstation.</td>
</tr>
<tr>
<td>Decompress visible images</td>
<td>Decompress images that are visible in the viewer.</td>
</tr>
<tr>
<td>Decompress open images</td>
<td>Decompress images in the selected frame.</td>
</tr>
<tr>
<td>Decompress images</td>
<td>Decompress all other images in a study.</td>
</tr>
</tbody>
</table>

To adjust the priority, left-click on the circular knob and drag it along the color-coded bar until the action is within the priority level you want. Since the priority levels cannot cross each other’s border, it may be necessary to move multiple knobs to get the action within the correct priority range. Start by moving the lower-priority knobs first. When you’ve set the priority level for all of the actions, click on OK to save them. To reset the priority levels to the manufacturer’s default, click on Reset.

### 4.1.12 Spine Tool Settings

The spine tool settings page defines default settings for the spine labeling annotation tool. The configuration defined on this page is reflected in the spine labeling window when you activate the annotation tool. To display the advanced settings page, select Customize Settings from the Settings menu, and click on the Spine tab.

The spine labeling function is an annotation tool used to quickly label the components of a spine. When activated, the user clicks on an image, and the next spine label appears. Subsequent clicks add the next label. To progress smoothly through the spine without requiring user interaction, defaults are needed. This page provides the default settings used by the spine-labeling annotation tool.

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial</td>
<td>Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertebra</td>
<td>Enabled</td>
<td>This is the starting point for the vertebral labels. Select the starting vertebra. If the Vertebra radio button is selected, the tool defaults to labeling vertebral disks.</td>
</tr>
<tr>
<td></td>
<td>Disk Interspace</td>
<td>Disabled</td>
<td>This is the starting point for the disk interspace labels. Select the starting disk interspace. If the Disk Interspace radio button is selected, the tool defaults to labeling disk interspaces.</td>
</tr>
<tr>
<td></td>
<td>Include L6</td>
<td>Disabled</td>
<td>If checked, include L6 in the list of lumbar disks. If clear, L6 is not included in the default list of lumbar disks.</td>
</tr>
<tr>
<td></td>
<td>Reverse Direction</td>
<td>Disabled</td>
<td>If clear, labeling progresses in the direction from cervical to sacral disks. If checked, labeling progresses in the reverse direction.</td>
</tr>
<tr>
<td></td>
<td>Show lines</td>
<td>Disabled</td>
<td>If clear, labels appear with no lines connecting the label to the focal point. If checked, lines connecting the label to the focal point appear.</td>
</tr>
<tr>
<td>Label Texts</td>
<td>Cervical</td>
<td>C</td>
<td>Default prefix for new cervical disk labels</td>
</tr>
<tr>
<td></td>
<td>Thoracic</td>
<td>T</td>
<td>Default prefix for new thoracic disk labels</td>
</tr>
<tr>
<td></td>
<td>Lumbar</td>
<td>L</td>
<td>Default prefix for new lumbar disk labels</td>
</tr>
<tr>
<td></td>
<td>Sacral</td>
<td>S</td>
<td>Default prefix for new sacral disk labels</td>
</tr>
<tr>
<td>Size</td>
<td>Height/Width</td>
<td>--</td>
<td>The height and width of the vertebra and interspaces, used when locating the intersecting points on orthogonal images. The value corresponds to the selected radio button.</td>
</tr>
</tbody>
</table>
4.1.13 Dictation Settings

The dictation settings control the tools available for recording dictated reports, including Philips SpeechMike and general microphone controls, foot pedal settings and control of the rewind and fast-forward tools. For backward compatibility, the default settings conform to previous behavior. To display the dictation settings page, select Customize Settings from the Settings menu, and click on the Dictation tab.

These settings are part of the user profile, so they follow the user to each workstation. This could be a problem for the selected foot pedal device. If a device is selected on one workstation and does not exist on another, the foot pedal setting may need to be changed each time the user switches workstations.

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SpeechMike</td>
<td>Type</td>
<td>None</td>
<td>Type of Philips SpeechMike device used. Options are None, Push button and 4-position switch. See section 8.2.3.1 for details.</td>
</tr>
<tr>
<td></td>
<td>Control mode – State based</td>
<td>Disabled</td>
<td>SpeechMike’s record button toggles the state, On or Off. Toggling the state requires the SpeechMike be activated by pushing to top middle button. When active, the red light is on and steady.</td>
</tr>
<tr>
<td></td>
<td>Control mode - Persistent</td>
<td>Enabled</td>
<td>SpeechMike’s record button is On only when the button is pressed.</td>
</tr>
<tr>
<td></td>
<td>SpeechMike button click</td>
<td>Enabled</td>
<td>Controls the audible click when pressing a button on the SpeechMike. When enabled, a click sound is heard for each button click. The click sound is controlled by Windows, and can be changed from the Sounds entries in the Windows control panel.</td>
</tr>
<tr>
<td></td>
<td>SpeechMike pause tick</td>
<td>Enabled</td>
<td>Controls the audible feedback while the SpeechMike is in pause mode. When enabled, a click sounds every two seconds when the SpeechMike is in pause mode. The click sound is controlled by Windows, and can be changed from the Sounds entries in the Windows control panel.</td>
</tr>
<tr>
<td></td>
<td>Record start/stop tick</td>
<td>Disabled</td>
<td>Play back an audible sound every time the record button is pressed or released.</td>
</tr>
<tr>
<td></td>
<td>Keep Speech-Mike active</td>
<td>Enabled</td>
<td>Keeps the SpeechMike activated when you pause your recording.</td>
</tr>
<tr>
<td>Foot pedals</td>
<td>Type</td>
<td>None</td>
<td>List of installed foot pedal devices. Select the applicable one.</td>
</tr>
<tr>
<td></td>
<td>Playback mode – Play/Stop</td>
<td>Enabled</td>
<td>Each push of the foot pedal changes the state, from play to stop playing.</td>
</tr>
<tr>
<td></td>
<td>Playback mode – Push-to-play</td>
<td>Disabled</td>
<td>Recording plays only if the foot pedal is pressed.</td>
</tr>
<tr>
<td>Rewind/Fast forward</td>
<td>Steps</td>
<td>Enabled</td>
<td>Each push of the rewind/FFW pedal advanced the set number of seconds in the records. Holding down the pedal for the Hold Down period rewinds or fast forwards to the beginning/end of the stream.</td>
</tr>
<tr>
<td></td>
<td>Continuous</td>
<td>Disabled</td>
<td>Rewind/FFW continues as long as the pedal is pushed.</td>
</tr>
</tbody>
</table>
### 4.1.14 Speech Recognition Settings

The speech recognition settings control both the embedded speech recognition engine plus all supported third-party speech recognition systems. To display the speech recognition settings page, select Customize Settings from the Settings menu, and click on the Speech Recognition tab.

The embedded speech recognition feature supports multiple options. The workstation must have both the engine’s client and the eRAD PACS Embedded Speech Recognition license installed. When both are present, the option and its configuration parameters are enabled.

Some embedded speech options include application speech control. The custom commands can be downloaded from this window but need to be installed from the engine’s command browser. Details on this and other features of the embedded speech recognition tool can be found in section 8.2.4.1.

eRAD PACS supports third party speech recognition packages by initiating the speech system’s client using information about the loaded study. If the client application and the associated eRAD PACS third-party speech recognition license are installed on the workstation, the option and its associated configuration parameters are enabled in the settings window. In the case of third party solutions, EP does none of the voice to text conversion. How and where that operation takes place is defined by the third party application. For information on which third party speech recognition systems EP supports, refer to section 8.2.4.3

<table>
<thead>
<tr>
<th>Section</th>
<th>Settings</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3rd Party Speech Recognition</td>
<td>Account ID</td>
<td>&lt;EP user ID&gt;</td>
<td>Account ID sent to the speech recognition engine or third-party system.</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td></td>
<td>Password sent to the speech recognition engine or third-party system.</td>
</tr>
</tbody>
</table>
|                               | Use Speech Recognition System  | None               | A list of configured and available speech recognition systems. Options might include the following:  
|                               |                               |                    | None: Record voice stream as a WAV file, and do not convert any of it to text.  
|                               |                               |                    | Dragon: Activate the embedded Dragon speech recognition engine.  
|                               |                               |                    | Fluency Direct: Activate the embedded Fluency Direct speech recognition engine.  
|                               |                               |                    | Powerscribe: Activate Nuance’s Powerscribe client application.  
|                               |                               |                    | SpeechMagic: Activate the embedded SpeechMagic speech recognition engine.  
|                               |                               |                    | VR1 or VR2: Activate eRAD’s VR2 or VR2 client application.  
|                               |                               |                    | XML Interface Speech Recognition: Activate the (generic) XML file-drop integration method. Works for Fluency Direct, Powerscribe, VR1 and VR2 as well.  
|                               | Auto Record WAV when dictating | Disabled           | When using Dragon, also record the voice stream as save it as a WAV file on the server.  
|                               | Show Full report panel         | Disabled           | After disabling the SpeechMike, the full report panel opens automatically. This works best when the SpeechMike is configured in State-based control mode.  
|                               | after dictating                |                    |                                                                             |
### 4.1.15 Presentation State Settings

The presentation state settings page contains default settings for the presentation state creation panel and settings for automatically creating presentation states and key images. To display this settings page, select Customize Settings from the Settings menu, and click on the Presentation State tab.

When the user manually creates a presentation state, the presentation state creation panel pops up. The settings default to the values defined in the Default Settings of PS Creation section on this panel in Customize Settings.

Presentation states and key images are automatically generated when the user drops a select annotation onto an image. When you set the option to create presentation states or key images, a list of annotation buttons appear. Click the annotation tool that, when used on an image, will automatically save the image and annotation as either a presentation state or key image.

Key images are attached to the study’s report. They are uploaded to the server when the report is saved. Presentation states are created on the workstation and uploaded when the user explicitly saves them (from the File menu) or if the viewer is configured to upload presentation states automatically when created.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default settings of PS creation</td>
<td>Selected image/Selected frame/All frames</td>
<td>Selected image</td>
<td>Set the default image selection setting to be the single image, all the images in the selected frame or all images in all frames (for the study).</td>
</tr>
<tr>
<td></td>
<td>Send presentation states to the server</td>
<td>Disabled</td>
<td>When checked, the created presentation state is automatically sent to the server.</td>
</tr>
<tr>
<td>Automatic PS creation settings</td>
<td>Do not generate presentation state or key images</td>
<td>Enabled</td>
<td>The system will not generate presentation states or key images automatically. Users will have to explicitly save these.</td>
</tr>
<tr>
<td></td>
<td>Generate presentation state</td>
<td>Disabled</td>
<td>The system automatically saves the presentation state of the image when one of the annotations selected in this panel is dropped on an image frame.</td>
</tr>
<tr>
<td></td>
<td>Generate (presentation states as) key images</td>
<td>Disabled</td>
<td>The system automatically attaches the image as a key image to the report when one of the annotations selected in this panel is dropped on an image frame.</td>
</tr>
</tbody>
</table>

### 4.2 User Profiles

eRAD PACS supports customizable user profiles. A user profile contains the configuration data, viewer settings, hanging protocols, preset values and other information that make the user environment unique for each individual.
The system stores the profiles on the eRAD PACS server(s), and downloads them to the workstation when the user logs on. As a result, changes a user makes to his or her profile while logged in at one workstation automatically propagates to the next workstation when the user changes location.

4.2.1 Creating User Profiles

eRAD PACS automatically creates a user profile when the administrator creates the user account. A system default user profiles exists. After the user logs on and makes changes to the default profile, the changes are stored back on the server. It is possible to use a user profile from an existing account as the default when creating a new user account. This provides a method for setting up a set of default user profiles, such as one for technologists, one for radiologists, and another for orthopedists, and using this as the baseline profile when creating a new user account. For detailed information on creating user accounts, refer to the eRAD PACS Operator’s Manual.

4.2.2 Applying User Profiles

When a user logs into eRAD PACS, the user profile for that account automatically downloads to the workstation and remains there until the next user logs in. The user does not need to take any explicit action to apply their user profile.

eRAD PACS does not support the application of another user’s profile to your account. If you want to add another user’s setting to your profile, such as a hanging protocol template or series of preset window width and center values for a particular modality, you must set it up manually under your own account, or remove your entire account and recreate it using the other user’s profile as the default.

4.3 Presets

eRAD PACS supports preset settings for window width and center, and hanging protocol templates. Preset settings allow you to group together one or more settings to a specific function, and then apply those settings all at once by selecting the tag from a list. In the case of preset window and level, you can create modality specific window/level pairs, and apply them to a selected image by selecting them from the list. In the case of hanging protocols, you can save the layout used to display a particular study, and then apply it to another study by selecting the tag from the list. If the hanging protocol assistant is active, it may apply the hanging protocol template automatically. In all cases, presets speed up image organization and presentation.

4.3.1 Window Width and Center

The preset list of window and level values provide a list of all saved window/level settings for a specific modality type. The preset window/level list appears in the window/level toolbar. The list of preset values is in the pull-down menu. A few default values exist in the preset window/level list.

- **Initial** corresponds to the default window width and center values applied when the image is first displayed. These values come from, first, the window width and center values explicitly defined in the image object, and, if none are explicitly defined, the actual or auto range, depending on the settings in Customize Settings.
- **Actual Range** corresponds to a full window width, centered in the middle of the maximum range, as defined by the encoded image information.
- **Auto Range** corresponds to the result of a histogram equalization analysis performed on the data. In most cases, this results in a smaller distribution than the actual range due to the interpretation of the pixel data values.

To create a preset window/level entry, load an image into the image frame, and adjust the window width and center to the desired values. On the window/level toolbar, click the Save button, located next to presets list. An information box appears prompting you to enter a label for the settings. By default, the label appears as the window width and center separated by a slash. If you want to use something other
than the default label, clear it and enter a new name. Complete the process by clicking on Add. The label appears in the presets list.

To change the settings for an image, set the window width and center in the selected image, and enter the name in the text field in the window/level toolbar. Click the Save button. A notice appears prompting you to confirm overwriting the original settings. Click Yes to complete the change.

**Instruction Summary – Creating and Changing Preset Window/Level Settings**

- Load image in an image frame and set the window width and center.
- Enter the preset window/level setting label in the text field on the window/level toolbar.
- Click Save.
- If the label already exists, confirm the change by clicking Yes on the popup confirmation notice.

To remove a preset window/level setting, select it from the preset list. The button next to the list changes to a Delete button. Click on the Delete button. A notice appears prompting you to confirm the delete request. Click on Yes to remove the preset setting.

The Initial, Actual Range and Auto Range settings cannot be deleted or modified.

### 4.3.2 Hanging Protocols

Hanging protocols refer to the way eRAD PACS displays the images on the screen. It consists of the grid layout, which series are loaded into which frames, the tile mode of each frame, the visible image in an image frame, series links, window/level (if saved as presets), zoom factor, and panning position.

Hanging protocol templates are available from the template toolbar. The template toolbar exists in either the main viewing area or on the layout manager. Once you define your layout and load the images into the image frames, save the layout.

1. Organize the images in the viewer’s image frames.
2. In the Template toolbar, enter a label for the hanging protocol.
3. Click the Save button, ![Save Button](Image), in the Template toolbar.
4. To create a modality-specific hanging protocol, check the box labeled *Available for specific modalities* and select the modalities from the list. Leave it unchecked to create a generic hanging protocol.
5. Click Save.

When applying a hanging protocol, the hanging protocol manager removes white spaces, if present, from the Series Description attribute of the first image in the series, converts it to lower cases, and compares it against a list of predefined values saved for the hanging protocol. If a match is found, the corresponding series is loaded into the assigned image frame. If no match is found, the frame remains empty, indicating the specified series does not exist in the study.

**Note:** Hanging protocols created prior to v7.0 contain no series description information. Update pre-7.0 hanging protocols by applying them, adjusting the position of the series in the Viewer, and clicking the Save button.

#### 4.3.2.1 Hanging Protocol Sets

Hanging protocol sets are an ordered collection of hanging protocol templates. You can apply each one using a single mouse or button click. To create a hanging protocol set, follow these steps:

1. Create and save the individual hanging protocol templates to include in the set.
2. Press *Create a New Hanging Protocol Set* button ![Create Button](Image).
3. Enter the name of the layout set in the Layout Set name field.
4. Add at least 2 templates to the layout set to form the sequence.
5. Press the Save button.

Apply a defined hanging protocol template by selecting one from the pull-down list on the template toolbar. Refer to section 5.2.3 for additional details on applying a hanging protocol template or set.

4.3.2.2 Default Hanging Protocol Template

If you use one hanging protocol template more often than any other, you can define it as the default for studies acquired from a particular type of modality. By doing so, the hanging protocol assistant automatically applies the default template when you load a new study of the specified type. If you decide to use another template, simply select it from the template list in the Layout Manager.

To define a default template, do the following:

1. Create and save the template you want to use as the default.
2. Go to the Layout page in the Customize Settings window.
3. Select the modality the default will apply to, or choose Default to set the viewer default template.
4. Disable the hanging protocol assistance.
5. Select the template from the pull-down list.
6. Re-enable the hanging protocol assistant to make the default apply only when no specific template exists.

eRAD PACS records the window and level settings in the hanging protocol template if the window width and center values exist as preset window/level setting. Before saving the template, define and save the window and level settings as a preset W/L value. Apply the W/L settings to the images in a frame. Then save the template as previously defined. The next time you apply the template, eRAD PACS looks to see if the recorded W/L setting in the template matches a preset W/L setting for the modality type. If defined, eRAD PACS applies it to the image. Since eRAD PACS stores a separate list of preset W/L values for each modality type, it is likely that you will not have the same named W/L preset for more than one modality. As a result, eRAD PACS usually applies preset W/L values to studies from the same type of modality that you used to create the template.

4.3.2.3 Hanging Protocol Assistant

The hanging protocol assistant is an automated pattern-matching algorithm that matches existing hanging protocol templates to the characteristics of the study. When opening a study, the hanging protocol assistant searches the defined templates to find the one that best matches the study. If it finds a good match, it automatically applies it to the study. If no good match is found, the hanging protocol assistant uses the configured default settings for the study’s modality type. If no match is found and no default configuration exists, the assistant displays the layout manager so you can manually organize the study.

Turn the hanging protocol assistant on and off using the Use hanging protocol assistant checkbox on Customize Settings’ Layout page. When enabled, the hanging protocol assistant inspects the characteristics of the existing study and selects the template you used in the past for a study with similar characteristics. The assistant looks at the following study characteristics:

- study description
- body part
- modality
- number of studies
- number of series in study
- localizer image(s)
- number of monitors
- monitor orientation

The hanging protocol assistant learns by observing your behavior as you apply templates and creating rules it can follow. As in any learning experience, the assistant initially knows very little about your reading behavior. By defining, saving and applying templates appropriately, the hanging protocol assistant should correctly select the best template after a short period of time. The hanging protocol assistant learns by analyzing the study’s characteristics and which template you applied, and adds it to its rules base. If
necessary, you can reset the rules to the factory default by selecting Reset Hanging Protocol Rules from the Layout panel in the Customize Settings window.

4.3.2.4 Custom Keyword Dictionary
The dictionary the hanging protocol assistant uses to identify series is customizable. To modify the built-in default dictionary, export it from the viewer as follows:

1. From Windows Start, open a command prompt window. The location of this tool depends on your version of Windows.
2. Change the directory to the one in which eRAD PACS is installed. The default is c:\Program Files\PracticeBuilder or c:\Program Files (x86)\PracticeBuilder.
3. Run the following command: \pbuilder.exe --osdk series_description_keywords.xml
4. From a Windows Explorer window, launch the series_description_keywords.xml file in a text editor and make changes. For details on the file format, refer to the eRAD PACS Hanging Protocol Series Matching Configuration Manual.
5. Save the changes to the same file in the same folder.

When this file is found in the workstation’s PracticeBuilder folder when the viewer launches, it overrides both the built-in default and the customized version on the server.

4.3.2.5 Display Hanging Protocol Matching Criteria
For debug purposes, you can display the criteria the hanging protocol manager is using to identify a series for a specific image frame. The value is available as an overlay field. It can be compared to the actual Series Description value to see why they match or don’t match.

To display the hanging protocol’s series description criteria, do the following:

1. From the View menu, select Customize Settings.
2. Select the DICOM Fields tab.
3. Select the Display Location that will display the matching criteria.
4. In the Info section, select HP Series Info and click Add Info. The field appears in the displayed values list on the left.
5. Click OK.

When the hanging protocol manager determines a series belongs in an image frame but the current study does not contain a series matching the criteria, the image frame is left blank. Some users might think this is confusing or even an error. To eliminate the confusion, users might consider displaying the series description criteria in empty image frames. When enabled, a frame without any data will display either the description of what should be there but isn’t present in the study, or nothing indicating no assignment was made for that cell.

To enable the series description in an empty image frame, do the following:

1. From the View menu, select Customize Settings.
2. Select the Colors tab.
3. In the Color Settings list, select HP Series Info.
4. Set the color to anything other than the image frame background color. Since the default image frame background color is black, set the color to white.
5. Click OK.

4.3.2.6 Hanging Protocol Debug
If the viewer uses a custom hanging protocol dictionary file and it contains the debug tag, the viewer creates a log file containing hanging protocol details you can use to debug the HP decision making process.

Insert the debug tag in the HP keyword dictionary as follows:
1. Create a local copy of the HP keyword dictionary, series_description_keywords.xml, as described in section 4.3.2.4.
2. Edit the HP keyword dictionary and insert the debug tag in the Default section:
   
```xml
<DebugLevel>x</DebugLevel>
```
   
where x is one of the following
   1. List the scores for each combination of template’s series to study’s series
   2. List the score of each keyword by keyword comparison
3. Restart pbuilder.exe.

The hanging protocol debug log is found the ...\PracticeBuilder\DescriptionMatchingLog.txt

To disable debug logging, remove the customer HP keyword dictionary file or remove the debug tag from the file.

## 4.4 Keyboard Macros

Keyboard macros are collections of existing tools applied through a single keyboard entry. For example, reset the zoom factor, orientation and window/level setting by pressing Ctrl-Z. Keyboard macros functions are available on the Macro toolbar (see section 3.1.14) and the Settings menu (see section 3.2.3).

To create a keyboard macro, load a study into the viewer and perform the following:

1. Click the Start Recording button,
2. Apply each command in the order it is to be executed in the macro.
3. Click the Stop Recording button, The Save Action Macro panel pops up.
4. Enter a macro label.
5. Click the Change button to define the shortcut input sequence. This can be any combination of Ctrl, Alt, Shift and alphanumeric key.
6. Click Save.

To apply a keyboard macro, press the input sequence assigned to the macro.

Macros are available for reviewing, editing, deleting and assigning to the context (right-click) menu from the Macro Manager, available from the Macro toolbar or Settings menu.

To edit a keyboard macro, follow these steps:

1. Click the Show Macro Manager button,
2. Select the macro from the Recorded Macros list.
3. Click the Edit button.
4. Change the macro’s settings. To disable the macro but keep it defined, click the Change button and press ESC.
5. Click Save.
6. Click Close.

To delete a keyboard macro, follow these steps:

1. Click the Show Macro Manager button,
2. Select the macro from the Recorded Macros list.
3. Click the Delete button.
4. Click Close.
To assign an existing macro to a context menu, follow these steps:

1. Open the Macro Manager panel.
2. Select the context menu you want to configure from the pull down list.
3. Select the keyboard macro from the Recorded Macros list.
4. Click Add. The macro appears in the Custom Context Menu list.
5. Move the macro to the preferred position in the list by selecting it and using the up/down buttons.
6. Click Close.

Macros are user-specific and follow the user to each workstation automatically.

### 4.5 Prestaging

eRAD PACS workstations support prestaging technology via the viewer prefetch function. The viewer prefetch function consists of a prefetch worklist filter defined by each user, and a query initiated by the viewer. When the query request yields information on new studies that match the prefetch filter, eRAD PACS viewer retrieves the studies to the workstation and prestages them for viewing.

In addition to the prefetching function, a registered viewer supports auto-routing. The auto-routing function permits the workstation to have a prefetch filter, in addition to the user’s prefetch filter. Auto routing transmits the studies that satisfy the workstation’s prefetch filter when they arrive on the eRAD PACS server.

#### 4.5.1 Prefetching

To turn on prefetching, enable the prefetch setting in the Customize Settings’ Prefetch panel, and configure the eRAD PACS viewer to run in standby mode from the Customize Settings’ Settings panel.

When the user enables prefetching from the prefetch page in the Customize Settings window, eRAD PACS uses the worklist’s filter definition labeled *Prefetch* to select the studies to send to the workstation. Define a filter that includes all the studies you want to prestage on the workstation, such as all high priority (STAT) studies, or all unviewed studies that take place during your reading hours, and save it as the prefetch filter. When the eRAD PACS viewer queries the server for new studies, it applies the user’s prefetch filter and downloads the first 20 studies that exist on the list, if not already in the viewer’s cache.

The prefetch settings page provides the only means for enabling and disabling prefetching. An administrator can disable prefetching by logging in from the prefetching workstation as the user who enabled it, and clearing the checkbox.

When enabled, prefetching occurs when the eRAD PACS viewer is loaded with a study and when it is running in standby mode. Depending on the resources and performance of your workstation, you may experience interference due to the background prefetch processing when using the viewer. If this happens, select *Prefetch in Standby Mode Only* in the Customize Settings’ prefetch page. When selected, prefetching will cease when you open a study in the viewer and automatically restart when the viewer returns to standby mode.

When prefetch is enabled and the viewer fails to connect to the configured prefetch server, a message appears in the system tray. The message appears for 30 seconds or until the user dismisses it with a mouse click. The message is repeated hourly.

Since prefetching continues to function after the user logs off of the workstation, excess data traffic can result when too many workstations have prefetching enabled. Reduce the network traffic by increasing the prefetch cycle time.
4.5.2 Auto-Routing

A registered eRAD PACS viewer can have its own prefetching worklist, independent of a specific user. eRAD PACS calls this form of prefetching auto-routing. The registered viewer controls auto-routing through an auto forward filter configured on the eRAD PACS server.

Start by defining a filter for all the studies you intend to auto-route to the workstation. Assign a label and save the filter. On the Other Lists page, select the Auto Forward function for the new filter. In the popup window, select the specific eRAD PACS viewer device you want to route the matching studies to. Note that the registered viewer must exist in the device table on the Devices page. Click Apply to save the settings. From the viewer’s Customized Settings panel, enable prefetching from the Prefetch tab. When the workstation boots and the viewer enters standby mode, it periodically polls the eRAD PACS server. The default poll period is once every 30 seconds. When new studies matching the filter appear on the EP server, they are immediately downloaded to the workstation.

When a user logs into a registered viewer, auto-routing adds the user’s personal prefetch worklist filter to the query requests. When the user logs off of the workstation, prestaging returns to the workstation’s auto-routing configuration.

4.6 System management

Under normal circumstances, the eRAD PACS viewer handles all the routine maintenance and system management functions. Nevertheless, a number of tools exist for manually verifying or overriding the viewer’s regular procedures.

4.6.1 Monitor Calibration

Some digital modalities such as CT and MRI convey actual pixel size and spacing information. The Practice-Builder 1-2-3 viewer uses this data to automatically render images using the correct aspect ratios, calculate distances and area measurements, and display objects at their actual size. Some devices, such as frame grabbers, including ultrasound, and film scanners, do not. For the modalities that do not provide this information, eRAD PACS provides a calibration tool that the user can use to help the viewer generate it. For detailed information on image calibration, refer to section 5.5.8.

Once the pixel size and spacing information is available, eRAD PACS still needs to have information about the monitor in order to render images properly. For this reason, the user has the ability to calibrate the monitor. While image calibration is needed for each study, monitor calibration is only needed once for each monitor. However, for safety reasons, eRAD PACS prompts the user to confirm the monitor calibration for each study. Since eRAD PACS records the previous monitor calibration settings, if the monitor or display resolution has not changed, the user simply needs to confirm the setting.

To calibrate a monitor, select the Calibration item on the Settings menu, and select Monitor. A notice appears explaining how to use the monitor calibration tool. If you do not want this notice to appear each time, click on the checkbox that indicates you do not want to display it again. Then click on Next. Using a ruler held up to the monitor glass, drag the horizontal and vertical rulers on the screen using the mouse until they reflect the actual size. When finished, click on OK.

Repeat this process for each monitor, using the Settings menu at the top of each monitor to open the monitor calibration window for each respective monitor. Once you have calibrated all of the monitors, you will not have to do it again until you either update the eRAD PACS viewer, or modify the hardware or display settings.
4.6.2 Emptying Cache

The eRAD PACS viewer cache can hold a lot of data, and therefore it may consume substantial amounts of disk space. If you share your PC with other applications, you may find it necessary to reclaim the disk space allocated to the viewer cache. Additionally, for security reasons, you may want to erase image files from your system after you have finished using them. Typically, eRAD PACS manages its cache by clearing unnecessary files on an as-needed basis. Therefore, no intervention is needed. Nevertheless, eRAD PACS provides manual and scheduled cache clearing functions to remove lingering data files from the disk.

To manually remove the data from the eRAD PACS cache, select the Empty Cache function from the File menu or from the Customize Settings’ cache page.

To schedule a recurring purge of the cache, do the following:

1. From the Settings menu, select Customize Settings
2. Select the Cache tab
3. Check the box labeled Purge Files From the Cache After N Days
4. Enter the number of days after which a purge will take place
5. Click on the Settings tab
6. Click to put a check in the box labeled Standby Mode

As long as eRAD PACS is running in standby mode, it will automatically empty the cache every Nth day.

4.6.3 Running Other Programs

The eRAD PACS active-X and standalone viewers are both designed to function alongside other Windows applications. Provided the other applications are designed to do the same, any user should be able to run any application while the viewer is running, whether it is in standby mode or active with a study loaded.

4.6.4 Licensing

The use of the eRAD PACS viewers require a valid license. All eRAD PACS licenses are customized for and installed on the server. When the user logs into eRAD PACS, the server checks that the license is installed and permits the operation requested. Administrators can review the licensed components in the User License Information section of the Server web page.

The eRAD PACS active-X viewer requires the standard viewer license. The standalone viewer’s license is embedded in the viewer installed on the media.

Plug-in licenses are managed separate from the basic and workstation licenses. A user is licensed to use the specified plug-in module if the server the user is logged into has the plug-in license installed. Since the plug-in license is server-based, it is possible for a user to have access to the plug-in module when logged into one server, and not have access to it when logged into another.

4.6.5 Permissions – Open Rights, Report Rights

Use of the eRAD PACS active-X viewer is a privileged operation. To invoke the viewer, the administrator must have assigned Open rights to your account. If you receive a notification when attempting to open a study in the viewer informing you that you are unable to access the viewer application, contact your system administrator and request Open privileges.

The viewer has the ability to edit reports. Note that editing a report includes changing the state, adding a key image, saving a processed series back to the server, dictating a report, approving a report or making notes on the report page. Report edits require Report rights. If you are unable to save changes made to the study from the eRAD PACS viewer, contact your system administrator and request Report privileges.
4.6.6 NETWORK TRANSFER OPTIMIZATION

The best setting for optimized data downloads across a local area network is to use no compression and large data packets in the network transfers. Conversely, the best setting for optimized downloads across a wide area network is compressed data and small packet sizes. eRAD PACS automatically sets these settings based on its configuration and on measured feedback it obtains during each download operation. Nevertheless, it is possible to override these and force a specific compression application or network packet size.

eRAD PACS supports settings to define what address ranges constitute the local area network. They are defined in the LAN domain field on the server’s Server web page. Any IP address not on this list is deemed accessible via a wide area network. eRAD PACS uses these settings to automatically adjust the compression setting and the initial network packet sizes for data transfers between its server and viewer.

The user can override these automatic settings from the customize settings window in the eRAD PACS viewer. The Advanced page controls the compression setting for download of the study summary information, and the packet size for all transfers. The Prefetch and Image pages control the compression setting for the download of the image data. When set to Auto, these settings are dynamically set based on the eRAD PACS LAN domain setting, plus the measured feedback eRAD PACS obtains during each download operation. In almost all situations, Auto yields the best overall download performance.
5 Displaying Images

The primary function of the eRAD PACS viewer is to display full-fidelity images for primary interpretation. This section contains information on how to open and manage the viewing area, load a study, organize the images once they load, manipulate the data, and save your changes before closing.

5.1 Opening a Study

How you load a study into the eRAD PACS viewer depends on which viewer you use and where you start. In all cases, the first step is to display a list of available studies. The tools available for displaying the study list differ slightly among the different viewers. The sections that follow describe how to select one or more studies to load into the eRAD PACS viewer, how to navigate to other studies once you have one open, and what the different viewing modes mean.

5.1.1 Opening a Study from the Study List Panel

In both registered active-X and standalone viewers, display the list of available studies from the Study List window, shown below. The study list contains a table of studies that exist on the CD/DVD (standalone viewer) or in the local cache (registered active-X viewer). In the registered viewer, it is possible to obtain a list of all available studies on the server by clearing the Local Only checkbox at the top of the study list window.

To load a study, open the study list window by clicking the button, in the Standard toolbar, or selecting CD Contents or Study Panel from the View menu. The study list has many of the functions available on the browser worklist, including sorting and filtering (registered viewer only) capabilities. Using these functions, locate the study you want to load. On some versions of the standalone viewer, a browse function is available. If it is, the Browse button, , appears at the top of the study list. Click this button, and use the Windows explorer window to locate either a DICOMDIR file, or specific DICOM object files. Click Open to make these studies appear in the Study Panel.

Click on the patient name, or the open button, , on the left side of the row. To open multiple studies at one time, use the batch open function in the study list window. Using the list filter and sorting functions, get all the studies you want to load onto a single page in the study list. For each study, click to put a check in the box on the far left of each row. When all the studies are marked, click on the batch open button, , in the top left corner of the study list.

If eRAD PACS finds prior studies when attempting to open a study in the registered viewer, it displays them in the study list. The study you select is indicated by the shaded row. The other studies are relevant priors that have been prestaged from the archive. Clear the Local Only setting to get the server worklist, and load the study.
eRAD PACS does not support adding a new study to a list of studies already open in the viewer. If you need to add a study to your viewer, you must save your work, close the current study, and open it again, this time adding the additional study to your list of selected studies.

5.1.2 Opening a Study in the Active-X Viewer

The eRAD PACS active-X viewer is a downloadable application that displays images stored on the eRAD PACS server. You are advised to always download and install the latest version of the eRAD PACS viewer. Follow the instructions in section 2.3.2 to install the active-X viewer. Once installed, you are ready to open studies.

Opening a study in the eRAD PACS active-X viewer starts with the worklist page in the web browser. Request a study by clicking on the hyperlink in the Patient Name column, or click on the Open button to the left of the study information on the worklist. To open multiple studies at one time, use the worklist filter function and page size field to get all the studies listed on one worklist page, and then check the box on the far left side of each row. At the top left corner of the worklist, click on the batch open button. The eRAD PACS viewer loads all the selected studies.

When opening a study from the hyperlink, eRAD PACS checks the database for relevant priors that match the selected study. If it finds any, it displays the list in a new worklist. The study you selected is identified by the shaded row. Select the studies you want to include by putting a check in the box to the left of each line, and click on the batch Open button at the top left corner of the worklist. If you want to open just one of the listed studies, click on the patient name hyperlink, or the Open button in the study’s row.

For additional information on selecting a study list from the eRAD PACS worklist, refer to the eRAD PACS Operator’s Manual.

If the eRAD PACS active-X viewer is running in standby mode, it will appear on the screen rather quickly. If standby mode is disabled, Windows will load the program into memory, and then it will appear on the screen. Since this involves reading the application from disk and loading it, it may take a considerable amount of time to launch the viewer, depending on the configuration of the workstation. To improve the time to launch the viewer, run it in standby mode. See section 4.1.1 for information on enabling standby mode.

There are two stages to opening a study. The first is the transfer of the study information from the server to the viewer. This occurs regardless of the whether or not the study already exists in the viewer’s local cache. The progress of this download is shown by a blue line progressing across the Status bar, and by a completion percentage displayed in the far right of the Status bar. When the transfer completes, the viewer has all the information it needs to display the thumbnail images, select a hanging protocol template, and start loading the images and report data.

The second stage of opening a study in the eRAD PACS viewer is the loading of the image and report data. First, eRAD PACS checks the local cache to see if the data is already on the workstation. If found, the data is loaded from disk. Otherwise, the viewer pulls the data across the network from the eRAD PACS server. If redirection is enabled, the viewer pulls the data over from the closest server to minimize network traffic and download time. A blue progress bar located along the bottom edge of each thumbnail image shows the progress of each image download. To instruct eRAD PACS to download a specific image first, load that thumbnail into a frame in the main viewer workspace. All the series loaded into the main viewing workspace go to the front of the download queue, and the images displayed at the top of each frame get downloaded first.
5.1.3 **Opening A Study From The Patient Folder**

Studies available on the server but not loaded into the current viewer session are indicated in the patient folder with a defined background color, blue by default. Load these into the current viewer session as follows:

- Drag the study cell in the patient folder into the thumbnail panel, or
- Select the study cell in the patient folder and click the Load button, ![load button], at the top of the study list.

5.1.4 **Opening Next and Previous Study**

In the eRAD PACS viewer, the user can immediately open the next study in the worklist by using the Ctrl-Alt-Down keys. Similarly, the Ctrl-Alt-Up keys open the previous study in the worklist. These functions are also buttons available in the Standard toolbar, ![next study button] and ![previous study button].

To determine the next study, eRAD PACS first applies the current filter to the database, then finds the study you currently have open, and finally, opens the study that immediately follows it on the worklist. For the previous study, eRAD PACS does the same except it chooses the study that immediately precedes the current study on the worklist. The viewer does not qualify the study, meaning it is not possible to use the next/previous feature to open, say, the next *Unviewed* study. To accomplish this, you need to apply the appropriate worklist filter prior to using the next/previous function.

When you use the next/previous function, you are required to respond to any prompts that appear before eRAD PACS will close the open study. For example, if you have entered a report but failed to send it to the server, the viewer prompts you to either send it or delete it. Once you have cleared all the prompts, the current study closes and the next one opens without having to re-launch the viewer.

5.1.5 **Save Current Workspace To Open Another Study**

A user can bookmark his or her work, and return to it later. To bookmark the active study,

1. Click on the Bookmark button, ![bookmark button], select Bookmark from the File menu, or press the Ctrl-Alt-B keys.

The viewer saves the study’s current state, including the image layout, selected key images, annotations, dictations, and study state on the local workstation. After bookmarking a study, it is safe to close the study and open the viewer again with another study, log out of the system, or open the same study again.

To restore a bookmarked study,

1. Close the study you opened after bookmarking the original, click on the Restore button, ![restore button], or press the Ctrl+Alt+R keys.
2. If multiple bookmarked sessions exist, the selection list pops up.
   a. From the list, select the bookmarked session
   b. Click Restore to restore the selected session.
   c. Click Delete to remove the selected session. If changes were made but not saved, they might be lost.
   d. Click Cancel to close the popup window and return to the current viewer session.

If you changed user accounts, you need to re-login in as the original user to return to the bookmarked study state.
If the viewer is open with a study that contains edits when the auto-logout timer expires, eRAD PACS bookmarks it for the user automatically. To restore the study, log in, open the viewer from the system tray, and click on the Restore button.

5.1.6 Study Locking and Read-only Mode
If you open a study but cannot make changes, the study is in read-only mode. This applies when you open a study from a CD, do not have report editing privileges or some other user has the study open already. When in read-only mode, you receive a notification informing you of this. You can continue to look at the study, but no changes you make are recorded. Some users may be given the ability to override the read-only privileges. If you have this ability, the notification informs you of who currently controls the editable version of the study, and prompts you to break the lock, as seen in the screen shot shown here.

If you opt to break the lock, you have the only write-enabled copy of the study. The other user receives a warning that you have taken the lock, but is unable to stop you from doing so. He will be unable to save his work to the server. It is advisable to verbally notify the user listed in the notification that you intend to break their lock before doing so. This provides him with an opportunity to save his work.

If you receive a notice indicating another user has taken editing rights (i.e., the study lock) away from you, you can save your work to your local workstation. When you open the study again and are granted the editing rights to the study, you can import the saved changes (provided you are working on the same workstation), and then save them.

5.2 Organizing the Study Data
Displaying images with eRAD PACS is completely customizable. You can change the characteristics of the display area, and specify how much of the window you want an image to occupy. You can stack images, tile them, increase and decrease image size, flip, rotate and invert images, change the window width and center, invert the grayscale slope, run a cine loop for a set of images, magnify images, change image attributes, and more.

The primary tools for organizing the images are the thumbnail panel, the layout manager and the hanging protocol assistant. The thumbnail panel contains a sub-sampled rendering of each image, usually grouped into series. The thumbnail panel exists to the left of the main viewing area, and is available at all times. The layout manager is a popup window that consolidates the entire viewing area across all configured monitors into a manageable popup window. From the layout manager, you can define the viewing workspace, organize the images, and save the settings as hanging protocols. The hanging protocol assistant automates the application of hanging protocols. It interprets study characteristics and finds an appropriate hanging protocol to apply.

5.2.1 Loading Images from the Thumbnail Panel
The thumbnail panel lists the available series. When displayed, the thumbnail panel appears on the left of the main viewing area of the primary monitor. See section 3.4 for details on the thumbnail panel.

Load a series of images from the thumbnail panel into the main viewing workspace by either double-clicking on the thumbnail image, or clicking and dragging the thumbnail image to the viewing area using the left mouse button. To overwrite an existing set of images, use the drag-and-drop method. If the Persistent Frame Settings setting is enabled, the tile mode settings applied to the image frame are applied to the thumbnail images. Otherwise, the default tile mode is applied.

To concatenate multiple series into a single frame in the viewing workspace, hold down the Ctrl key while you drag and drop the series into the desired frame. When concatenating images and series into a single
image frame, the cursor changes from the normal drag-and-drop cursor to one with a plus sign (+). This cursor indicates the series being dragged will be added to the images that already exist in the frame.

To quickly load all of the series in a study into the main viewing area, double-click on the study’s header. This method for loading series into the viewing workspace sets the viewer’s grid across all available monitors to accommodate all of the series, and then loads one series into each image frame. The maximum number of image frames eRAD PACS creates on a single monitor is based on the monitor size, but is generally 16. If more series exist than image frames, only the first few series are loaded. Use the drag and drop method of loading series to replace the series displayed in one of the image frames.

Double click the study header while pressing the Ctrl button to load all the images in a study into the next available image frame. If no image frame is available, empty one or more image frames to make room for the global stack, and repeat the action.

To load the thumbnail in the next open image frame:
1. Position the cursor over the thumbnail image and double-click the left mouse button.

To load or overwrite the thumbnail in a specific image frame:
1. Click and drag the thumbnail image using the left mouse button to the selected image frame and release.

To concatenate multiple thumbnails to a single image frame:
1. Load the first thumbnail series into an image frame.
2. While holding down the Ctrl key, click and drag the second thumbnail image/series into the same image frame.
3. Repeat as necessary, until all series are loaded into the selected image frame.

To load an entire study into a single image frame:
1. Position the cursor over the study header and double-click the left mouse button.

5.2.2 LAYOUT MANAGER

The layout manager consolidates the entire viewing area across one or more monitors into a compact popup window. Depending on your configuration, the layout manager may appear automatically when you load a study. When hidden, display the layout manager by selecting it from the View menu or press the F6 key. For details on the layout manager, refer to section 3.6.1.

The first step in loading the images into the viewer workspace from the layout manager is to select the grid layout. From the grid tools toolbar, select the number of image frames you want to appear on each monitor. If you want a single grid to span across all your monitors, select the span button, [ ]. To apply a different grid to each monitor, ungroup them. By default all monitors are grouped. The white frame around each monitor in the layout manager notes this. Select each monitor independently by clicking on the colored (blue or gray) title bar in the monitor in the layout manager. When only one monitor is selected, assign the grid layout. To regroup all the monitors together, press and hold the CTRL key when clicking on the colored title bar.

The layout appears on the emulated monitors in the Layout Manager. Each time you click on a predefined grid button, the layout will change. You can resize the frames in the default grid by placing the cursor over the boarder lines in the emulated monitor, clicking the left mouse button, and dragging the line to obtain the desired size.
Loading the images into the grid is the same from the layout manager as from the thumbnail panel. Refer to section 5.2.1 for information on loading the series into the viewing workspace.

eRAD PACS’s default display mode is to display the layout manager when the study loads. If you want to prevent the layout manager from appearing each time you launch a study, set it to remain hidden until manually activated. Open the Customize Settings window and go to the layout page. Clear the checkmark in the box labeled Show Layout Manager to hide it. A check in the box instructs eRAD PACS to always display the layout manager. If the checkbox is disabled, it is because the hanging protocol assistant is enabled. In this case, temporarily disable the hanging protocol assistant by clearing the checkbox labeled Use hanging protocol assistant. Make your changes to the other settings, and then re-enable the hanging protocol assistant by putting a check back in the box.

5.2.3 HANGING PROTOCOLS

eRAD PACS provides hanging protocols for reducing the time needed to organize the image data in the viewer. A hanging protocol is a record of how the series and images in a particular study are arranged in the main viewing workspace. You create hanging protocols by saving the current layout under a defined template name. When you select the hanging protocol template, eRAD PACS applies the grid layout, and then moves the series and images into the defined image frames. It also applies the defined linking state, window and level settings, zoom factor and frame position. See section 4.3.2 for a thorough description of hanging protocols.

Apply a hanging protocol by selecting the template from the Template toolbar.

The Template toolbar can exist in the layout manager or the main viewing workspace. Click on the arrow button to display the list of available templates. The viewer applies the template to the current study to the best of its abilities. If one or more series defined in the template do not exist in the open study, eRAD PACS leaves the image frame empty.

Hanging protocol sets in the hanging protocol selection box are designated with an asterisk (*). To apply a hanging protocol set, select it from the drop-down box in the Template toolbar. The buttons beside the hanging protocol selection box change to Modify Current Hanging Protocol Set, and Go to Next Layout in the Hanging Protocol Set. Repeatedly click the Go to Next Layout button to advance through the hanging protocols in a sequence. When you reach the last hanging protocol, it loops and starts over.

The hanging protocol assistant is the tool that automatically checks the characteristics of the new study against the defined hanging protocol templates, including hanging protocol sets, and selects one to apply. If no good match is found, the hanging protocol assistant pops open the layout manager. Otherwise, it displays the series and images as the template specifies. For detailed information on how the hanging protocol assistant selects a template, refer to section 4.3.2.3.

When you end a study session, the hanging protocol assistant makes a note of the studies characteristics and the template you have applied at that time. The assistant analyzes this information and adds it to its rules base. Note that if you change the template before closing the study, the assistant will not learn how to apply them correctly.

5.2.4 APPLYING USER-SPECIFIED PRIOR TO CURRENT LAYOUT

A hanging protocol contains rules for selecting the studies loaded into image frames. For example, it might load the current (primary) study into image frames on monitor 1 and the first prior into image frames on monitor 2. You can override the default prior defined by the hanging protocol, updating your layout without affecting other image frames.

To replace a study loaded into image frames with a different study listed in the thumbnail panel, do the following:
1. Select a hanging protocol from the hanging protocol toolbar. The viewer might do this automatically when it initiates the session.
2. From the thumbnail panel, left-click the study’s header and drag it into an occupied image frame.

The hanging protocol assistant replaces the study whose images occupy the target image frame with images from the selected study using the same rules defined by the current hanging protocol.

5.3 The Viewing Area

The eRAD PACS viewing workspace displays the full-fidelity diagnostic images. This area makes up the majority of the graphical user interface, and is generally clear of any formatting or obstacles. To render the images in a manner conducive to each user’s individual preferences, the user can apply different tools to manipulate the area’s layout. The user can apply a predefined or custom grid layout, display images in a stack mode or in a tiled mode, create a common or disassociated environment across all monitors, and quickly hide all screen objects except the image to eliminate any distractions the interface may cause.

5.3.1 Grid Layouts

eRAD PACS uses a dynamic grid to display images in the main viewing workspace. For example, a common grid layout is a 4-up symmetrical grid, consisting of two rows and two columns, as shown here, before adding the images. You can select from predefined grid configurations, define custom symmetrical grids, and create asymmetrical grids using the framing tool.

The tools for selecting and creating a grid pattern are available from both the main viewing workspace and the layout manager. The most common tool used for choosing a grid layout is the Grid toolbar. Click on the button showing the grid layout you want to apply to the main viewing workspace. You can also select a grid layout from the Grid layouts submenu on the Settings menu. On eRAD PACS workstations with multiple monitors, you can apply a different grid layout to each one. By default, all monitors use the same layout. To set just one, open the layout manager, and click on the colored title bar of the graphic that represents the monitor you want to make unique. The white border appears around the selected monitor only. Click the button on the grid toolbar to set the monitor setting. To move to another monitor, select it by clicking on the colored title bar. To group all the monitors again, hold the CTRL button while clicking on the colored title bar. A white border appears around all the selected monitors.

Each frame in a grid contains an independent instance of the images. This means when you place an image or series in multiple frames, each instance has its own display characteristics, such as window and level setting, zoom factor, orientation, and any characteristics. For example, you can render the abdominal series of a CT study in two different frames, and apply a tissue window/level setting to one frame and a lung setting to the other.

When you select a grid pattern, the defined frames always remain on the screen. However, you can change the size of each to the frames by dragging the borders to enlarge or reduce their size. When you place the mouse cursor over the line separating the grid’s individual frames, the cursor icon changes to either a two-directional arrow or a four-directional arrow. The cursor indicates the direction in which you can move the border. While holding down the mouse button, drag the mouse and the grid changes size. If you have the images displayed as Fit to Window, the image size changes in relation to the grid size.

Once you have loaded the images into the image frames, you can rearrange them by dragging them from one frame to another. When you move the images to another frame, the images in the destination automatically move to the original frame. Basically, you are switching the data in the two frames. If the destination frame is empty, the original frame clears after the move.
To move the images from one frame to another, position the mouse over the top left corner, over the two diagonal lines. The cursor changes to a hand. Click and hold down the left mouse button. Drag the frame to any other frame in the viewing workspace. Release the mouse when your cursor is situated over the destination frame.

Copy the contents of one image frame into another by positioning the mouse over the diagonal lines in the top left corner of the frame, holding down the Ctrl button, and pressing the left mouse button. The cursor changes to include a “+” sign. Drag the mouse to a free image frame and release. A copy of all the images in the source frame now exists in the target frame.

To clear the images from a frame, drag the frame back to the thumbnail panel (on the main viewing workspace or in the layout manager.) You can quickly clear all the series by selecting a new grid layout from the grid toolbar.

5.3.1.1 Customizable grid layouts
The grid toolbar offers the user a fixed set of grid layouts. These consist of 1-up, 2-up, 4-up, and other symmetrical layouts, plus an asymmetrical 3-up. Two methods exist for creating custom grid layouts.

The custom grid button, on the grid toolbar enables you to create symmetrical grids that are not already available. Click on the custom grid button. A popup window appears prompting you to enter the number of rows and number of columns to apply to your grid layout. After entering the values, click OK. eRAD PACS applies the defined row and column count. A limit to the number of rows and columns does exist. The particular limit depends on the resolution of your monitor.

The second customization tool creates asymmetrical grid layouts. With the frame-splitting tool, you can split existing frames in half. Each frame created has the same independence as any of the default grid frames, meaning you can insert any group of images into customized frames and apply a window and level, zoom factor, orientation, etc., to it. You can also save these customized layouts as templates.

To customize a layout, start with the best-fitting predefined grid layout from the grid toolbar, or use the Grid layouts submenu on the Settings menu. To split any one of the available frames into two independent frames, click to select the frame you want to split into two frames. From the Grid layouts submenu from the Settings menu, go to Split selected cell, and choose the position of the new frame relative the selected frame. A new, empty frame appears next to, above or below the original frame. To remove one of the frames, repeat the procedure, except select Join selected cell from the Grid layouts submenu.

5.3.2 Tile Layouts
By default, each grid displays the series in stack mode, meaning the image at the top of the stack takes up all the space in the frame, with the other images behind it. This is actually a 1-up tile mode. You can expand the stack into individual image slices by selecting different tile mode. For example, if you want the images in a frame to appear similar to a common 12-up sheet of film, you would apply a 12-up tile mode, with four rows and three columns. eRAD PACS’s tiles modes are on the Tile toolbar, which is available in the main viewing workspace and the layout manager.

A tool exists for defining a custom tile layout. On the Tile toolbar, click the custom tile button, , and a popup window appears prompting you to enter the number of rows and columns to apply to your frame. After entering your preferences, click OK, and eRAD PACS applies the tile mode to the selected frame. Note that the number of rows and columns you can use is limited. The particular limit depends on the resolution of your monitor.

5.3.3 Full Screen Mode
eRAD PACS provides a display mode that removes all screen objects, such as the toolbars, menus, thumbnails, and Windows taskbar, and displays the selected frame as large as possible on the monitor.
This permits you to eliminate all potential distractions and extraneous light from the screen, leaving just the pixel data in the image object.

To display an image in the full screen mode, click on the frame and then press the F5 function key. While in full screen mode, you can apply most functions eRAD PACS makes available on the mouse, including window and level, panning and zoom. To return to the normal display mode, press the ESC button, click the close button in the top left corner of the image, or press F5 again.

To quickly maximize an image without removing the menus, toolbars, etc., double click the right mouse button. The selected image appears in a 1-up frame. This applies when the viewer’s grid layout is anything other than 1-up and the selected image frame is not running a plug-in module. Double-click again before making any significant changes to the 1-up display to restore the original grid layout. Changes that drop the original layout include applying a new grid layout, loading a new series into the image frame or applying a plug-in module to the image frame.

### 5.4 Managing Series

eRAD PACS groups all images into series, usually as defined by the imaging source. In some cases, the series is defined as sequential images acquired as a result of a single pass through a scanner. Other times, they may be a collection of seemingly random screenshots. Generally speaking, a series is just a collection of one or more images. Each series in a study appears on the thumbnail panel and in the layout manager.

The sections that follow contain information on how to organize and manage series of images.

#### 5.4.1 Grouping and Ungrouping Series

By default, eRAD PACS uses the series grouping defined when the study was created. Sometimes, studies contain images grouped into series that users general prefer to view individually. eRAD PACS provides tools for automatically separating images based on their orientation, ungroupping series into single-image series, and manually splitting a series into one or more series.

##### 5.4.1.1 Automatic Series Splitting

Imaging modalities group images together in a number of ways. For example, one vendor’s CT may group the localizer image together with the first sequence of axial images, while another vendor’s CT separate the localizer into its own series. eRAD PACS can look at the orientation of each image in a series, and regroup them accordingly. If configured to perform this check, the studies from both CTs in the example appear in the viewer with the localizer image in one series and the axial images in a second series. Another example is when a modality embeds a multi-frame image into a series with single image frames. Enabling Split Series separates the multi-frame image into its own series in the thumbnail panel.

To enable this check, open the Customize Settings window, and select the Layout page. In the Automatic Settings section, check the Split Series box. This setting can be assigned to any modality or to all modalities by selecting the modality label in the Settings For menu.

Another automatic series splitting function addresses the situation when an imaging device puts multiple images into a series and the user prefers they be managed independently. An example of this is when a CR acquisition system puts both the AP and lateral x-ray into a single series. eRAD PACS can be configured to separate all images in a series into individual series. This is most useful when the number of images in the series is fairly small. For this reason, eRAD PACS uses a threshold to define the point at which it will separate the images into separate series, or keep them together.

To force all images in a series into separate series, open the Customize Settings window and go to the Layout page. Insert a non-zero value into the Series Split Length field. The value refers to the point at
which the images remain in a single series in the Layout Manager and Thumbnail Panel. For example, if the value is 4, eRAD PACS separates each series with 1 through 4 images into 1, 2, 3 or 4 series. For series with more than 4 images, eRAD PACS leaves the series intact. A value of 0 means the function is disabled. This setting applies to the selected modality type only. The Default setting does not apply to this function.

5.4.2 Concatenating Series
When loading images into an image frame, eRAD PACS copies each series to a separate grid location. To load two or more series into a single image frame, you must use the drag-and-drop mechanism as described in section 3.4 while holding down the CTRL key. Series concatenation mode is indicated by the cursor. With the CTRL key depressed, the icon includes a ‘+’ marker, indicating you are adding the selected series to the existing image frame, rather replacing it.

To quickly load all the series in a study into a single image frame, press and hold the Ctrl key while double-clicking on the study header in the thumbnail panel.

5.4.3 Manually Splitting and Joining Series
eRAD PACS provides the tools needed to manually split one series into two or more series. Start by scrolling through the thumbnail images, or the images in an image frame, until you arrive at the position where you want to insert the break. Right-click on the thumbnail image to display the popup menu. From the Tools menu, select Series, and then Cut series. A new series appears in the thumbnail panel or in the layout manager. The original series contains the images up to the break point. The new series contains the images from the break point to the end. These modified series remain defined until you close the study. Note that any instance of the series left in the main viewing area contains the original image series.

If you or eRAD PACS has separated a series and you want to join it together again, select the frame. From the Tools menu, click on Series, and then choose Join series forwards or Join series backwards. One of the two series will disappear from the thumbnail panel and layout manager. The resulting series contains the images from both original series.

5.4.4 Sorting Series
By default, eRAD PACS displays images in the order in which the modality acquired them. Unfortunately, scans frequently occur in both directions when the procedure calls for multiple series. In these cases, the first and last images in the series are opposite each other. This makes linking series irrelevant. To address the problem, eRAD PACS can sort the images based on slice position (relative to the patient) so that the order of the images in each series is the same.

To set it, open the Customize Settings window from the Settings menu. Go to the Layout page, and check the Sort Series box in the Automatic Settings section of the panel.

If you want to enable the sort for all modalities, first select Default from the Settings For: list. If you want to override the default setting, choose the modality you want from the list and enable or disable the sort setting in the checkbox. The setting will take effect the next time you launch a study.

5.4.3 Linking Series
eRAD PACS has the ability to link together multiple series into independent groups of linked series. For example, if you have four series rendered in the viewer, you can link two series together into one link group, and link the remaining two together into a second link group, and have the two sets operate independently from each other. Create up to 8 independent linked groups simultaneously.

To link series, do the following:

1. Load two series into different image frames.
2. Select the Link cursor mode by clicking the Link button.
3. Position the cursor over the first series in the image viewing area.
4. Click and hold down the left mouse button, drag it to the second series, and release.

A link icon appears in the top left corner of each frame. To add a third frame to the group, repeat the process, starting on either of the currently linked frames, and ending on the new frame. To create an independent link group, perform the same steps on two frames that do not belong to any other link group.

To remove the link, select the frame you wish to remove from the link group, and then click on the link icon on the image, or click the Link item in the Cine menu.

eRAD PACS only permits a frame to belong to a single link group. If you need to connect a frame to two different groups, you need to remove the original link. If you attempt to attach the frame to another link group, you will be prompted to acknowledge the ungrouping from the first group.

By double-clicking the Link button, the Viewer automatically links together all series from the same study, in the same image plane and tagged as spatially related to each other by the imaging modality. When finished, you can identify which series are linked together by matching up like-colored link icons (in the top left corner of the frame). You can manually add additional series to the automatically defined links, or unlink them.

The auto-link state instructs the viewer to automatically link series together. The default link state is manual. Auto link state persists between viewer sessions. To enable the auto-link state, do one of the following:

- Click and hold down the left mouse button on the Link Cursor button, on the Toolbox toolbar for 2 seconds.
- From the Settings menu, expand the Link Property menu and select Auto Link.
- From the Link Control toolbar, check the Auto box.

When auto link is active, the Link Cursor button in the Toolbar toolbar changes to . To disable the auto-link state, repeat these steps. The button graphic will return to the original image.

Additional link properties are available under Settings/Link Property, or from the Link toolbar. The Mirror setting sets the panning and rotation features to operate in opposite directions across the linked image frames. The Magic Glass setting results in a separate Magic Glass window in each of the linked image frames. The Unhook setting (Link control toolbar, only) temporarily disassociated the link settings so you can apply an image manipulation tool to a single image frame.

5.5 Managing Images

eRAD PACS offers a number of image manipulation tools for enhancing the data. You can change the image’s window width and center, apply a zoom factor, flip, rotate and pan the images, and stack them to emulate a cine playback. Many of these settings can be applied automatically through hanging protocol templates, but they are most flexible when applied manually to individual situations. The sections below provide detailed information on applying image enhancement tools to the images loaded in the eRAD PACS viewer.

5.5.1 Stack Mode Scrolling

eRAD PACS includes a 1-up, stacked frame tile mode. This tile mode can appear in any image frame, as explained in section 5.3.2. A few methods exist for scrolling through the images in the frame:

- Using a three-button mouse with a wheel, left-click on the frame to select it, and then spin the wheel to scroll through the images. Reverse the wheel direction to scroll in the opposite direction.
- When the image is display in Fit-to-window mode (section 0) scrolling is available from the left mouse button. Press and hold down the left mouse button while the cursor is over the image
frame, and drag the mouse back and forth to scroll up and down the stack. Release the mouse to end the scrolling. Note that the left mouse button controls the panning function when the image is not in Fit-to-window mode. When this is the case, hold the CTRL key down while you drag the mouse with the left mouse button pressed to scroll the image.

- The Up and Down arrow keys advance the image stack. Select the image frame using the mouse, and then hit the Up or Down arrow key on the keyboard to move forward or backward through the stack. The Home and End keys jump to the beginning and end of the stack, respectively.

By default, scrolling through a series of images may skip some slices in order to keep up with the drag of the mouse. This enables users to advance through a large series very quickly, but is problematic when you wish to smoothly progress through every image in the series. The Continuous Image Scrolling setting on the Customize Settings' Settings page (section 4.1.1) toggles between skipping quickly through the images and forcing every image slice to appear. When enabled, eRAD PACS displays every slice in the series if you drag the mouse and continue to hold it down until it reaches the desired image frame.

In addition to these manual scrolling tools, eRAD PACS supports a cine mode that automatically cycles through a series of images in an image frame. The cine mode setting is available in any image frame that contains more than one image. You can apply the cine mode setting to one or more of the image frames simultaneously, and to linked image frames.

The cine mode controls are available from the Cine menu (section 0) and the Cine toolbar (section 3.1.9). The cine mode controls include play/stop playback, step one frame forward or back, cycle/reverse mode setting, and a speed adjustment.

To activate cine mode, select the image frame using the left mouse button, and select the Play option from the Cine menu or toolbar. The images display at a rate defined by the speed control. To activate cine mode in another window, repeat the process on the other image frame. If the frame is linked to one or more image frames, all of them play back the images at the same display rate. To stop the cine mode playback, select the image frame, and then the Stop option from the Cine menu or toolbar.

The Next/Previous functions in the Cine menu are equivalent to manually scrolling the image stack, as described earlier in the section.

When the cine playback reaches the end of the image stack, the cycle/reverse mode setting defines how eRAD PACS continues. In Cycle mode, cine playback cycles back to the beginning and repeats the same sequence. In Reverse mode, cine playback reverses the direction and displays the images in the reverse order until it reaches the beginning, at which time it reverses direction again, and continues. By default, cycle mode is selected. Find and change the applied cycle/reverse mode setting from the Cine menu or toolbar.

You can set the relative speed of the playback by adjusting the playback speed gauge in the Cine toolbar, or selecting Faster and Slower from the Cine menu. The playback speed is not synchronized to any clock, so there is no quantitative value to the speed setting. Use this feature simply to increase or decrease the rate at which images in the stack appear in the frame.

### 5.5.2 Windowing and Leveling

eRAD PACS provides multiple tools for adjusting an image’s window width and center values. These include a sliding gauge, mouse control, predefined setting, explicit numeric definition, a region of interest histogram, and greyscale inversion. The customize settings includes some configuration parameters for assigning default values to images without a predefined window width and center, and for overriding those assigned values.

The quickest way to adjust the window width and center values for an image is by applying a preset setting to the image frame. On the Window/Level toolbar, click the pull-down list to display the available
presets. Select one of the entries. The settings are applied to the selected image frame. For instructions on setting a preset window/level setting, refer to section 4.3.1.

The simplest tool for dynamically adjusting the window width and center values is the mouse control. Place the cursor over the image. The image can be a thumbnail or one that is loaded into an image frame in the main viewing workspace. Press and hold down the right mouse button while you drag the mouse. Right and left movements increase and decrease the window width. Backward and forward movements increase and decrease the window center. When you release the mouse, eRAD PACS updates the other images in the series by applying the same offset.

The mouse window/level tool applies the offset resulting from the mouse movement to all the images in the selected series. For example, after releasing the mouse, the new settings may have increased the window width by 10 and the center by –50. eRAD PACS applies +10 and –50 to the current window/level values of each image. If the other images in a series start with a different window/level setting, they will be different after using the mouse tool. To quickly update all the images to the same window and level value, first apply a preset window/level setting to the series, and then adjust it using the mouse.

You can assign an explicit window width and center value to an image from the Window/Level toolbar. Click in the text field next to the appropriate label, delete the present setting, and type a new value into the area. Press the Enter key to apply it. If you enter in a value that is out of the range of pixel values, eRAD PACS will set it to the maximum.

The other controls for setting window and level in the Window/Level toolbar are the sliders. eRAD PACS distributes the possible range of values across the slider. By moving the slider left and right, you can quickly change the respective value. Start by selecting the image. Then click and hold down the window or level slider in the toolbar. Move the mouse left and right to move the slider. When you have come to the desired value, release the mouse.

eRAD PACS provides a window/level tool that uses the pixel distribution within a defined region of interest to calculate a window range with a center value set to the medium value, and then apply those settings to the entire image. This is a quick method for applying a density-specific setting to the entire image. For example, you can apply a bone window to an MRI object by selecting a part of the bone as the region of interest. To define the region of interest, select the ROI with window/level cursor mode, , and position the mouse cursor over the area in the image you want to define. Click and hold down the left mouse button while you drag the mouse to define the region of interest. As you move the mouse, lines outlining the region appear. Release the mouse to create the region. You can resize the region by selecting one of the edges with the mouse and dragging it. Position the mouse cursor over the middle of the defined region, click and hold down the left mouse button, and you can move the region around the image. As you do, the window/level within the region continues to update, using the pixels within the region to create the curve. Each time you release the mouse, eRAD PACS applies the window width and center values from the region to the entire image. To remove the region of interest, click on the image anywhere outside the region of interest area.

eRAD PACS supports an automatic inversion of the slope of the curve used to apply the window width and center. The result is an inverted greyscale image. To apply this setting, select the image in the image frame, and click the Invert image button, , in the Toolbox toolbar, or select Invert from the Tools menu.

To reset the window width and center values of the images in an image frame, click on the reset window/level button, , in the Toolbox toolbar, or select Window/level from the Reset submenu in the Tools menu.

For color images, eRAD PACS can apply a greyscale color map in place of the color palette. The result is a black and white rendering of the color image. To remove all color from a color image, click on the Color/Greyscale button, , in the Toolbox toolbar, or select Greyscale from the Tools menu. Note that of monochrome images, this feature is disabled.
At times, the images eRAD PACS receives have improperly encoded window width and center values, or the technologist may have inserted erroneous values into the image objects. To accommodate these situations, eRAD PACS provides configuration settings it can use to override some default values. On the Image page in the Customize Settings window, three settings exist for working around problems that may exist in images.

- **Use W/L Range** – When the image object contains no preset window and level setting, eRAD PACS can define the default range to use for calculating the values. When this setting is enabled, eRAD PACS uses the actual range of pixels values to define the default window width, and positions the window center in the middle of the pixel range. When disabled, the defined minimum and maximum values are used to set the window width, with the window center set to the middle of the range.

- **Auto W/L Setting** – Some image objects include unused bits in their definition of the pixel value, resulting in a very wide window width, even though the pixel data is confined to a considerably smaller area. When active, this setting overrides the study/series/image with the actual pixel range as calculated by eRAD PACS. Use this setting when a particular modality’s images define a window range that is too large.

- **Auto W/L Range** – Some images have noise at the extreme ends of the pixel distribution curve, which can distort the calculated window width and center values. Use this setting to eliminate the noise by defining how much of the pixel data to image include in the automatic calculation of the pixel distribution.

### 5.5.3 **VOI LUTs**

When a value of interest (VOI) look-up table (LUT) is present in the image object, the eRAD PACS viewer applies it in place of the window and level setting. When present, the VOI LUT is included in the list of available presets, identified by the VOI LUT label preceded by a pound character (#).

When a VOI LUT is applied, the linear window and level toolbar features are disabled. The viewer denotes this by displaying **Using VOI LUT setting** in their place. When you use the mouse to change the setting, eRAD PACS viewer deactivates the LUT, applies the best W/L setting it can, and enables the window and level fields on the W/L toolbar.

To disable the automatic application of a VOI LUT, disable the **Apply VOI LUT** setting for the modality type. Refer to section 0 for details.

### 5.5.4 **Presentation States**

Presentation states represent the state of a modified image, such as window/level setting, magnification and position, and annotation. You can create presentation states during a viewer session, save them so they are available to future viewer sessions, or discard them when finished with the session. Presentation states created by the viewer or third party systems appear in the Presentation State section of the thumbnail panel and can be loaded into the viewer like other series.

#### 5.5.4.1 **Creating Presentation States**

Saved presentation states are the same as key images except they do not appear on the report. To save a presentation state, do the following:

1. Select the frame containing the image.
2. Click the Create Presentation State button, ![Create Presentation State](image) in the Presentation toolbar. A control window pops up.
3. Select the presentation state group label or enter a new label.
4. Choose to save the selected image, all images in the selected frame or all images in all frames.
5. Check the Send presentation states to the server box to upload the presentation state to the server for permanent storage.
6. Click OK. A representation of the presentation states appear in the Presentation Group section of the thumbnail panel.

The settings defined in the control window are saved as the default settings for the next presentation state created.

To apply the default presentation state settings to the selected image(s) without displaying the control window, double-click the Create Presentation State button.

To automatically create a presentation state when annotating an image, set the Generate Presentation State setting on the Auto PS tab in the Customize Settings panel, and select the annotation tools. See section 4.1.15 for details. The presentation state is created automatically when the user adds a selected annotation to an image. By default, this feature is disabled.

5.5.4.2 Applying Presentation States
When presentation states exist for one or more images in a study, they are grouped together in the thumbnail panel under a heading titled Presentation Groups. Each presentation state thumbnail is overlaid with the presentation state indicator, ☑. To display a presentation state image or group, drag the thumbnail into an image frame as you would for any thumbnail series.

When a presentation state object exists for a specific image displayed in the main viewing area, a presentation state indicator, ☑, appears in the top left corner of the image frame. Click this icon to apply the presentation state. If more than one exists, a list of available presentation state descriptions pops up. Select one of the listed descriptions and click Apply. When a presentation state is applied to the image, the presentation state indicator changes, ☑.

The partially applied presentation state icon, ☑, is used when some presentation settings are applied and others settings are not. For example, the presentation state sets the zoom factor, W/L values and a graphic annotation. If you change the W/L setting, the image no longer displays the presentation state’s W/L value, but still displays the annotation.

To remove all presentation state objects from an image, reload the image or series from the thumbnail panel, or click the icon and select the Delete Overlays from the list in the popup window.

5.5.4.3 Saving Presentation States
To save all presentation states to the server after creating it with the automatic upload setting disabled, do the following:

1. From the File menu, select Send presentation states to server.

To save a single presentation state or presentation state group (i.e., a thumbnail series) to the server after creating it with the automatic upload setting disabled, do the following:

1. Right click the presentation state thumbnail to display the popup menu.
2. Select Send presentation state to server.

5.5.4.4 Showing Presentation States in the Thumbnail Panel
To display or hide presentation states in the Presentation Group section of the thumbnail panel, do the following:

1. From the View menu, select Customize Settings
2. Check the box labeled Show Presentation State thumbnails to include presentation states in the thumbnail panel. Clear the box to hide them.
5.5.5 Image Zoom

eRAD PACS offers a variety of tools to magnify images. You can apply a predefined zoom factor to the entire image, define a region of interest and zoom that area to fit the image frame, pop up a magnifying glass window that magnifies the data behind it, dynamically magnify an image, and with some image and monitor calibration tools, display the image in its actual size.

Within an image frame, the image appears with some magnification factor applied, or it is automatically sized to fit inside the frame. When fit to the image frame (fit-to-window mode, section 0), the entire image appears, and the zoom factor is optionally displayed as overlay text (section 6.1.) All other display modes apply a magnification factor. When magnified, some of the image may exist outside the image frame. When in this state, eRAD PACS activates a panning function that allows you to move the image around within the image frame to center a particular section of the image that may otherwise fall outside the display region.

When you apply a magnification factor to an image, the thumbnail images, if displayed, show the viewable region. The coinciding thumbnail image contains a dotted white line indicating the selected area of interest.

To quickly return the image to its starting point, use the reset buttons in the Toolbox toolbar. There are buttons to reset the image size to its original display mode (fit-to-window or original size), reset the image position after panning, plus additional reset functions to return the image orientation and window/level settings.

5.5.5.1 Applying Magnification

eRAD PACS provides two different cursor modes to magnifying an image. Start by loading an image thumbnail to an image frame, and then select the image frame. Activate general magnification mode by clicking on the magnify cursor mode button, 🕵️. The cursor turns into a magnifying glass. When in this cursor mode, there are two ways to zoom into an image. The first is to position the cursor over the center point of the area you wish to magnify, and press and release the left mouse mutton. The behavior differs depending on which buttons you hold down when you click the left mouse button, as follows:

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Magnification Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Shift</td>
<td>Increase magnification factor doubled</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Decrease magnification factor by one half</td>
</tr>
<tr>
<td>Shift+Ctrl</td>
<td>Decrease magnification factor by one quarter</td>
</tr>
</tbody>
</table>

The second way to use the magnification mode is to draw a region defining what portion of the image to display in the image frame. After setting the cursor mode to magnify, position the cursor in the center of the region you want to define, press and hold down the right mouse button, and drag the mouse. Dotted lines appear to define the region of interest. When you release the mouse button, eRAD PACS fits the defined region in the image frame, applying whatever zoom factor is needed. Note that the Center Region Zoom setting on the Customize Settings' Settings page toggles between defining the region from the center out, as described here, or from the top left corner of the area. For details, see section 4.1.1)

After you right or left click the mouse, the cursor mode returns to the Normal cursor mode. If you want to keep the cursor in magnification mode, hold down the ALT key as you click the left mouse button.

A dynamic zoom mode is available from the gauge on the Toolbox toolbar. When the toolbar is available, select the image to magnify, and drag the gauge to increase or decrease the magnification factor.

The interpolation mode on the Customize Settings window’s Image page specifies the interpolation algorithm used when the image is resized. There are various options for determining interpolation. The Nearest Pixel (default) option uses a pixel replication algorithm to create new pixels. The Bilinear option performs a first order interpolation using the bordering pixel values to replicate the missing pixels. While
bilinear interpolation results in a smoother image, there are more derived pixel values than there are when using the nearest pixel algorithm.

To display the selected image frame on the entire monitor, press the F5 key, or click on the Tools menu, select Zoom In/Out, and click on Full Screen. When in full screen mode, all of eRAD PACS's toolbars, menus and other graphics disappear, and the entire monitor is used to display the selected image frame. Many of the same tools that are available in the normal mode are also available in full screen mode, including window/level, scrolling, and panning. To return from full screen mode, press the ESC or F5 key, or click on the close button in the top left corner.

When a frame displays images in tile mode other than 1-up, quickly enlarge one particular image to the frame size by double-clicking on the image. To revert back to the NxM tile layout, double click again. If the current tile mode is 1-up, double-clicking the image changes the grid mode to 1-up. Double-click the image again to restore the original grid layout.

5.5.5.2 Dynamic Zooming
Dynamic zooming is an interactive function for enlarging or shrinking an image some indeterminate amount. Hold down both the left and right mouse button as you drag the mouse forward to zoom in and backward to zoom out. When zooming in, the region is centered at the cursor’s starting position.

5.5.5.3 Magic Glass
A magnifying glass tool exists for zooming in on images. The Magic Glass feature is a floating magnifying glass that magnifies the image behind it. To activate the Magic Glass, select the Magic Glass entry in the View menu, click on the Magic Glass cursor button, , from the toolbar, or type Alt-M on the keyboard. A popup window appears in the main viewing workspace. Move the popup window over the image(s) by dragging it with the mouse. The area under the Magic Glass window is magnified by the zoom factor defined on the Customize Settings' Setting page. Be aware that while the mouse button is pressed, eRAD PACS uses a pixel replication algorithm for magnification. When you release the button, eRAD PACS applies the configured interpolation algorithm. Only image data is magnified. Clear the magnifying glass by left-clicking anywhere outside the zoom area.

An enhanced magic glass allows the floating magnifying glass to be applied to multiple, linked images. To use the enhanced magic glass, link two or more image frames. Check the Magic Glass check box in the link control toolbar or from the Settings/Link Properties menu. When you apply the magic glass tool at this point, a magic glass window appears in each of the linked image frames.

You can resize the Magic Glass window that floats over the images can by dragging the edge of the window. Move the mouse over the edge of the window until it changes to a bi-directional arrow. Click the left mouse button and drag to resize the window. A large Magic Glass window may result in ghosting as you drag it around. If this is not acceptable, reduce the size of the Magic Glass window.

5.5.5.4 Actual Size Mode
The Actual Size Zoom mode is a setting that affects the way an image is rendered when not displayed in fit-to-window mode. The Actual Size Zoom button, , appears in the toolbox toolbar. When depressed, the eRAD PACS renders the images in real-world size. When not depressed, eRAD PACS renders the images in pixel size, matching an image pixel to a monitor pixel. You can toggle the actual size zoom mode by clicking on the button in the toolbar, or selecting it from the Tools menu, under the Zoom submenu.

In order for actual size zoom mode to work, both the monitor and the images in the study need to be calibrated. When you first enable actual size zoom mode, eRAD PACS automatically prompts you to confirm the monitor calibration. If the selected image does not already contain pixel size and spacing information, eRAD PACS automatically prompts you to define it. See sections 5.5.8 and 4.6.1. Note that if you apply the image calibration settings to the entire study, you are not prompted for this information again, at least not until you open another study.
5.5.5 Image Panning
After magnifying an image, the part you are interested in may fall outside the image frame. eRAD PACS provides a panning tool to let you reposition the image within the image frame. To pan a magnified image, position the mouse cursor over the image and press and hold down left mouse button. Then, drag the mouse to move the image to the desired location. When panning an image, the cursor changes to the panning mode. Note that in order to pan images, the images must be displayed in some mode other than fit-to-window.

Use the reset position button, 🌀, in the Toolbox toolbar to reset an image position to the center. Use the reset size button, 🌀, in the same toolbar to reset the magnification mode.

5.5.6 Flip and Rotate
eRAD PACS’s transform functions let you flip an image horizontally or vertically, as well as rotate it to the right or left. This function works on thumbnail images as well as images displayed in an image frame. Click to select the image you want to flip or rotate, and then apply the respective function from the Orientation toolbar, from the Transform item on the Tools menu, or using the shortcuts: Ctrl-H to flip horizontally; Ctrl-U to flip vertically; Ctrl-L to rotate left; and Ctrl-R to rotate right. To reset the image orientation, use the reset button, 🌀, in the Toolbox toolbar.

If the image information displayed on the image obstructs the image, flip the text horizontally in the image frame. Use the Flip Image Information function, ⬤, in the Orientation toolbar or on the Transform submenu of the Tools menu.

5.5.7 Image Cropping
Cropping an image allows the user to mask out unwanted parts of an image. To define a crop area, load the image into an image frame. Select the Crop mode button, 🌀, in the Toolbox toolbar, or select Crop from the Cursor item on the Tools menu at the top of the screen. Position the cursor over the top-left corner or the area you want to keep, press and hold down the left mouse button, and drag the cursor to define the cropped image. When you release the mouse button, eRAD PACS hides everything except what is within the defined area. A dotted-line frame appears around the entire image.

To resize the area, move the cursor over the edge of the dotted-line frame until the cursor changes to a bi-directional arrow. Click and drag the mouse to position the edge of the crop area. To resize the image to fit the frame, click on the Fit to Window button, 🌀, in the Toolbox tool bar.

Remove the crop area by moving a thumbnail into the frame, or double-click on the image.

5.5.8 Image Stitching
Stitching is the process of combining two or more images to make a single image that you can manipulate. This is most commonly applied to spine images or extremities. For example, if you want to take two CR images of the spine, one upper spine and one lower spine, you can stitch them together to make a single image, and then calculate a Cobb angle based on the entire spine.

To stitch two images together, you must download and install the Stitching plug-in module, as defined in Section 3.6.5. Once installed, the stitching control appears in the Post-processing menu. To activate the stitching process, load an image into an available image frame, pull down the Post-processing menu and select Stitch from the Stitching sub-menu. The selected image frame turns into a stitching frame, with the stitching toolbar displayed along the bottom edge of the frame and the image fit into the frame size.

The stitching toolbar consists of tools to pan the images, individually and as a group, tack the image to the workspace, magnify and crop the image, and automatically match the images up.
<table>
<thead>
<tr>
<th>Function</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag mode</td>
<td></td>
<td>Drag the image under the cursor around the image frame. Click on the image with the left mouse button and drag.</td>
</tr>
<tr>
<td>Pan mode</td>
<td></td>
<td>Move all the images in the frame. Click on the image with the left mouse button and drag.</td>
</tr>
<tr>
<td>Pushpin mode</td>
<td></td>
<td>Tack the image to the workspace at a specified location. Left click to apply a pushpin. Multiple pushpins lock an image’s position and angular orientation. To remove a pushpin, left click on the pushpin in the image.</td>
</tr>
<tr>
<td>Magnify mode</td>
<td></td>
<td>Increase or decrease the size of the images in the image frame. Left click zooms in. Hold the ALT key and left click to zoom out. Note that dynamic zooming (left+right button drag) works in any mode.</td>
</tr>
<tr>
<td>Crop mode</td>
<td></td>
<td>Remove extraneous information from the image. Click and drag the mouse to define the crop region. Release the mouse and the area outside the region is eliminated.</td>
</tr>
<tr>
<td>Allow rotation</td>
<td></td>
<td>When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag rotates the image around the pushpin.</td>
</tr>
<tr>
<td>Allow scaling</td>
<td></td>
<td>When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag rescales the image size.</td>
</tr>
<tr>
<td>Auto align</td>
<td></td>
<td>When the two images are roughly lined up, click the auto align button to find the best overlap.</td>
</tr>
<tr>
<td>Stop auto align</td>
<td></td>
<td>When auto-align is active, this button stops the alignment tool.</td>
</tr>
<tr>
<td>Undo auto align</td>
<td></td>
<td>When auto-align is active, this button reverses the alignment results.</td>
</tr>
</tbody>
</table>

Start by loading the images into the stitching frame from the thumbnail panel. Since all the images default to fit-to-window, size the image in the frame so there is enough room to work. Use the zoom mode button on the toolbar, or dynamically alter the image size by holding down both the left and the right mouse button at the same time and dragging the mouse. Click on the Drag mode button, and position the images in their approximate location. Then click on the Auto Align button to have eRAD PACS find the best fit. When finished, double click on the image to export it to an image frame. The stitching frame disappears, leaving a single image in the viewer. The image is added to the thumbnail panel. You can apply any tool to the new image, save it to the eRAD PACS server, and attach it to the report as a key image.

To scale and rotate an image, lock down the image using a single push pin. Enable and disable rotation via the Allow Rotation button. When depressed with one pushpin applied to the image, Drag mode rotates the image around the pushpin. The same applies to the Allow Scaling button. When depressed with one pushpin applied to the image, Drag mode alters the size of the single image as well. If you want to rotate without rescaling the image, apply a single pushpin, press the Allow Rotation button, unselect the Allow Scaling button, and drag the image. Once the orientation is applied, remove the pushpin but clicking on it again.

To remove extraneous information from an image, use the crop tool. Left-click on one of the corners of the image to identify the starting point of the region you want to keep, and drag to the diagonal corner of the region. When you release the mouse, the area outside the region is automatically removed. Cropping applies to only one of the images at a time.

Drag the images to line them up. The signal-to-noise ratio gauge on the left side of the stitching frame indicates the distortion between the two images. The objective is to make this gauge as small as possible. When you get the images close, use the Auto Align function to have eRAD PACS try to improve on the image matching. While there is no guarantee the automatic alignment function will produce a better signal-to-noise ratio than you can accomplish yourself, it can usually improve the result. The automatic alignment tool does not try to resize the image.
5.5.9 MASK SUBTRACTION

Mask subtraction is used to eliminate the commonalities between two images, leaving the differences behind to render on the monitor. This is often useful when tracing some type of bolus or injected dye through various parts of the body. The modality generally provides this information so the workstation can apply it. If eRAD PACS viewer detects mask subtraction information in the image, it can automatically initiate the process to apply the parameters and generate a post-processed series.

To use the mask subtraction feature, you must download and install the Mask Subtraction plug-in module, as defined in Section 3.6.5. Once installed, the mask subtraction control appears in the Post-processing menu. To activate the subtraction process, load a series of images into an available image frame, pull down the Post-processing menu and select Create from the Mask Subtraction sub-menu. The plug-in creates a new series and adds it to the thumbnail panel and layout manager. To display the subtracted image series, drag it to an available image frame.

The mask subtraction tool has configuration settings. From the Postprocessing menu, select the Mask Subtraction submenu and click on Configure. The mask subtraction configuration panel pops up. The Automatic Mode setting is to have the viewer automatically perform the mask subtraction operation on images that contain the required attributes. The Display Notifications setting pops up a notice prior to applying the function to the images. By default, both of these settings are enabled.

If configured to automatically create a subtracted series when the viewer opens the study, and displaying notifications is enabled, you will see a notice pop up when you open a study. If you select to process the images, the subtracted series are automatically created. If you opt to skip this step, you can manually invoke the mask subtraction process at any time by selecting Create from the Mask Subtraction sub-menu in the Post-processing menu at the top of the viewer.

A series of subtracted images has all the properties of a series in the original study. You can window and level them, apply a zoom factor, measure the structures in the image, annotate the image, save the series on the server for others to use, and attach one or more as a key image in a report. Be aware that before you can attach a post-processed image, you must save it to the server first.

5.5.10 CALIBRATION

Some imaging modalities convey enough real-world pixel size and spacing information that eRAD PACS automatically renders images using the correct aspect ratios, calculates distances and area measurements, and displays objects at their actual size. For the imaging modalities that do not provide this information, such as frame grabbed images and scanned film, the user can have eRAD PACS generate the information by calibrating the image that appears on the screen.

When the pixel size and spacing information is available, whether supplied by the modality or entered by the user, eRAD PACS still needs to have information about the monitor in order to render some images properly. For this reason, the user has the ability to calibrate the monitor. While manual calibration for images needs to be performed for each study, monitor calibration is only needed once for each monitor. For safety reasons, the user is prompted to confirm the monitor calibration for each study. Since eRAD PACS records the previous monitor calibration settings, if the monitor or display resolution has not
changed, then the user simply needs to confirm the setting. Section 4.6.1 contains instructions for calibrating the viewer monitors.

To perform image calibration, select the Calibration item on the Settings menu, and select Image. The image calibration wizard window appears showing the current pixel sizing information. If the Use DICOM calibration data setting is selected and contains non-zero values, it means the image object already contains enough information for eRAD PACS to use. The Apply To section of the window allows you to assign the calibration information to an image, a series of images, the entire study, or to all the images loaded into the selected image frame. The default setting is usually the best. If you need to override the default, click the option you want to use for these parameters.

If the image does not contain DICOM calibration data, you need to calibrate the image manually so eRAD PACS can determine the spacing information it needs to assign real-world dimensions to the pixel data. To manually calibrate the image, click on Add or Change Calibration Rulers. The viewer enters image calibration mode, and displays the image and a new set of tools.

The calibration tools lets you draw one or more rulers on the image and then assign a length to each one. Using this information, eRAD PACS calculates the pixel sizes. When you first enter calibration mode, a full-screen window appears with an image display. The cursor is now a ruler cursor, similar to the linear measurement annotation tool. Click, drag and release the mouse to place a ruler over the image. When you release the mouse, you will be prompted to enter in a distance, in millimeters. The objective is for you to draw the ruler over an object in the image for which you know the distance. For example, place the ruler over a measurement graph, or a lead marker, that appears in the image. You can pan and zoom the image to get a more accurate result by clicking on the buttons in the top left corner of the window. The more rulers you define at various angles, the more accurate the size calculations will be. When finished, click Done. When back at the main calibration window, chose to apply this setting to the present image, the series, the frame or the entire study, and then click on Finish.

5.5.11 Magic X Position Locators

When a study contains multiple series in multiple orientations (axial, coronal and sagittal), it is sometimes necessary to display the same point in all three axes simultaneously. You can do this using eRAD PACS’s Magic X function. Set the Magic X cursor mode by selecting the button, from the Toolbox toolbar, or from the Cursor item in the Settings menu. Your cursor will change to a fat X. Place the cursor over the point of interest on one of the images. Left-click and release the mouse and the slices in the other frames that also contain this point are displayed. Left-click and drag the mouse to make the Magic X cursor persist, and as you change the position of the cursor, the other images update to display the intersecting point. If you have localizer lines enabled on these other images, you will see how the entire slice intersects the other images. After clicking on the image, the cursor mode reverts back to the normal mode. If you wish to reposition the images again, you need to reselect the Magic X cursor mode.

The Magic X cursor changes when the icon falls outside a defined distance from the intersecting image. The purpose of this is to provide the user with a clear indication that the referenced image displayed
when using the Magic X tool (i.e., the closest intersecting image to the primary image) is far enough away from the primary image that the intersection is really not relevant.

The user can define the distance from the intersection used as an indication that it is out of range by setting the Magic X Limit values on the Hash Marks page in the Customize Settings window. The first field, Dimmed Magic X after $N$ millimeters, causes eRAD PACS to dim the Magic X icon in the referenced images once the active Magic X icon moves more than $N$ mm away from the closest slice. This happens most often when you reach the end of the series. The second field, Disable Magic X after $M$ millimeters, erases the Magic X icon in the referenced image once the active Magic X icon moves more than $M$ mm away from the closest slice.

### 5.5.12 Post-Processed Images

Post-processing involves creating a new image from existing images. These new images may have the same diagnostic quality as the original, and you can apply all of eRAD PACS’s image manipulation functions to them.

**5.5.12.1 Saving and Deleting Post-Processed Images**

A post-processed image created in the eRAD PACS viewer only exists during the viewer session unless you explicitly elect to save it to the server. Uploading post-processed images to the server requires Edit or Report privileges.

If you want to attach a post-processed image to a key report, you must first register it on the eRAD PACS server.

When you create a new post-processed image or series of images, it appears in the thumbnail panel. To save the image, load it into an image frame, or select the image frame if already displayed in one. Expand the File menu and select *Send image to server* or *Send series to server*. The upload begins immediately. Be aware that image transfers can take some time, especially on slow or congested networks. You will be unable to close the viewer until the transmission completes. The Status toolbar displays the message *Sending Image* while the transmission is in process.

If you close the viewer without saving the post-processed images to the server, they are deleted. To restore them, you will have to process the original images again. If you want to remove a post-processed image yourself, you can do so by loading the image into an image frame, expanding the File menu, and selecting *Delete image/series*.

**5.5.12.2 Multi-planar Reconstruction Images**

eRAD PACS supports multi-planar reconstruction as a plug-in module. Refer to section 7.1 for complete details on the MPR plug-in.

**5.5.12.3 Stitched Images**

Stitched images are two or more independent images that are concatenated to create a single image. In most cases, this is done to two or more CR images or scanned films. eRAD PACS treats the resulting images as a post-processed image. For details on creating a stitched image, refer to section 5.5.8

**5.5.12.4 AVI Images**

eRAD PACS can create an AVI object from any series of images. The AVI object displays the images at a defined frame rate. While an AVI object is a post-processed image, it does not possess many of the same properties. AVI objects cannot be saved as a new series, attached to a report or stored on the eRAD PACS server. For details on creating an AVI object, refer to the AVI plug-in section, 7.4.

**5.5.12.5 Mask Subtracted Images**

eRAD PACS can apply a mask subtraction algorithm to images that include the requisite attributes. These attributes must be defined by the modality. eRAD PACS manages the resulting images as a post-
processed image. For details on applying mask subtraction to a series, refer to the Mask Subtraction section, 5.5.9.

5.6 Warning Indicators

eRAD PACS viewer uses some graphics to inform the user of some condition that may be medically relevant about the image in the image frame.

5.6.1 IMAGE COMPRESSION

When compression is used to download images from the eRAD PACS server to the viewer, the image may contain bit errors that result in modified pixel values. This is common when employing compression ratios that are not bit conserving. To inform the user when an image was downloaded using a lossy compression ratio, a warning icon, ▶️, appears in the upper left corner of the image frame.

To eliminate this warning, select Uncompressed in the image settings page’s Compression section, or select Wavelet and set the Wavelet Quality setting to Lossless. To request the remaining data for a compressed image without changing your settings, double click on the lossy compression warning icon in the image frame. The viewer downloads the rest of the wavelet data from the server, resulting in lossless compressed image.

5.6.2 IMAGE NOT INTENDED FOR DIAGNOSTIC INTERPRETATION

A Not Intended For Diagnostic Interpretation Indicator 📢 displays for any image not intended for diagnostic interpretation. Different DICOM objects are used for conveying unprocessed data and processed data. The warning appears if the image belongs to one of these object classes. For example, this warning can be seen when opening an unprocessed mammography image.

5.7 Closing a Study

eRAD PACS uses the action of closing a study to perform a few maintenance operations. First, it verifies that the user saved their work. A progress bar may appear while the data gets sent to the server. After saving the work, eRAD PACS updates the user profile on the main server. As a final step, eRAD PACS sees if there is a bookmarked study that needs to be reopened.

In the event the user recorded a dictation, created a report, attached key images, or changed the study state, and did not save those changes, eRAD PACS notifies the user. The prompt asks if the user wishes to save his or her work. The user can update some of the information in the notice window. One of the fields to update is the study state. The suggested state comes from the proposed states setting. See section 4.1.1.1 for details. To select a state other than the proposed state, check the Set Status to box, click on the menu, select the state you want, and click OK.
You can close a study from the File menu by selecting Close Study. This leaves eRAD PACS viewer running, even though there is no open study.

Terminate the eRAD PACS viewer session entirely in one of the following ways:

- From the File menu by selecting Quit
- From the Windows application close button, ❌, in the top right corner of the viewer window on the primary monitor
- Opening a new study from the worklist

Note: If you want to add a new study to the studies already loaded, you must return to the worklist or study panel, and add the new study to the group of studies you want to open, and select a batch open.

### 5.7.1 Terminating The Viewer

To terminate eRAD PACS, select Quit from the File menu. The conventional Windows close button in the top right corner of the application performs the same action as the Quit function.
6 Overlays and Annotations

eRAD PACS supports overlays and image annotations. Overlays are lines of text containing details about the patient, the acquisition procedure, the image and other information usually defined by the imaging modality or information system. When displayed, overlays appear in the corners of each image frame.

Annotations are text and graphics that usually reference some detail in the image, such as a linear measurement or an arrow pointing to some anatomical structure. When displayed, annotations appear on top of the image. See the example of text labels and a measurement annotation in the picture below.

The sections that follow give details on creating, displaying, hiding and saving overlays and annotations.

6.1 Overlays

Overlays consist of textual and graphic information identifying the patient, exam type, acquisition data, and image characteristics. Overlays appear on the image in the corners of each image frame, centered along the edge of the image (in the case of orientation markers), and directly over the image (in the case of hash marks). Overlay configurations are specific to each user account, and for each modality type. By default, overlays as displayed in each image frame, but you can hide them at any time using the function keys.

6.1.1 Text Overlays

Text overlays contain information defined by the modality and encoded in the image object along with the pixel data, plus some calculated values. To display the text overlays in the image frame, press the F10 button, or select Show Image Info from the View menu. To hide the text overlays, repeat the action.

The default user profile includes a general overlay configuration that is applied to all image types. Customize these settings to your own preferences from the Customize Settings window.

1. Open the Customize Settings window from the Settings menu
2. Select the DICOM Fields tab
3. Select the modality type whose overlay configuration you want to modify, select the location on the image, and use the Add, Remove and arrow buttons to insert, delete and move the identifiers to the preferred location. See section 4.1.5 for additional details.
4. Save your settings.

By default, private DICOM attributes are unavailable from the viewer. To display private attributes, the server must be configured to process them. This configuration does not have a GUI interface. Contact support with the list of private attributes you wish to make available for overlays in the viewer.

To set the font size for text overlays, return to the DICOM Fields page of the customize settings window. The font size is configurable for each area of the image. Again, select the modality type and the location.
Set the font size in the Character Size field by deleting the current setting and entering in a new value, or use the up/down arrows to the right of the text box to increase/decrease the font size. When you click on OK, the changes will take place immediately.

6.1.2 ORIENTATION MARKERS
Orientation markers indicate the position of the imaged body. There are six orientation labels plus one label to indicate an unknown value:

A Anterior (or front)
F Foot
H Head
L Left side
P Posterior (or back)
R Right side
? Unknown

Orientation markers appear in the center of each side of the image. Generally, one marker appears on each side. If the gantry was tilted during the acquisition, there is a chance the direction increases in multiple directions. When this is the case, the orientation markers are multiple values, and are listed in the dominant order. For example, an orientation marker of LH indicates the primary direction of the vector leading off to that side of the image is toward the patient’s left side, but also progresses toward the patient’s head. Usually, when this appears, the mirror side of the image would contain the opposite orientation markers. In this example, you would likely see RF on the other side of the image.

When the orientation marker contains multiple values, it is often beneficial to have a visual representation of the image to understand the degree of tilt in the image. To assist in this visualization, eRAD PACS provides an overlay that shows how the image slice exists in the 3-dimensional space. It appears as a cube along the lower edge of the image. The Alt-F11 key sequence toggles the display of this orientation overlay. In the cases where the image is square to the patient, the overlay appears as one of the letter labels encased in a square. However, if the image orientation is angled to any degree, the overlay appears as a 3-dimensional box with the letter identifying each respective orientation.

eRAD PACS determines the orientation markers from information encoded in the image object. When the image object does not provide enough information for eRAD PACS to accurately determine this information, no orientation is provided. In this case, eRAD PACS displays question marks (?) in place of the orientation marker.

To display the orientation markers, press the F11 key, or select Show Orientation from the View menu. To hide the orientation markers, repeat the action.

6.1.3 SCALE RULERS
Ruler overlays exist for all calibrated images. Calibrated images are those that contain dimensional information in the DICOM attributes, or have been manually calibrated using the image calibration function. (Refer to section 5.5.9.) They appear on the outside edge of the image frame. You can assign the location of the rulers, and whether they exist for the vertical, horizontal or both planes.

By default, rulers are hidden, but when enabled, appear in successive viewer sessions if left enabled. Change the current setting from the View menu by clicking Show Scale and selecting the location. A hot key, Alt-F10, is also available. Click repeatedly on the hot key to
advance through the locations. Change the color of the scale rulers from the Color tab in the Customize Settings window. From the pull-down list, select Scale Markers, and assign the color. The change takes place after clicking the OK button.

### 6.1.4 Localizers Lines and Hash Marks

Localizers lines and hash marks are overlays the show the intersection of a referenced image on an orthogonal view. When they appear, they reference the image or images in the selected frame. If you select a different image frame, the localizer lines and hash marks on the images change to reflect the intersection of the newly selected image. In most cases, localizer lines and hash marks appear on orthogonal images.

Note that localizer lines and hash marks appear only when the images are defined by the modality to be in the same frame of reference. If the modality does not explicitly define all the image objects this way, eRAD PACS cannot identify the relationship between the images, and therefore it cannot show where one intersects the other. You can verify two images are in the same frame of reference by opening the Information Panel, and comparing the value Frame of Reference UID. If the attribute is missing or the value is different, localizer lines and hash marks are not supported.

While localizer lines and hash marks refer to the same information, eRAD PACS makes a small distinction between the two. In eRAD PACS, localizer lines refer to a single line showing the intersection of the referenced image on the other views. Hash marks are the collection of localizer lines showing the intersection of all the images loaded into the referenced frame on the other views. When displaying a localizer line, a single line appears. When displaying hash marks, multiple lines appear.

If an image is encoded by the modality as a localizer, eRAD PACS automatically displays localizer lines and hash marks on it. For all other image types, you must instruct eRAD PACS to display them. If you want eRAD PACS to attempt to detect which images are localizers, go to the Settings menu and select Localizers. Then click on Auto find localizers to mark it with a check. Repeat the process to remove the check. When enabled (checked), eRAD PACS tries to identify images that are orthogonal to the other images in the series or study, and separates it out as a localizer. When identified as a localizer, eRAD PACS automatically displays the localizers lines on it.

To show localizer lines, press the F12 button, or go to the Settings menu, select Localizers and then click on Show localizer lines on all images. To hide localizer lines, press the F12 button again, or select Hide localizer lines on all images from the same Settings menu. You can make this setting permanent from the Hash Marks page in the Customize Settings window. Select the modality type, and put a check in the box to show or hide the localizer lines.

To display hash marks, press the Alt-F12 key combination, or go to the Settings menu, select Localizers and click on Show hash marks on all images. To hide hash marks, press the Alt-F12 key combination again, or select Hide hash marks on all images from the same Settings menu. When hash marks are displayed, one line is highlighted. This line indicates the intersection of the image currently displayed in the reference frame. You can make this setting permanent from the Hash Marks page in the Customize Settings window. Select the modality type, and put a check in the box to show or hide the hash marks.

Displaying localizer lines in tiles frames takes on some of the properties of displaying hash marks. If two image frames, each with a multiple image series in two different orientations (e.g., axial and coronal) are displayed in stack mode, and you enable each series to show localizer lines and select one of them, the other shows the intersection of the selected one as it intersects it. If you change the tile mode from stack mode to two by three tile mode, you will see six localizer lines displayed on the image still rendered in stack mode. These six lines correspond to all six images displayed in the tile frame. As you scroll through the tile frame, the six localizer lines change to reflect the six displayed images.

In the Customize Settings window, the Hash Marks page contains some configuration parameters that affect localizer lines and hash marks. The hash mark spacing parameter defines the space between hash
marks. If the slice thickness is too small, eRAD PACS’s hash marks may run together, resulting in a solid block of color and completely obstructing the image. To make sure there is enough space between the hash marks so the image underneath can be identified, use the hash mark spacing field to define the minimum distance between hash marks.

The localization criteria parameter in the Hash Marks page defines the angle eRAD PACS uses to determine whether or not two images are in the same plane or not. If the angle between the image planes is greater than the value defined, the two planes are considered orthogonal, and a localizer line appears.

Section 4.1.6 contains details for setting the hash mark spacing and localization criteria parameters.

6.1.5 Embedded Overlays
Embedded overlays are overlays created by third-party devices, such as the imaging modality, and encoded in the image object. When applied to an image, the corresponding image pixel is replaced by an overlay pixel, which when combined with other overlay pixels, result in a graphic displayed on top of the image. Overlays can exist for any object, but are frequently found on summary images or localizer images.

By default, overlays are displayed if they exist for an object. To toggle the embedded overlay setting, use the Ctrl-F9 function key, or select Show Overlays from the View menu.

6.1.6 Orthogonal Image Overlays
Orthogonal image overlay is used to display a localizer image as an overlay on an image, serving as a position reference. The user specifies which overlay image to use. The user can overlay an orthogonal image with hash marks on printed images. Orthogonal image overlays also appear on key images when displayed in the viewer, but not when the key image is rendered as a JPEG image on the report page from the browser.

The orthogonal image overlay setup is controlled under Settings/Customize Settings/View. Under Orthogonal Overlay, set the size and default location of the overlay image.

To apply orthogonal image overlays to an image frame, follow these steps:
1. Select Show Scout Overlay from the View menu.
2. Drag the image you want to display as the orthogonal image into the lower right or left corner of the image frame, and drop it. When positioned over the appropriate area, the image drag cursor changes to an orthogonal image overlay icon.
3. To move or remove the orthogonal image overlay from an image frame, click on it and drag it to the desired location, or back into the thumbnail panel.

6.1.7 Mammography CAD Overlays
A CAD marker provides computer-aided diagnosis to mammography images. eRAD PACS supports the Hologic Image Checker™ (formerly R2) and iCAD Second Look™. Refer to the respective product’s user manual to learn more about them.

If a study includes a CAD marker, the presentation state icon appears in the top left corner of the image when it is displayed in an image frame. To apply a CAD marker, perform the following steps.

1. Click the presentation state icon, in the top left corner of the image.
2. If more than one presentation state option exists, the presentation state selection window appears. Select the CAD marker you want to display, and click on Apply.
3. The presentation state, including annotations and markers appear on the image.
4. The icon changes to a partially applied presentation state icon.
5. Repeat this process for each CAD marker and each image.

The number and type of marker is listed beside the CAD product’s logo at the top of the image. CAD markers are displayed as defined by the CAD object and cannot be modified by the Viewer in any way. Refer to the CAD product’s user manual for more information if necessary.

6.2 Annotations

Annotations provide you with the ability to attach text and graphics to an image. The Annotation Toolbar contains a series of eight buttons for working with annotations. The Annotation button, ![Annotation button](Image), puts you in the annotation mode, providing you with the ability to create, move, modify and delete an annotation. The available annotations are adding text strings, linear and angular measurements, area measurements using circular and free-form regions of interest, Hounsfield units, a pointer graphic, key image numbering and spine labels. When a specific annotation tool is selected, the cursor changes to identify it. Set the specific annotation tool by selecting it from the annotation toolbar, or if already in annotation cursor mode, spin the middle mouse button to advance through the available tools.

Most annotations consist of a graphic such as a line representing a rule for linear measurement, or a ring representing the area defining a region of interest, a value such as the measured length, or a text string, and an annotation index number. The index number starts at one (‘1’) for each image, and increments by one for each annotation you add to an image. When displayed, these indices can be used as references to the annotations in the report, or when discussing the data during a collaboration session. The value and index components float independently from the graphic. If one is obstructing part of the image, click on the component with the left mouse button, and while holding the button down, drag it to another location. To move all three at the same time, move the graphic component.

You can hide all the annotations using the F9 function key, or by selecting Show annotations from the View menu. When hidden, the annotations still exist, but do not appear on top of the image. To display the annotations again, repeat the sequence.

To set the font size of annotations, open the Customize Settings window from the Settings menu and go to the Advanced page. The font size is specified in the field labeled Annotation font size. To change the setting, delete the value and type in a new size, or use the up/down arrows to the right of the edit box to increase/decrease the font size. When you click on OK, the changes get applied to all existing and future annotations.

To modify or remove an existing annotation, click on the Annotation button to enter annotation mode, and then click to select the annotation you want to change. When selected, you can drag the annotation around, or adjust its settings. Right click on the annotation to pop up a menu (shown here) containing annotation commands. From this menu, you can remove the selected or all annotations, show or hide the annotation index number, numerical value such as the length or area or the tick marks in a linear ruler, or change the font size or color.

6.2.1 Text Annotations

Use the Add Text button, ![Add Text button](Image), to create or add text to an annotation that you want subsequent viewers to see. Click on the image where you want to insert the text string. A window appears with a field for entering the text string. This field is also pull-down list containing the previously entered annotation strings. If you have entered the text string before, you can select it from this list. The feature supports an auto-completion capability such that eRAD PACS automatically fills in the value once you have entered enough for it to find a match. By default, the history file retains the last 20 values. Enter the text and click on OK. To remove unwanted values from the history list, select the value from the text annotation window and click on the Delete button.
6.2.2 MEASUREMENT ANNOTATIONS

eRAD PACS supports linear measurements, \( \text{\texttt{\textregistered}} \), angular measurements, \( \theta \), Cobb angle measurements, \( \gamma \), and area calculations on oval, \( \epsilon \), and free-form, \( \square \), regions. Linear measurement values are displayed in millimeters. Angles are displayed in degrees. Area values are in square millimeters. If the image object does not contain pixel size and spacing information, eRAD PACS displays measurements in pixels. To convert pixels to real-world dimensions, you must calibrate the image. (See section 5.5.8.)

To use the linear and ROI measurement tools,
1. Select the respective annotation button
2. Left-click with the mouse on the image.
3. While holding down the left mouse button, drag the cursor to expand the measurement ruler or region.
4. Release the mouse button to get the measurement value.

For the angle measurement,
1. Select the angle tool
2. Left-click with the mouse on the image and drag.
3. The initial application of the graphic defines only one leg of the angle graphic. Click and drag the second leg of the graphic to set the angle properly.

The Cobb angle tool measures angles whose vertex exists outside the image. This is useful in measuring very small angles, such as spine curvature. The angle created when the two lines intersect is displayed.
1. Select the Cobb angle tool
2. Click on the image and drag the mouse. The line connecting the two vectors of the angle appears.
3. To cast each vector, click on the end point of the line perpendicular to the connector and drag. Position along the axis you need to measure.
4. Repeat with the perpendicular line at the other end of the connector.

The free-form region of interest tool defines a geometric area that cannot be enclosed using the other ROI tools.
1. Click on the free-form ROI button.
2. Move the cursor to a starting point on the image and click the left mouse button.
3. While holding down the left mouse button, drag the mouse to define the region. When you release the mouse button, the viewer automatically closes the region by connecting the end point with the start point. The viewer calculates the area within the defined space and displays it on the image.
4. To correct the region outline, move the mouse until it crosses over the point to want to move. The cursor changes to either a two-directional or four-directional arrow.
5. Click the left mouse button and drag the mouse to move the line. If you hold the Shift key while dragging, the line will move in an arc. Without the Shift key, you will just move the point under the cursor.
6. Release the mouse button. The viewer recalculates the area inside the region.

To adjust the annotation graphic using the mouse,
1. Click on the Annotation button to enter annotation mode
2. Select the annotation you want to change.
3. To resize the graphic, left-click on one of the grab points along the edge or ends of the graphic and drag the mouse.
4. To move the graphic, left-click the edge of the graphic that is not a grab point and drag the mouse.

To adjust the annotation graphic by small amounts using the keyboard,
1. Click on the Annotation button to enter annotation mode
2. Select the annotation you want to change
3. Press the Tab or Shift+Tab key to select the side, edge or other object you want to adjust. When you press the Ctrl key (see next step), the selected side, edge or other object is highlighted.
4. Press the Ctrl+<direction> key to move the selected side, edge or other object. The <direction> key can be ↑ to move up, ↓ to move down, ← to move left, → to move right, Home to move up and to the left, End to move down and to the left, Page Up to move up and to the right, and Page Down to move down and to the right.

6.2.3 HOUNSFIELD UNIT ANNOTATIONS
The Hounsfield notation tool creates a region of interest and calculates its average pixel value and the standard deviation on the distribution. To perform this calculation, select the Hounsfield ROI button, ✂, click on the image, and drag the mouse to define the region of interest. When you release the mouse, eRAD PACS calculates the values and displays them. Resize the region by clicking on one of the edges of the graphic, and drag it.

To get the value of a particular pixel anywhere in the image, select the Hounsfield annotation tool and position the cursor over the pixel of interest. The pixel value is displayed in the lower right corner of the Status bar, along the bottom of the screen. If the Status bar is hidden, display it by going to the View menu at the top of the screen, select Toolbars, and click on Status Bar.

6.2.4 REPORT IMAGE NUMBERING
When attaching key images to a report, it is useful to label each image so you can reference them in the report. With the text annotation tool, you can manually add a textual identifier to each key image before attaching it to the report. With the Report Image Numbering annotation tool, eRAD PACS can drop a sequential numeric label onto each image in the report, eliminating the need to explicitly type in a text annotation. To use the report figure numbering tool, click the button, ✂, open the full-size report panel, and click on a key image. The next number in the sequence appears where you clicked. To move the numeric label, select the annotation and drag it to another location on the same key image. To delete the annotation, right-click on the selected annotation and select Delete.

6.2.5 POINTER GRAPHIC ANNOTATION
The pointer graphic tool draws an arrow on the image. Select the pointer annotation button, ✂, and click on the image. Drag the mouse to adjust the size of the pointer. You can rotate the graphic around its head by clicking on the end of it and dragging it around.

The pointer graphic tool can contain a text string. The advantage of adding text to the pointer graphic over using the text annotation tool is that eRAD PACS manages the two annotations as one. Therefore, if you move or adjust the pointer graphic, the text automatically follows. To assign a text string to a specific pointer annotation, first drop the pointer annotation onto an image. Hold the Ctrl key when you click to place the pointer annotation on the image, and the text box automatically appears. Alternatively, right-click on the pointer to display the popup menu and select Edit text. The text list appears. Select a text string from the pull-down list, or type a new string into the text window. Click OK.

6.2.6 SPINE LABELING ANNOTATION
The spine-labeling tool is for labeling vertebrae and disk interspaces. The result is similar to adding text annotations to an image of a spine, except the spine-labeling tool uses predefined labels, and displays them in their corresponding location on images in all orthogonal planes.

Select the spine-labeling tool by clicking on the spine label annotation button, ✂. When active, a spine labeling control panel appears, listing the predefined vertebral and disk interspaces. To apply a label, select the starting point from the control panel, and then click on the image to place the label. The label automatically advances to the next label after you place each one, so left-click again to drop the next label. To automatically advance in the opposite direction, check the box labeled Reverse Direction in the
spine labeling tool window. Continue until you are done. To skip a label, change the next label in the pull-down list in the popup window. To toggle between vertebral labels and disk interspace labels, press and hold the Alt key while clicking on the mouse. For disk interspaces, and when you drag vertebrae labels away from their default location, a line appears. To display the line after you are done labeling the image, check the box labeled Show Lines in the spine labeling tool window.

To customize the spine-labeling tool, use the Spine page in the Customize Settings window. You can set the default starting point for both disks and interspaces, and select which one is enabled initially. You can include or exclude L6, and define the default labeling direction. You can also modify a default label used, and the spacing between vertebral bodies when placing the spine labels on orthogonal views. See section 4.1.11.2 for details.

When placing the specified labels in the orthogonal images, eRAD PACS uses the label's focus point. If the graphic intersects the image within the defined distance from the focus point, it appears in intersecting plane. The spine labels appear in all orthogonal images automatically, as long as the images belong to the same Frame of Reference, as defined by the original images modality. If the Frame of Reference is not predefined, you will have to label each of the images individually. If the focus point falls outside the distance specified, no label appears.

The center point of the annotation is identified by the little dot next to the label. This is the focus point, referenced when identifying the point on other images. You can add or remove a line connecting the dot to the label by dragging the text away from its default location. To make the lines persist after exiting the annotation mode, select Show Line in the control panel. Move the label by selecting annotation cursor mode, and dragging the label where it needs to go. To remove a single label, select annotation cursor mode, right-click on the label to pop up the annotation menu, and select Delete Selected. Select Delete All from the same menu to remove the spine labels and all other annotations. To remove all spine labels, including all the labels in intersecting planes, and leave other annotations, click Reset on the spine label popup window.
7 Plug-in Modules

eRAD PACS uses plug-in modules to add packages that perform specific functions. Plug-in modules are individually licensed. When you log in and open the eRAD PACS viewer, it checks the server to see which plug-ins are licensed. The viewer then loads the licensed modules, which may result in the addition or modification of menus, popup windows, and toolbars. The sections below provide instructions on using a particular plug-in module.

7.1 Multi-planar Reconstruction Plug-in

eRAD PACS supports multi-planar reconstruction (MPR) as a plug-in module. The MPR plug-in is available for the active-X and standalone versions of the viewer. When the viewer starts, it obtains the plug-in licenses from the server. If the viewer finds a valid license for the MPR plug-in module, it automatically downloads and installs the plug-in on the workstation. If the MPR plug-in was installed using one server and the user switches to an eRAD PACS server that does not contain a valid MPR plug-in license, the viewer does not initiate the plug-in and MPR is unavailable.

Like the general eRAD PACS viewer, if a newer version of the plug-in is available, the viewer downloads and installs the update automatically. Since a plug-in does not require a formal installation process, Windows administrator privileges are not necessary to install or upgrade a plug-in.

MPR allows a user to create a completely artificial view of the available image data. For example, if an axial series exists, and you wish to view the images in a coronal orientation, MPR can create the coronal view. Additionally, you can use MPR to create a view at an oblique angle. The MPR module creates a volume using the available data, and allows the user to select the plane that cuts through the volume. The result is a series of images that the user can view, save to the server, archive, and attach as a key image.

To create the MPR volume, load a series into the main viewer and select Create from the Reconstruction submenu of the Post-processing menu at on the top of the eRAD PACS GUI. Use the series with the most slices to obtain the best results.

When you create an MPR frame, the volume is created and the image frame separates into four smaller frames. Each frame contains a single orthogonal view (sagittal, coronal, and axial) plus an oblique angle view. The oblique image frame is the results window, and is represented by the purple localizer in the coronal view. The other three frames are control windows.

If the series is particularly large, creating the volume may take a little time. A progress bar appears to show you how much additional time is needed to create the data volume.

Using the color-coordinated localizers (i.e., the color of the line matches the color of the frame containing the image in that plane), move and rotate the oblique image. You can window and level the image using the regular window/level tools. The other tools are unavailable in an MPR image frame.

When you have the results you want, export the series to EP by double-clicking
on the oblique image, or selecting Export from the Reconstruction menu. Once the series is exported back to the viewer, it is available from the thumbnail panel and you can perform any available function on the image. From the Reconstruction menu, the Export Setup item opens the exporting control panel. From this control panel, you can define the number of slices to include when you export the regenerated series (default is 9 slices) and define the spacing you want to use between the slices (default is the same as the original series). To change the default, uncheck the box, and enter the number in the respective field.

Users with Edit or Report permissions can upload exported MPR images and series to the server so other users can use them. From the File menu, select Send Image to Server or Send Series to Server. Once an exported image is saved to the server, you can attach it to a report as a key image.

7.2 AVI Plug-in

eRAD PACS creates audio video interleaved (AVI) images via a plug-in module. The AVI plug-in is available for the active-X version of the viewer. When the viewer starts, it automatically downloads and installs the plug-in on the workstation. If the AVI plug-in was installed using one server and the user switches to an eRAD PACS server that does not contain a valid AVI plug-in license, the viewer does not initiate the plug-in and AVI creation is unavailable.

Like the general eRAD PACS viewer, if a newer version of the plug-in is available, the viewer downloads and installs the update automatically. Since eRAD PACS plug-in modules do not require a formal installation process, Windows administrator privileges are not necessary to install or upgrade it.

AVI allows a user to create a movie from the available image data. If the series does not contain a recommended frame rate, the plug-in module prompts the user to enter one. The images are then converted into an AVI file that the viewer can play back at the specified frame rate. Unlike the results of other post-processing plug-in modules, AVI objects cannot be annotated, saved to the server, or attached as a key image.

To create an AVI object, load the selected series into an available image frame. To combine multiple series into a single AVI object, concatenate (Ctrl-drag) the additional thumbnail series into the image frame. From the Post-processing menu, select AVI Player, and then Create. The plug-in prompts you to confirm the applied frame rate. Enter the value in the popup window and click on Continue. A progress bar appears indicating when the process will complete. On large data sets, it could take a couple of minutes to create an AVI object. When
the process is complete, the AVI object appears in the frame.

The AVI plug-in plays the image back at the defined frame rate. Frequently used tools are displayed in a toolbar at the bottom of the AVI frame. These and other tools are also available in the AVI Player submenu from the Post-processing menu. Tools include buttons to start, pause and stop the playback. When the playback is paused or stopped, you can manually advance the AVI image by dragging the progression bar or by clicking on the next and previous frame buttons on either end of the progression bar. The applied frame rate is displayed on the toolbar as well. From the AVI Player submenu, you can apply a zoom factor to the AVI images.

AVI images cannot be exported to the viewer, meaning they cannot be stored on the eRAD PACS server. You will have to recreate the AVI object each time you want to display it. You can save the AVI file to the local workstation as an AVI file. Use the Save As item on the AVI Player submenu to bring up a Windows panel to select a folder in which to save the data.

The AVI plug-in configuration panel is available from the AVI Player menu in the Postprocessing pull-down menu at the top of the viewer. Click on Configure to pop up the configuration window. The AVI configuration allows you to define a default frame rate to use when the series does not contain a recommended value and to override the recommended frame rate when one is defined.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use DICOM frame rate</td>
<td>When checked, the value in the image object is used automatically. Enabled</td>
</tr>
<tr>
<td>without prompting</td>
<td>by default.</td>
</tr>
<tr>
<td>Override recommended display</td>
<td>When checked, the defined default will be proposed for all series. Disabled by</td>
</tr>
<tr>
<td>rate</td>
<td>default.</td>
</tr>
<tr>
<td>Default frame rate</td>
<td>The default frame rate (frames/sec) to propose when no recommended frame rate</td>
</tr>
<tr>
<td></td>
<td>exists, or Override Recommended Display Rate is enabled.</td>
</tr>
<tr>
<td>Select codec</td>
<td>Select the preferred codec to use for creating the AVI images. The list comes</td>
</tr>
<tr>
<td></td>
<td>from the codecs available to Windows on the workstation.</td>
</tr>
</tbody>
</table>

7.3 Image Fusion Plug-in

The eRAD PACS image fusion tool is a plug-in module for superimposing PET/CT and SPECT/CT structural and functional images into a single volume. Tools include orthogonal and volume oriented view controls, alpha blending, color spectrum application, and MIP view. The plug-in applies to studies whose largest, contiguous segment of images share complementary spatial resolution characteristics, meaning they were acquired on a single machine as part of a single procedure.

The image fusion plug-in module has the following workstation requirements.

- Processor speed: greater than 2GHz
- RAM: minimum is twice the size of the series loaded into the fusion frame
- Display controller:
  - Video RAM: minimum of 256MBs
  - Support for Direct X v9.0 drivers dated August, 2008 or more recently
  - Support for PixelShader 2.0 or later

Attempts to invoke the fusion plug-in module on a machine with insufficient resources may display one or more warnings or error messages. If so, the plug-in may appear to process the data correctly but performance may be poor and results cannot be guaranteed. Do not use the fusion plug-in until you are able to load the plug-in without receiving any popup notices.

When the EP viewer starts, it searches the server for the fusion plug-in license. If a valid license exists and the user account is configured to use the plug-in module, the viewer prompts the user to download and install it on the workstation. Once downloaded the plug-in installs automatically and is ready to use.
To invoke the fusion plug-in module, drop a series from the thumbnail panel into an image frame. From the Post-Processing menu, expand the Image Fusion submenu and chose Create. The plug-in is ready to use when the progress bar disappears, the data is 100% downloaded, the image frame becomes a plug-in frame with toolbar displayed on the border, and the default layout appears.

To fuse the loaded series with another, drag and drop another series into the image frame running the plug-in module. A progress bar pops up while the plug-in module processes the data. When finished, the progress bar disappears and all series loaded into the plug-in frame appear fused together on the screen.

### 7.3.1 Fusion Frame Layout

The fusion plug-in consists of a viewing area and a toolbar.

![Image Fusion Toolbar](image)

#### 7.3.1.1 Image fusion toolbar

The toolbar defaults to the right side of the image frame. It can be detached and floated anywhere in the image frame.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-up</td>
<td><img src="image" alt="4-up Button" /></td>
<td>Four image cells containing orthogonal and MIP views</td>
</tr>
<tr>
<td>9-up</td>
<td><img src="image" alt="9-up Button" /></td>
<td>Nine image cells containing each series in orthogonal views</td>
</tr>
<tr>
<td>Show/hide structural</td>
<td><img src="image" alt="Show/hide Button" /></td>
<td>Show/hide the structural image in individual cells</td>
</tr>
<tr>
<td>Show/hide functional</td>
<td><img src="image" alt="Show/hide Button" /></td>
<td>Show/hide the functional image in individual cells</td>
</tr>
<tr>
<td>Move structural</td>
<td><img src="image" alt="Move Button" /></td>
<td>Manually line up the images by manipulating the structural image</td>
</tr>
<tr>
<td>Move functional</td>
<td><img src="image" alt="Move Button" /></td>
<td>Manually line up the images by manipulating the functional image</td>
</tr>
<tr>
<td>Save image</td>
<td><img src="image" alt="Save Button" /></td>
<td>Export the highlighted image</td>
</tr>
<tr>
<td>Save series</td>
<td><img src="image" alt="Save Button" /></td>
<td>Export a series of images from the highlighted cell</td>
</tr>
<tr>
<td>Show/Hide hash marks</td>
<td><img src="image" alt="Hide Button" /></td>
<td>Toggle to show and hide the hash marks</td>
</tr>
<tr>
<td>Show/hide SUV values</td>
<td><img src="image" alt="Show/hide Button" /></td>
<td>Toggle to show and hide the SUV overlay and SUV ROI annotation</td>
</tr>
</tbody>
</table>

#### 7.3.1.2 Display layouts

The two primary layouts display the images in different views.
<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-up</td>
<td>Displays the individual or fused series in all three orthogonal views, plus one MIP view.</td>
</tr>
<tr>
<td>9-up</td>
<td>Consists of three rows showing the series in all three orthogonal views. The first row shows the structural image. The second row shows the functional image. The final row displays the fused images.</td>
</tr>
</tbody>
</table>

### 7.3.1.3 MIP Image View
A MIP view of an individual or the fused image is available in 4-up display mode.

### 7.3.2 IMAGE MANIPULATION
Image manipulation tools include scrolling, zooming, windowing/leveling, color palette adjustments, alpha blending, rotating, and panning.

By default, the fusion plug-in renders all loaded series. To display the image in a single series, load only one series into the plug-in frame, or deselect the Show Structural or Show Functional button from the toolbar.

#### 7.3.2.1 Window/level
To adjust the window and level settings for the displayed image, apply the following sequence:
1. Position the mouse cursor over any image in the fusion plug-in frame.
2. To adjust the window width and level of the primary/structural image, press and hold down the right mouse button. To adjust the width and level of the secondary/functional image’s palette range, press and hold the Shift button and the right mouse button.
3. Drag the mouse to the left to decrease the window width, right to increase the window width, forward to decrease the window center and backward to increase the window center.

#### 7.3.2.2 Scrolling
To scroll through the image stack, position the mouse cursor over any image in the fusion plug-in frame and press the left mouse button to select it. Then apply one of the following sequences:
1. Scroll the mouse wheel backward to advance and forward to return one frame at a time
2. Press and hold the wheel button, and move the mouse backward to advance and forward to return one frame at a time.

#### 7.3.2.3 Zooming
To magnify the images, apply the following sequence:
1. Position the mouse cursor over any image in the fusion plug-in frame.
2. Press and hold down both the left and right mouse button, and drag the mouse forward to increase the image size and backward to decrease it.

#### 7.3.2.4 Orbiting MIP view
You can rotate the default MIP volume around a center point by applying the following sequence:
1. Position the mouse cursor over the MIP image.
2. Press and hold down the left mouse button, and drag it to orbit the image.

#### 7.3.2.5 Cross correlation
Cross correlation is the ability to identify the same point in all orthogonal images. There are two modes. The cross correlation tool finds the intersecting point on all images and displays it in each cell. The Magic X version is the same function and includes the images displayed in the main viewer frames as well.

The tool applied to the image depends on the selected cursor mode. If the cursor mode is the normal mode, [cursor], the cross correlation tool is applied. If the cursor mode is Magic X, [cursor], the Magic X tool is applied.

After selecting the cursor mode, apply the following sequence:
1. Position the cursor over the point in an image.
2. Press and hold down the CTRL button, and click the left mouse button to display the intersecting point in all image cells, or hold down the left mouse button and drag the mouse to dynamically refresh the point under the cursor in each of the other cells.

7.3.2.6 Color schemes
A number of predefined color schemes are available. The default scheme is red, and can be changed by the user. The other options include blue, red glow, blue glow, hot metal, ice water, rainbow, and none (grayscale). To apply a selected color scheme to a functional or fused image, apply the following sequence:
1. Position the mouse over the fusion plug-in frame and click the right mouse button.
2. Click Color Scheme to display the submenu.
3. Select the color scheme from the submenu.

When a color scheme is applied to the functional or fused image, adjust the palette range as follows:
1. Position the mouse cursor over any functional or fused image in the fusion plug-in frame.
2. Press and hold the Shift button and the right mouse button.
3. Drag the mouse to the left to decrease the window width, right to increase the window width, forward to decrease the window center and backward to increase the window center.

To change the default color scheme,
1. Drop a function (PET) image in the fusion plug-in frame.
2. Select the color scheme you want as the default, as instructed above.
3. Position the mouse over the fusion plug-in frame and click the right mouse button.
4. Select Color Scheme to display the submenu.
5. Click Save Current as Default.

7.3.2.7 Alpha blending
Alpha blending is combining the alpha layer with other layers in an image in order to show translucency. Alpha blending modes include Constant and Linear. Select the alpha blending mode as follows:
1. Position the cursor over the fusion plug-in frame and click the right mouse button.
2. Click Alpha to display the submenu.
3. Select the alpha blending mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Alpha blending adjustments alter the alpha constant. The initial alpha constant is 0.5.</td>
</tr>
<tr>
<td>Linear</td>
<td>(Default) Alpha blending adjustments alter the alpha scaling factor. The initial alpha scaling factory is 2.0.</td>
</tr>
<tr>
<td>Reset</td>
<td>Reset the alpha constant and scaling factor to system defaults</td>
</tr>
</tbody>
</table>

When the alpha blending mode is Constant, the transparency is independent of the image's color/intensity value. When the alpha blending mode is Linear, the transparency is a linear function of the image's windowed intensity.

Alter the alpha constant or scaling factor as follows:
1. Select the alpha blending mode as described above.
2. Press and hold down the CTRL key and the right mouse button
3. Drag the mouse forward to decrease the value and backward to increase the value.

7.3.2.8 Manual registration
The image series are automatically registered if they were acquired on the same device and are encoded with a shared frame of reference identifier. Other series can be manually registered. To do this, load both series into the fusion plug-in frame and follow the steps below.

1. To keep the structural image fixed and adjust the functional image, select the Move Functional button, [ ], in the fusion toolbar. To keep the functional image fixed and adjust the structural image, select the Move Structural button, [ ], in the fusion toolbar.
2. Position the cursor over the fusion cell containing the image you want to adjust.

To move the affected image:
- Press and hold down the left mouse button, and drag the mouse.

To rotate the affected image around the starting point:
- Press and hold down the right mouse button, and drag the mouse.

To resize the affected image centered around the starting cursor position:
- Press and hold down the left and right mouse buttons, and move the mouse forward and backward.

7.3.3 Annotations
The fusion plug-in module supports a number of annotations and overlays, including hash marks and SUV values.

7.3.3.1 Hash marks
Orthogonal images in the fusion frame include hash lines of the interesting image planes. They appear as cross hairs on the images. To show and hide the hash marks, apply the following sequence.
- Press the Show/Hide Hash Marks button, in the fusion toolbar.

7.3.3.2 SUV values
When the functional image contains the standard uptake value (SUV) data, the information is displayed in the image cell by default. The uptake value for the point under the cursor is displayed.

If SUV information is available, SUV values are displayed by default. To hide the SUV data overlay, apply the following sequence.
- Press the Show/Hide SUV Values button, in the fusion toolbar.

SUV values are only displayed when specific values are present in the PET or SPECT series. Some values depend on the modality vendor. In general, the following attributes are required. The value in parentheses is the DICOM tag value.

- Injection Dose (0018,1074)
- Injection date (0018,1078) and time (0018,1072)
- Acquisition date (0008,0022) and time (0008,0032)
- Half life (0018,1075)
- Patient weight (0010,1030)

SUV values are normalized for body weight (SUV<sub>bw</sub>), and displayed in g/ml. Some modalities produce data using other scales. To convert to other units, the conversion information is required. For these modalities, vendor-specific attributes are needed, which may or may not be present in the data.

7.3.3.3 SUV regions of interest
To display the maximum SUV value in a region of interest, apply the following sequence.
1. Position the cursor over the center of the SUV ROI sphere you want to draw.
2. Press and hold down the Shift key and the left mouse button, and drag the mouse away from the center point. A circle appears on the image.
3. Release the mouse and keyboard once the circle defines the region. The maximum SUV value in the sphere appears on the image.

To remove or redefine an SUV ROI
1. Position the cursor within the boundaries of the SUV ROI. The annotation is highlighted.
2. Press the Delete key.
7.3.4 **SAVING IMAGES**

Images created by the fusion module can be exported to the main viewer and sent to the archive for storage. Exported images can be attached to reports as key images on they are uploaded to the server. Uploading exported images requires Edit or Report permissions. See section 5.5.12.1 for details on uploading post-processes images.

Annotations applied to a fused image when it is exported remain on the image after exporting, but they cannot be modified outside the plug-in frame. To make adjustments to an annotation, reload the exported image into a fusion plug-in frame and edit it.

### 7.3.4.1 Exporting fused images

To export a single fused image, apply one of the following sequences.
- Double click the fusion cell containing the image, or
- Select the fusion cell containing the image to export and click the Export Image button, on the fusion toolbar.

### 7.3.4.2 Exporting fused series

To export a series of fused images, apply the following sequence.
1. Select the fusion cell containing the images to export.
2. Click the Export Series button, .
3. In the Export Options window, select the number of slices to include in the series plus the slice spacing (fused images) or incremental rotational angle (MIP).
4. Click OK.

### 7.3.5 CONFIGURATION

The fusion module configuration panel is available from the Image Fusion item under the Postprocessing menu at the top of the viewer. Click on Configure to pop up the configuration window.

Fusion configuration allows you to define default color schemes, alpha blending mode and associated parameters, a slice space limit and some D3D compatibility parameters. Default color schemes can be different when applied to the fused image, the PET-only image and the MIP image.

<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td><strong>Maximum slice spacing error</strong></td>
<td>5%</td>
<td>Defines the maximum spacing between slices accepted as belonging to the data volume.</td>
</tr>
<tr>
<td></td>
<td><strong>Don’t use 32-bit textures</strong></td>
<td>Disabled</td>
<td>If the data cannot be rendered in 16 bits, the data is expanded to 32 bits to preserve precision. Some D3D drivers and devices do not support this. Checking this box avoids this issue, but may result in rounding errors in the data.</td>
</tr>
<tr>
<td><strong>Coloring</strong></td>
<td><strong>Fused coloring</strong></td>
<td>Red</td>
<td>Default color scheme applied to fused images.</td>
</tr>
<tr>
<td></td>
<td><strong>Functional only coloring</strong></td>
<td>Same as Fused Coloring</td>
<td>Default color scheme applied to functional (PET) images when rendered non-fused.</td>
</tr>
<tr>
<td></td>
<td><strong>MIP coloring</strong></td>
<td>Same as Fused Coloring</td>
<td>Default color scheme applied to MIP image.</td>
</tr>
<tr>
<td><strong>Blending</strong></td>
<td><strong>Blending mode</strong></td>
<td>Linear</td>
<td>Alpha blending mode. Can be Linear or Constant.</td>
</tr>
<tr>
<td></td>
<td><strong>Blending parameter</strong></td>
<td>Scaling factor: 2.0 Scaling constant: 0.5</td>
<td>When mode is linear, this parameter is the alpha scaling factor. When mode is constant, this parameter is the alpha constant.</td>
</tr>
<tr>
<td><strong>Auto Palette Range</strong></td>
<td><strong>Fused image</strong></td>
<td>100%</td>
<td>Color saturation intensity applied to fused images. The default is full intensity, 100%.</td>
</tr>
</tbody>
</table>
### 7.3.6 Keyboard Control Summary

The following tables summarize the keyboard and mouse commands.

#### 7.3.6.1 Normal mode

<table>
<thead>
<tr>
<th>Key</th>
<th>Mouse</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right</td>
<td></td>
<td>Drag left/right</td>
<td>Window structural/primary image</td>
</tr>
<tr>
<td>Right</td>
<td></td>
<td>Drag forward/backward</td>
<td>Level structural/primary image</td>
</tr>
<tr>
<td>Shift</td>
<td>Right</td>
<td>Drag left/right</td>
<td>Change palette range width of functional image</td>
</tr>
<tr>
<td>Shift</td>
<td>Right</td>
<td>Drag forward/backward</td>
<td>Change palette range center of functional image</td>
</tr>
<tr>
<td>Middle</td>
<td></td>
<td>Scroll forward/backward</td>
<td>Scroll through images</td>
</tr>
<tr>
<td>Left+Right</td>
<td>Right</td>
<td>Drag forward/backward</td>
<td>Resize image</td>
</tr>
<tr>
<td>Shift</td>
<td>Middle</td>
<td>Drag</td>
<td>Tilt the reconstructed planes</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Left</td>
<td>Click or drag</td>
<td>Set cross correlation point</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Right</td>
<td>Drag forward/backward</td>
<td>Adjust alpha blending setting</td>
</tr>
<tr>
<td>Shift</td>
<td>Left</td>
<td>Drag</td>
<td>Define SUV ROI</td>
</tr>
</tbody>
</table>

#### 7.3.6.2 Magic X cursor mode

<table>
<thead>
<tr>
<th>Key</th>
<th>Mouse</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl</td>
<td>Left</td>
<td>Click or drag</td>
<td>Apply Magic X</td>
</tr>
</tbody>
</table>

#### 7.3.6.3 Manual registration mode

<table>
<thead>
<tr>
<th>Key</th>
<th>Mouse</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Left</td>
<td>Drag</td>
<td>Moves the structural image</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Left</td>
<td>Drag</td>
<td>Moves the functional image</td>
</tr>
<tr>
<td>Shift</td>
<td>Right</td>
<td>Drag</td>
<td>Rotate the structural image</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Right</td>
<td>Drag</td>
<td>Rotate the functional image</td>
</tr>
<tr>
<td>Shift</td>
<td>Left+Right</td>
<td>Drag</td>
<td>Resize the structural image</td>
</tr>
<tr>
<td>Shift</td>
<td>Left+Right</td>
<td>Drag</td>
<td>Resize the functional image</td>
</tr>
</tbody>
</table>
8 Reports

eRAD PACS includes reporting functions that enable a user to record a text or dictated report and addenda, and to attach selected images to a report along with their presentation state. Reports from prior studies are available for display as well.

The patient folder displays a presentable form of a prior study’s report. The layout is templated, meaning it can be customized for presentation and content. Details on defining a report template and assigning it to your user account are found in the eRAD PACS Operator’s Manual.

The compact report panel is suited for dictating a report or addendum. It contains basic study identification information plus controls for recording a voice clip. Section 3.6.3 contains details on the compact report panel.

The full report panel provides access to all report components for each loaded study plus tools for creating, editing and reviewing reports. Section 3.6.3 contains details on the full report panel. The full report panel contains the key images as well. The key image panel appears at the bottom of the report panel. See section 8.3 for details.

Documents tagged as scanned paperwork, denoted by DICOM attribute (0008,0064) set to WSD or SD in SC Image or Encapsulated PDF objects, may appear in the report panel, depending on the applied XML template. Scanned documents can be dragged to an image frame in the viewer for manipulation, if necessary.

8.1 Displaying Reports

Reports consist of text, key images and attachments. Each of these can be displayed in the report panel.

8.1.1 Displaying Report Text

When a study loads into the viewer, it includes the report if one is available on the server. Report text for prior exams come from a variety of sources: entered directly from the eRAD PACS viewer; entered into the report editor from the web page; created on a third-party device such as a Radiology Information System (RIS) and imported into the PACS server. Once the server has the report data, it makes it available in the viewer’s report panel.

To display a report in the patient folder, do the following:
1. Click the report icon in the Reports carousel in the patient folder. The report appears in the view area of the patient folder.

To display a report in an image frame in the main viewer, do the following:
1. Drag the report icon in the Reports carousel into an image frame. The report replaces the previously displayed contents of the image frame.

To display a report in the report panel, do the following:
1. Click the Report Panel button, font from the toolbox toolbar or select Report Panel from the View menu.
2. If not already selected, click the tab for the study you want to display.
3. If not already displayed, click the sub-level tab for the report or addendum you want to display.

8.1.2 Displaying Attachments

If the study includes scanned documents or other forms of attachments, they appear in the Attachments section of the patient folder, in the thumbnail panel and in the report panel under a tab labeled Attachments.
In the patient folder, scanned documents are listed in the Attachments carousel. Click the attachment icon to display the document in the patient folder's view area. Drag the attachment icon into an image frame to display the document in the main image area.

If configured to display documents in the thumbnail panel, each attachment appears as an icon in the thumbnail panel. Drag the thumbnail to display the attachment in the main image area.

On the report panel, scanned documents are listed under the Attachments tab. Click the tab to see all the attachments. Click the attachment to load it into the report panel's attachment view area.

Note: The patient folder's view area, the main image area and the report panel's attachment tab's view area launch the application appropriate for the attachment's file type. The results are embedded into the designated area or launched in a separate window. The setting to embed PDF documents into the browser window is in Adobe Reader. From the Edit menu, select Preferences. In the Categories list, select Internet. Check the Display PDF in browser box.

If the attachment is an image (e.g., a JPEG file or DICOM object), position the mouse over the thumbnail to display the attachment at a readable resolution. For non-image file types (e.g., a PDF file), the attachment's file name appears.

The respective attachment view areas support three display modes.

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full image mode</td>
<td>Display the image at full resolution, adding vertical and horizontal scroll bars to reposition the viewable area.</td>
</tr>
<tr>
<td>Page-width mode</td>
<td>Fit the page width to the image area, adding a vertical scroll bar if necessary.</td>
</tr>
<tr>
<td>Full page mode</td>
<td>Fit the entire image to the image area.</td>
</tr>
</tbody>
</table>

To change the display mode, position the cursor over the image view area and click the left mouse button. The modes advance from page-width to full image to full page to page-width.

8.2 Creating a Report

Creating a report means entering text or a recording to a report, attaching a key image and changing the study state. To create a report you must have report editing and maybe dictation privileges. If the report panel has no editable fields, you may not have the requisite permissions. Speak with your system administrator if you need to change the settings on your account.

To create a report, open the report panel by clicking on the Report button, in the toolbox toolbar. If you press the Record button on a Philips Speechmike, you will open the compact report panel.

A report may consist of an observation, an impression, addenda, key images, and the dictated wav data. Any one of these components makes a report, although a report can consist of all of them. Creating an observation, impression, addendum and a dictation are described in the following sections. Attaching key images is described in section 8.3.

8.2.1 Text reports

Use the full report panel to enter a text report. The default report format consists of an observation section and an impression section. eRAD PACS does not apply any restrictions to the use of these fields other than they remain separate, both in the viewer and from the web page report. To enter text into either of these fields, click in the window and type.

The Notes section of the report panel contains radiologist notes. The text in this field is entered by and displayed for users with notes privileges. Other users, typically referring physicians, technologists, and
administrators, do not have access to the contents of the Notes field. The notes field is for submitting comments to the radiologist. If a note exists and the Impression and Observation fields are empty, the note automatically pops up when the study is loaded into the viewer. To disable this popup, clear the Show Report Note setting on the Settings page in Customize Settings. Notes are retained in the eRAD PACS database and can be edited any time prior to signing the report.

**8.2.1.1 Formatted Text**
The Observation and Impression text fields support rich text. The available tools include text font type and size, bold, italic, underline, strike-through, superscript, subscript, text alignment, bulleted and numbered lists, indentation, color, separator and tables. Rich text fields expand dynamically as you enter text.

For a detailed description of the formatting toolbar, refer to section, 3.1.9.

**8.2.1.2 Spell Checking**
If you have not installed the eRAD PACS spell checker, you will be prompted to do so when you first load the viewer. This process installs an application on your PC, which means you must have Windows administrator privileges on your workstation if the install is to work. If you do not have Windows administrator privileges, contact your local PACS administrator.

To use the spell checker, click the spell check button, on the report toolbar in the full report panel. The spell checker checks all text fields in the report panel. If it finds errors, it displays the spell check panel. Click the Change button to replace the misspelled word with the highlighted suggestion. The Change All button changes all occurrences of the misspelled word.

To add the word to your dictionary, click on Add. When done checking the text, click Cancel to close the spell checking window.

To override the spell checker’s default dictionary, create a new dictionary file named precorrect.txt in the c:\program files\practicebuilder\plugins\spellex directory. Restart the viewer to pick up the changes.

To use the spell checking function from the eRAD PACS web-based report editor page, you must have previously installed the eRAD PACS viewer and the spell checker plug-in module. The EP viewer must also be running in standby mode.

**8.2.1.3 Normality Flag**
The normality flag allows a user to tag a report so the study is visually highlighted on the worklist. To set the normality flag to Alert, clear the Normal Flag field on the report panel.

The presence and label of the normality flag on the report panel is configurable. It is a server setting, editable by the system admin. Refer to the Server Configuration section of the Operator’s Manual for more details.

**8.2.1.4 BIRAD Values**
BIRAD values can be assigned to a study in the report, but are only displayed for mammography images. To assign a BIRAD value to a report, open the Report panel and use the drop down box to select a value. Accepted values are n/a, 0, 1, 2, 3, 4, 4a, 4b, 4c, 5, and 6.

BIRAD values are displayed on the worklist if the column is included in the layout. User can search for studies with a defined BIRAD value.
8.2.2 **CANNED REPORT TEMPLATES**

Create a collection of predefined reports and apply them in place of dictating a report or typing a custom report. Each report template belongs to a user’s profile and can be defined as a general template or a modality-specific template. The administrator can copy canned report templates between user accounts, after which the new user can further customize the report template.

When saving a canned report template, the user specifies the text, state, flags fields are affected, and then combine multiple templates to compose a single report. The individual fields making up a report template are note, status, normality flag, observation, and impression.

To save a report template, follow these steps:

1. Open the Full Report panel.
2. Select Edit from the Template menu. The report panel changes to the report template editor.
3. Enter values into the fields to be saved in the report template.
4. Check the **Overwrite** checkbox for the fields you wish to replace when importing the canned report template. If the **Overwrite** checkbox is unchecked, the contents in that field will be concatenated to any existing contents when importing the canned report template. Check the **Overwrite** checkbox in the status field to replace the status with that of the template.
5. Select Save from the Report Template menu. The template saving panel pops up.
6. Enter the name of the canned report template. Valid characters are: alphanumeric (a-z, A-Z, 0-9), underline (_), hyphen (-), pound (#), period (.) and space.
7. To create a modality-specific canned report, check the box labeled **Available for specific modalities** and select the modalities from the list. Leave the box unchecked to create a generic canned report.
8. Click Save.

When a study is loaded into the viewer, canned report templates with the same Modality setting as defined by the study’s Modality attribute are combined with the general canned report templates into a single list. If multiple studies with different modality values are loaded into a single viewer session, templates for all modalities plus the general ones are available in a single list from the toolbar.

To apply a canned report to a study,

1. Open the report panel in the eRAD PACS viewer
2. From the Template menu, select Load.
3. From the list of saved report templates, select the one you want to apply.
4. Click OK. The viewer downloads the report from the server and enters the text into the respective fields.

8.2.3 **DICTATION**

eRAD PACS records dictations in the viewer using any Windows compatible microphone and sound card. Follow the manufacturer’s installation instructions for these components before attempting to record a report in eRAD PACS.

The recording controls are located in the Audio toolbar, which you can attach to the report panel by selecting **Audio Controls** from the View menu in the report panel. The recording controls contain a play/stop button, and record button and a delete button. There is also a progress gauge showing your current recording position.

Dictating a report requires dictation permissions.

Start recording a dictation by selecting the Record button on the Audio Toolbar, or from the Audio menu. After you finish recording, click on the Stop button. Play back the dictation by rewinding it to the beginning.
of the recording and pressing the Play button. Use the speed control gauge on the Audio toolbar to adjust the speed of the playback.

If multiple editable studies are loaded in the viewer when you start dictating, eRAD PACS prompts you to select the report you want to dictate. By default, the system chooses the report that corresponds to the primary study, which is the first study listed in the thumbnail panel. Choose the study you want to dictate and click OK.

If you start dictating when the selected image frame is from a study other than the one you previously selected, the Viewer prompts you to confirm you are dictating into the correct report. You can disable this prompt by checking the Make selection permanent for this viewer session box. To change the target study after making this assignment, open the Settings menu and uncheck Permanent Report Selection. The next time the image frame focus changes and dictation is started, the study selection window appears.

To disable the study selection prompt, deselect Enable Dictated Study List in the Customize Settings' Settings page. When disabled, dictation applies to the primary study.

Remove part of a recording by positioning the locator at the start of the unwanted section and clicking on the Delete button in the Audio Toolbar. The entire recording from the present location to the end is purged. Deleting removes everything to the end of the report.

It is not possible to delete any part of a dictation if the report component (observation, impression or addendum) has been approved and is in the Final state.

8.2.3.1 Philips SpeechMike™ Support
The eRAD PACS viewer supports tighter integration with the Philips SpeechMike than it does for other microphones. eRAD PACS supports the following Philips SpeechMikes:

- Philips LFH-30x0 SpeechMike AIR Pro
- Philips LFH-32x0 SpeechMike III Pro
- Philips LFH-35x0 SpeechMike Premium
- Philips LFH-36x0 SpeechMike Premium
- Philips LFH-5262/LFH-5272 SpeechMike Pro
- Philips LFH-5274 SpeechMike Pro
- Philips LFH-5276 SpeechMike Pro
The following models are supported on Windows XP, 2000 and Vista as well.

- Philips LFH-6174 SpeechMike Pro
- Philips LFH-6274 SpeechMike Pro

Figure 8.2.2.1-1 shows the SpeechMike and the buttons available from eRAD PACS.

SpeechMike integration requires driver 2.3.190.7 or later. Install the SpeechMike device and driver according to its instructions, and then restart the viewer. Set up your SpeechMike configuration in the Customize Settings' Dictation panel. See section 4.1.13 for details.

**State Based Control Mode**

When set for State Based control, the SpeechMike has two functional states. When inactive, the indicator light is off and the device is used to adjust the current position in the recording (rewind, fast forward) and to play back the recording. When the SpeechMike is activated, the indicator light turns on, the compact report window appears on the screen, and the device is ready to record a dictation. Toggle between the two modes by pressing the *Record* button.

To start recording, press the Record button to activate the SpeechMike, then the Play button to start recording, and speak. To stop recording, press the Play button again. Depending on the state of the *Keep SpeechMike Active* setting in the customize settings window, pressing the Play button will either return to Pause mode, or disable the SpeechMike.

To add to an existing dictation, press the Play button to append the voice to the existing recording. If you select Rewind or Fast Forward, you can reposition the starting point for recording more data.

When the control mode setting is State-based, the SpeechMike controls are as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Start Mode</th>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOL</td>
<td>N/A</td>
<td></td>
<td>Button not used by eRAD PACS</td>
</tr>
<tr>
<td>RECORD</td>
<td>OFF</td>
<td></td>
<td>Enter PAUSE mode</td>
</tr>
<tr>
<td></td>
<td>PAUSE</td>
<td></td>
<td>Turn SpeechMike OFF</td>
</tr>
<tr>
<td></td>
<td>RECORDING</td>
<td><em>Keep SpeechMike Active is disabled</em></td>
<td>Turn SpeechMike OFF</td>
</tr>
<tr>
<td></td>
<td>RECORDING</td>
<td><em>Keep SpeechMike Active is enabled</em></td>
<td>Enter PAUSE mode</td>
</tr>
<tr>
<td>INS/OVWR</td>
<td>Any</td>
<td>Delete remainder of dictation: No</td>
<td>Delete from current position to end</td>
</tr>
<tr>
<td>RECORDING</td>
<td>Delete remainder of dictation: Yes</td>
<td>Overwrite audio from current position to end</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;</td>
<td>Any</td>
<td>Rewind mode: Steps, press and release</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any</td>
<td>Rewind mode: Steps, press and hold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any</td>
<td>Rewind mode: Continuous</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PLAY</td>
<td>Stop playing dictation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PAUSE</td>
<td>Enter RECORDING mode and record</td>
<td></td>
</tr>
<tr>
<td>RECORDING</td>
<td>Keep SpeechMike Active is disabled</td>
<td>Turn SpeechMike OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RECORDING</td>
<td><em>Keep SpeechMike Active is enabled</em></td>
<td>Enter PAUSE mode</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any</td>
<td>Fast forward mode: Steps, press and hold</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any</td>
<td>Fast forward mode: Continuous</td>
</tr>
</tbody>
</table>

**Persistent Control Mode**

When set for Persistent control, the SpeechMike is activated automatically when you press a button, and deactivated automatically when you release the button. If the SpeechMike type is set to *4-position switch*, persistent mode is the only control mode available.
If your SpeechMike’s control mode setting is Persistent, the SpeechMike controls are as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOL</td>
<td>Button not used</td>
<td></td>
</tr>
<tr>
<td>RECORD</td>
<td>Record until released</td>
<td></td>
</tr>
<tr>
<td>INS/OVWR</td>
<td>Delete remainder of dictation: No</td>
<td>Insert audio</td>
</tr>
<tr>
<td></td>
<td>Delete remainder of dictation: Yes</td>
<td>Overwrite audio from current position to end</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Rewind mode: Steps, press and release</td>
<td>Rewind for configured Step Time</td>
</tr>
<tr>
<td></td>
<td>Rewind mode: Steps, press and hold</td>
<td>Rewind to beginning of recording</td>
</tr>
<tr>
<td></td>
<td>Rewind mode: Continuous</td>
<td>Rewind until released</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Fast forward mode: Steps, press and release</td>
<td>Fast forward for configured Step Time</td>
</tr>
<tr>
<td></td>
<td>Fast forward mode: Continuous</td>
<td>Fast forward to beginning of recording</td>
</tr>
<tr>
<td></td>
<td>Fast forward mode: Continuous</td>
<td>Fast forward until released</td>
</tr>
</tbody>
</table>

If you need audible feedback to know what mode the SpeechMike is in, check the SpeechMike Button Click, SpeechMike Pause Click and Record Start/Stop Tick boxes in the Settings page of the customize settings window. When the button click setting is enabled, each time you press a button on the SpeechMike, you hear a soft click. When the pause click setting is enabled, a click is sounded every two seconds while the SpeechMike is in pause mode. The click sound continues until you either start recording or deactivate the SpeechMike. The Record Start/Stop Tick setting results in audible click played back when the user enters or exits record mode.

The assigned clicking sound and volume is managed by Windows. By default, the click sound is start.wav. To change the click sound file, go to the Windows Start button, select Settings and then Control Panel. Double click on Sounds or Sounds and Audio Devices, depending on the version of Windows you have loaded. Select the Sounds tab. In the Program Events list, find the Windows event for the SpeechMike and select it. The Sounds list activates. Select any of the available sound files, of select Browse to load a custom sound file. When you’ve selected the sound file, click on OK to save.

8.2.4 SPEECH RECOGNITION

Speech recognition (SR) is the function of converting spoken language into editable text without manual transcription. Instead of using a keyboard to type text into an editor package, the user talks and the words appear in the text area. The converted text has the same properties as text entered manually into eRAD PACS, whether it was from the viewer’s report panel, the transcriptionist’s report panel, or the RIS.

eRAD PACS provides optional embedded SR support, where the SR tools are integrated into EP’s basic reporting function. The embedded SR functions are described in section 8.2.4.1.

For users running an integrated SR application on the workstation, eRAD PACS includes an optional interface to use it as an alternative to its embedded solution. This interface is described in section 8.2.4.2.

8.2.4.1 Embedded Dragon Naturally Speaking

The embedded Dragon Naturally Speaking package is provided as an optional plug-in module. It requires a plug-in module license, plus a licensed copy of Dragon Naturally Speaking (DNS) installed on each workstation. The embedded SR package is intended to be used with a Philips SpeechMike. Other microphones are supported, but the integrated controls are only available on the SpeechMike.

To configure the EP viewer to use embedded SR, open the Customize Setting window from the Settings menu, and click on the Speech Recognition tab. See section 0 for details. If the Dragon Naturally Speaking option is available, it means the license has been installed on the server, and a valid copy of Dragon exists on your workstation. Select it, and click OK to set the embedded speech recognition as your default report recording tool.
When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This would be unnecessary if the user is responsible for editing the resulting text. However, if the results of the SR processing need editing by a third party, such as by a transcriptionist, save the original recording for validation. Check the box labeled Auto record WAV when dictating in the Customize Settings’ Speech Recognition panel to save the WAV file.

When Dragon Naturally Speaking is selected as the default dictation mode, the Speech Recognition menu appears at the top of the EP viewer. This is the where you will find all the Dragon controls and tools. For detailed information on each of these tools, refer to the Dragon Naturally Speaking user manuals.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Displays the current user account name</td>
</tr>
<tr>
<td>Microphone</td>
<td>Enable/disable the microphone</td>
</tr>
<tr>
<td>Open User</td>
<td>Open an existing user account</td>
</tr>
<tr>
<td>New User</td>
<td>Create a new user account</td>
</tr>
<tr>
<td>Close User</td>
<td>Close the current user account</td>
</tr>
<tr>
<td>Roaming User Options</td>
<td>Set up roaming user configuration</td>
</tr>
<tr>
<td>Manage Users</td>
<td>Edit DNS user accounts</td>
</tr>
<tr>
<td>Audio Setup Wizard</td>
<td>Set up the microphone and sound controller</td>
</tr>
<tr>
<td>General Training</td>
<td>Train DNS to understand speech patterns</td>
</tr>
<tr>
<td>Train Words</td>
<td>Train DNS to understand specific words</td>
</tr>
<tr>
<td>Vocabulary Editor</td>
<td>Add and edit the DNS dictionary</td>
</tr>
<tr>
<td>My Commands</td>
<td>Add and edit custom commands, including EP commands</td>
</tr>
<tr>
<td>Accuracy Center</td>
<td>Tools to help you improve how DNS hears and understands what you say</td>
</tr>
<tr>
<td>Recognition History</td>
<td>Display most recently used words recognized by DNS</td>
</tr>
<tr>
<td>Option</td>
<td>Set DNS options</td>
</tr>
</tbody>
</table>

eRAD PACS has integrated a set of voice commands specific to the features available in the EP viewer. These commands must be downloaded from the eRAD PACS server and uploaded into the Dragon vocabulary. The available EP-specific commands are given in the following table.

<table>
<thead>
<tr>
<th>Voice Command</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>approve</td>
<td>Approve a report and set state to Final</td>
<td></td>
</tr>
<tr>
<td>bold font</td>
<td>Set selected text to bold font</td>
<td>Applies to selected text only</td>
</tr>
<tr>
<td>close study</td>
<td>Close the current study</td>
<td>Leaves the viewer open</td>
</tr>
<tr>
<td>close views</td>
<td>Close the image views</td>
<td></td>
</tr>
<tr>
<td>compact report panel</td>
<td>Display the compact report panel</td>
<td></td>
</tr>
<tr>
<td>customize settings</td>
<td>Open Customize Settings window</td>
<td></td>
</tr>
<tr>
<td>end dictation</td>
<td>End the dictation and disable the microphone</td>
<td></td>
</tr>
<tr>
<td>end study</td>
<td>End the current viewer session</td>
<td></td>
</tr>
<tr>
<td>exit from viewer</td>
<td>Close the study and the viewer</td>
<td></td>
</tr>
<tr>
<td>fit image</td>
<td>Set image zoom to fit-to-window</td>
<td>Requires a selected image frame</td>
</tr>
<tr>
<td>focus to addendum \ impression</td>
<td>Set cursor focus to the report's Addendum, Impression, Note or Observation field</td>
<td>Available with the full report panel is open</td>
</tr>
<tr>
<td>full report</td>
<td>Display the full report panel</td>
<td></td>
</tr>
<tr>
<td>full screen</td>
<td>Display selected image in Full Screen mode</td>
<td>Requires a selected image frame</td>
</tr>
<tr>
<td>help contents</td>
<td>Pop up the Help window</td>
<td></td>
</tr>
<tr>
<td>hide report panel</td>
<td>Close the compact or full report panel</td>
<td></td>
</tr>
</tbody>
</table>
To download the commands, follow the following steps.

1. Open the Customize Settings window from the Settings menu, and select the Speech Recognition tab.
2. Click the button labeled Download Voice Commands. A popup window appears describing the install process. Click OK. A window appears allowing you to select where to save the file you are about to download. Select the folder, or choose Desktop, and click Save.
3. After the file transfer completes, click on the Speech Recognition menu at the top of the EP viewer, and select My Commands. This starts the DNS command browser.
4. In the DNS Command Browser window, click the Manage button
5. Click on the Import button. From the Windows browse window, find the folder where you saved the command file in step 2, select the file (you may need to change the File Type to show All Files) and click Open.
6. Click Yes to validate the command file.
7. If you want to remove some of the EP commands, uncheck the ones you want to exclude. When ready, click on Import to import the remaining commands.
8. Close the DNS Command Browser when you are done.

### 8.2.4.2 Embedded SpeechMagic

The embedded SpeechMagic package is provided as an optional plug-in module. It requires a plug-in module license, plus a licensed copy of SpeechMagic installed on each workstation. The embedded package is intended to be used with a Philips SpeechMike. Other microphones are supported, but the integrated controls are only available on the SpeechMike.

To configure the viewer to use embedded SR, open the Customize Setting window from the Settings menu, and click on the Speech Recognition tab. See section 0 for details. If the SpeechMagic option is
available, it means the license has been installed on the server, and a valid copy of SpeechMagic exists on your workstation. Select it, and click OK.

When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This would be unnecessary if the user is responsible for editing the resulting text. However, if the results of the SR processing need editing by a third party, such as by a transcriptionist, save the original recording for validation. Check the box labeled Auto record WAV when dictating in the Customize Settings’ Speech Recognition panel to save the WAV file.

When SpeechMagic is selected as the default dictation mode, the Speech Recognition menu appears at the top of the viewer. This is the where you will find the SpeechMagic controls and tools. For detailed information on each of these tools, refer to the SpeechMagic user manuals.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize on init</td>
<td>Synchronize user file. Startup is faster with the synchronization disabled.</td>
</tr>
<tr>
<td>Adapt on save</td>
<td>If enabled, self-learning is triggered when saving a report. If enabled,</td>
</tr>
<tr>
<td></td>
<td>custom report templates are disabled.</td>
</tr>
<tr>
<td>Auto-init on login</td>
<td>Automatically log in and load user profile.</td>
</tr>
<tr>
<td>Initialize</td>
<td>Manually log in and load user profile. Disabled if Auto-init is enabled.</td>
</tr>
<tr>
<td>Uninitialize</td>
<td>Manually log out and unload user profile.</td>
</tr>
</tbody>
</table>

8.2.4.3 Embedded Fluency Direct™

M*Modal’s Fluency Direct speech recognition engine translates dictated reports into text and drives speech-driven mouse controls. The viewer supports Fluency Direct version 7.83.0.508 and later. The interface is supported for Windows 7.

The Fluency Direct plug-in module requires an eRAD PACS Speech Recognition plug-in module license. When licensed, Fluency Direct is downloaded and installed on your workstation as a plug-in module. The package is about 50MBs, not including the dictionaries. Fluency Direct is intended to be used with a Philips SpeechMike. Other microphones are supported, but the integrated controls are only available on the SpeechMike.

To configure the viewer to use embedded SR, open the Customize Setting window from the Settings menu, and click on the Speech Recognition tab. See section 0 for details. If the Fluency Direct option is available, the license has been installed on the server and a valid copy of Fluency Direct exists on your workstation. Enter your Fluency Direct user account ID, password and author OID in the respective fields. Select it, and click OK.

After configuring the viewer for Fluency Direct, the installation wizard walks you through the install. When you are successfully logged in, the floating Fluency Direct panel appears. It contains controls to configure and test the engine.

Before using Fluency Direct, you must select and download a dictionary. This is available from the Fluency Direct panel under Tools/Domains. The Radiology dictionary is recommended. You must also calibrate your microphone. This tool is available from the Fluency Direct panel under Tools/Microphone/Calibration.

For full details and troubleshooting assistance, refer to the Fluency Direct installation manual.

When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This would be unnecessary if the user is responsible for editing the resulting text. If a transcriptionist is expected to edit the result of the SR process, save the original recording for validation. Check the box labeled Auto record WAV when dictating in the Customize Settings’ Speech Recognition panel to save the WAV file.
8.2.4.4 Integrated Speech Recognition Systems

Many speech recognition systems provide an interface to pass control between a PACS viewer and the speech recognition client application. The interface consists of an XML file written to the local file system by the viewer and picked up by the speech recognition system. The XML file contains study details, user IDs and other information.

Some systems using this interface are eRAD’s VR1 and VR2, and Nuance Powerscribe. In some cases, an additional component is required. For example, Powerscribe supports this interface via its PACS Bridge software. Check your speech recognition system’s documentation for information on setting up this interface.

To configure the EP viewer to use this interface as the default dictation mode, the eRAD PACS Integrated Speech Recognition plug-in module must be licensed, the user must have permissions to load the plug-in module, and the speech recognition’s client application plus interface module, if necessary, must be installed and running on the workstation. Set the dictation mode as follows:

1. Opening the Customize Settings window from the Settings menu in the EP viewer.
2. Click the Speech Recognition tab.
3. If the plug-in license exists on the server, XML Interface Speech Recognition option is available in the Speech Recognition System list. Select it.
4. Confirm your user account and password. By default, the eRAD PACS account ID and password are used. If these do not match your speech recognition system’s ID and password, set them to their correct value.
5. The speech recognition system looks for control (XML) files in a folder on the workstation. The default file is C:\Dictaphone\study.xml. Check with your speech recognition system for the location and file name it uses. Set the folder and filename in the XML File field.
6. Click OK to save them.

Note that the list of available speech recognition systems displayed on the pull down list in the Customize Settings panel is configurable. If your system is not displayed, talk with your system administrator about adding it.

With the speech recognition client running and the EP viewer configured to use it as the default dictation mode, activate it by clicking the Record button in the EP viewer. The Record button is on the Audio toolbar. You might consider creating a keyboard macro to provide a shortcut to a button on your microphone. The accession number and other configured values of the selected study are written to the configured XML file. The speech recognition system should detect the file, read its contents, remove the XML file and then take over the recording process.

At this point, consult your speech recognition’s user manual for further information. Mouse and keyboard control generally remain with the eRAD PACS viewer, unless you display the speech recognition’s user interface and give it the mouse and keyboard focus.

The report created by the speech recognition system does not appear in the EP viewer report panel immediately. The system sends the report to eRAD PACS server directly, or indirectly through the RIS.

The information written to the XML file passed from eRAD PACS to the speech recognition system is configurable. Refer to the eRAD PACS Speech Recognition Configuration Manual for details.

8.2.5 Addendums

Correct or modify approved (Final) reports from the report panel by attaching an addendum to the report. If a report or an addendum is unapproved, you can modify it. When a report or addendum is in the Final
state, the text is not editable and a new addendum section appears at the bottom of the report panel or on a separate tab in the report panel. Enter the addendum text as you would for the initial report. Click on the Record button to dictate an addendum, or enter text into the editable text field on the full report panel to type an addendum.

When a user presses the Record button to start dictating, the viewer checks to see if the report component is an addendum. If it is, the viewer pops up a notification. The user must indicate if the viewer should insert the dictation into the addendum. Select Yes or No. This setting applies to this entire session.

In the popup notice, disable this warning permanently by checking the Don't show this warning again box. Once checked, re-activate the prompt from the Settings menu. Click the Warn when dictating to an addendum item on the menu to clear the checkmark.

To play back an addendum’s dictation, open the full report panel, scroll down to the addendum section or select the addendum’s tab, and click on the Listen or Play button.

8.2.6 RESTORING A REPORT

eRAD PACS provides two methods for restoring a report. The first method restores the report with the version that is presently stored on the eRAD PACS server. Provided you have not saved any changes, click on the Reload Report button in the full report panel. eRAD PACS retrieves the last stored report from the server.

After creating a report, communications problems between the workstation and server prevent you from saving it to the eRAD PACS server. Another problem may be another user took the write permissions (ie, the lock) from your edit session. (You would have received a notice indicating this.) To save your work, make a temporary copy of the report on your local workstation’s disk, and restore it at a later time so you can submit it to the eRAD PACS server. To save a report to your workstation, select Save to hard disk from the report panel’s Report menu or from the report toolbar. To restore it, open the study from the worklist at a later time, open the full report panel, and click Restore saved report. The text, dictation, key images and study state you previously saved are loaded into the report panel. You can now submit it to the server using Send report.

8.3 Key images

Save the presentation state of a rendered image to a report by making it a key image. Key images selected for a particular study are displayed at the bottom of the full report panel. Depending on the report panel template, scroll to the key images or click the Expand button,  , to expand the key image panel. Key images can be available in the Presentation Group section of the thumbnail panel if Show Key Image Thumbnails is set under the Settings tab in the Customize Settings panel.

eRAD PACS indicates an image has been marked as a key image by displaying a key image icon in the top left corner of the image when it is displayed in an image frame. Clicking on the icon opens the report panel and displays the image attached to the report.

The viewer contains two key image icons: a paper clip and a key. A paper clip icon,  , denotes that a particular image is attached to the report and viewable on the report panel. The key icon,  , indicates that the marked image is rendered using the same display characteristics (window/level, annotation, etc.) as the image attached to the report. These icons allow the user to discriminate between multiple instances of the same images attached to a report, each with a different set of parameters.

8.3.1 ATTACHING KEY IMAGES

To save a key image in the main viewing area, do the following:
1. Select the key image attachment cursor mode button, to, in the toolbox toolbar. The cursor changes to a paper clip.
2. Position the cursor over the image you want to save
3. Click the left mouse button. The key icon appears in the top left corner.

Make changes to the key image presentation state from the report panel. Changes made to the original image do not change the key image.

To save the image as a second key image, modify the original image’s presentation state. The icon in the top left corner of the original image changes to a paper clip, indicating the image in the frame no longer matches the one in the report panel. Set the cursor to key image mode and click on the image again. In the report panel, two images appear, each with their individual display characteristics.

To automatically create a key image when annotating an image, set the Generate Key Image setting on the Auto PS tab in the Customize Settings panel, and select the annotation tools. See section 4.1.15 for details. The key image is created automatically when the user adds a selected annotation to an image. By default, this feature is disabled.

To select multiple images without having to reset the cursor mode between each click, hold down the Alt key while you click on mouse button.

In the full report panel, the number of key images attached to each report segment (main report and each addendum) is listed in each segment’s header.

When attaching key images to a report, it is useful to label each image so you can reference them in the report. With the text annotation tool, manually add an identifier to each key image before attaching it to the report. It automatically drops a sequential numeric label onto each image in the report, eliminating the need to explicitly type in a text annotation. To use the report figure numbering tool, see section 6.2.4.

### 8.3.2 Modifying Key Images

Images in the full report panel are editable, as if they were in an image frame. Open the full report panel and change the window or level, add an annotation, change the zoom factor, etc. When modifying the image in the report panel, there is no need to reassign it as a key image.

Alternatively, drag and drop the key image from the full report panel into any image frame to manipulate its settings. Settings changed in an image frame are not saved unless you reselect the image as a key image and resubmit the report. To drag an image, position the cursor over the diagonal lines in the top left corner of the image until the cursor changes to a hand. Press and hold down the left mouse button, and drag the image to its destination. When the cursor is over the destination image frame, release the mouse button.

Once a report is approved, i.e., the study state is Final, images attached to a report cannot be modified. Add an additional key image reflecting the updated settings to the addendum.

### 8.3.3 Printing Key Images

To quickly add all the key images in a report to the print panel, open the report panel, click on the Images menu, and select Add All Key Images to Print Panel. When you open the print panel, the key images appear in the display area. You can edit or remove any image from the print panel.

### 8.3.4 Removing Key Images

To remove a key image from the full report panel, do the following:

1. Open the full report panel.
2. Select the image
3. Press the Delete key.
4. At the prompt, confirm the delete.

To remove a key image from an image frame, the key image icon must be the key icon, \( \text{X} \). If this icon is not displayed on the image, move it from the full report panel to an image frame. Then do the following:

1. Place the cursor over the key image icon in the top left corner of the image. The cursor changes to a key with an ‘X’ through it.
2. Click on the icon.
3. At the prompt, confirm the delete.

It is not possible to remove a key image attached to a report segment that has been approved and is in the Final state.

### 8.4 Submitting Reports

After you create any report component, including recording a dictation, adding text to the report impression, attaching a key image, amending a report or just changing the report state, submit the report using either of the following methods:

- Click the Send Report button, \( \text{Send Report} \).
- Close the study. In the close prompt, check the Send Report box to submit the report to the server.

When the status toolbar displays Report Sent, the server has acquired and stored the changes.

When the viewer encounters a network problem while saving a report, store it locally for submission at a later time. Select the Save to hard disk option from the Report menu or report toolbar. Be aware that this is not the equivalent to submitting the report to the eRAD PACS server. It simply saves your work on your local machine so you can come back to it at another time. When the network problems are resolved, open the same study. eRAD PACS detects the saved report, and notifies you that you have a copy of a report on your machine. From the prompt, click Yes to import the saved report. Everything you saved is now stored to the viewer, and can be saved to the eRAD PACS server.
9 User collaboration

When multiple users need to consult with each other while viewing a study, eRAD PACS allows them to share a common instance of the viewer. When a user initiates a collaboration session, his/her viewer appears on the workstation of the invited participants, and the actions applied by any one of the users is rendered on the other’s workstation. There is dual-cursor support so that each user can see what the other is doing. When used in combination with a telephone, the participants can communicate and review the same study as though they were sitting together at the same workstation.

Collaboration requires that the other participant(s) have the eRAD PACS viewer installed on their workstation and running in standby mode (see section 4.1.1), and are presently logged into the same eRAD PACS server under his or her own account.

To establish a collaboration session, select the Connect option on the Collaboration menu. A window appears, with a list of users connected to eRAD PACS. At this point, there are two options. If all the intended participants are directly accessible from the network by the server, meaning they are on the same local area network, or the network does not consist of NAT devices or other redirection devices, the collaboration host can invite users to join. If the server cannot reach one or more of the participants, the host must explicitly create a collaboration session and the participants must individually join it.

In the case where the server can address the workstation of each participant, select the user you want to add to the collaboration session and click on Invite User From List. The other user will receive a prompt notifying him that you wish to establish a collaboration session. If they accept the session, eRAD PACS launches itself on the other user’s workstation, and displays what is presently displayed on your workstation.

In the case were the server cannot address the workstation, or when the invite request fails with a message indicating the server could not connect to the workstation, the host will have to create a session and each user will have to join it. Start by having the host create a session name and click on Create New Session. Then have each participant type in the same session name and click on Join existing session. When everyone has joined the session, the workstation screens will contain the information displayed on the host’s screen.

When the connection is accepted, you will see a second cursor appear on your workstation. The white cursor is yours. The red cursor is the cursor on the other user’s workstation. As each of you moves your cursor, the other will see it move on his workstation. Any action you take to change the image display, including window/level settings, scrolling, series selection, zooming, annotations, etc., will appear on the other workstation. The collaboration session only affects the main viewing workspace. The popup windows, including the report panel, settings windows, notices, layout manager, and print panel, are not shared on other participant’s workstations.

At all times during a collaboration setting, one of the users is the master, meaning they have control of the session. By default, the host is the master. For security purposes, none of the other users can obtain control of the session without the master granting it to him. To request control, the other user simply clicks their mouse on the workstation. A notice appears on the master’s workstation indicating that the other user requested control of the session. The master user can either turn over control to the other user, or deny the request. If control is passed over, then the original master must request it back using the same technique.
The user creating the session grants permission to users to join the session, but does not define access restrictions to the study data. eRAD PACS global restrictions for the user who opened the study are temporarily granted to all collaboration session participants. When a user leaves the collaboration session and when the session is terminated, each user’s global restrictions revert to their usual settings.

When the session is over, either user can request to terminate the session by selecting the Disconnect option from the Collaboration menu, or the user who established the session can close the viewer. Once the session is terminated, the users revert to the same access to the studies as they had prior to the collaboration session.
10 Saving data
The eRAD PACS viewer allows the user to save the image data to files on the local workstation using a limited number of standard formats.

10.1 Saving JPEG images
Users can save a copy of an image or series of images to the local file system in a JPEG formatted file by using the Save function. Under the File menu, select Save Image to save the selected image, or Save Series to saves all the images in the selected series to individual JPEG files. After requesting one of these options, eRAD PACS pops up a window from which the user can select a destination directory and a file name. If saving a series of images, eRAD PACS automatically appends a numeric increment to the base file name and places one image in each file. The resulting file represents the presentation state of the image when saved, including the annotations, zoom factor, window/level setting, and all other display characteristics as they appear on the screen.

A user can also copy the selected image into the system clipboard so the image can be pasted into another application. Select the image and choose Copy from File menu. To paste the image, open the other application and select the paste option as defined by that application.

10.2 Saving DICOM images
To save a copy of the original DICOM image, you must use the browser interface. The eRAD PACS viewer cannot save DICOM objects. From the browser interface, you can create a DICOM-conformant media by using the Export function, downloading the resulting ISO file to your workstation, and then writing this to a CD or DVD using the CD/DVD writing software installed on your PC. eRAD PACS does not provide an application to write the data to the CD/DVD media. Refer to the eRAD PACS Operator’s Manual for additional information.
11 Printing

From the eRAD PACS viewer, you can print full-resolution images to DICOM conformant imagers, or to ordinary printers supported by your Microsoft Windows operating system. The printing procedure starts by selecting one or more images that are currently loaded into the eRAD PACS viewer, and arranging them in the print panel. For information on the print panel, see section 3.6.4 and the section below.

You can print or hide the image overlays when you print images to either a Windows printer or a DICOM printer. If the overlays are displayed on the screen when you request the print job, the resulting images will display them as well. If the overlays do not appear on the images, they will not appear on the film or paper. To display the overlays, select Show Image Information from the View menu, or hit the F10 key.

When printing images from the eRAD PACS viewer, if hash marks are displayed on the image, they will appear on the printout.

If the user has defined a print header for Windows printouts, it also appears on DICOM printouts.

11.1 Print panel

To display the print panel, select Print from the File menu. If no image frame or thumbnail is selected, the print panel opens with no images loaded. If you have an image frame selected when calling up the print panel, eRAD PACS automatically loads the images into the panel. The number of images eRAD PACS loads depends on the Drop Image setting. eRAD PACS either loads the selected image, the entire series, the entire study, or prompts the user to select an image range.

To load additional images into the print panel, position the cursor over the drag icon (diagonal lines in the top left corner of the image) in the image frame. The cursor changes to a hand. Hold down the left mouse button, drag the image over the print panel and release the mouse button. You can also drag the frame from the thumbnail panel into the print panel. The images in the print panel appear in a tile mode, meaning they are not stacked. Use the scroll bar on the right of the window to see all of the images.

When adding images to the print panel, you can insert every N\textsuperscript{th} image. Set the selection type to Prompt. When you drop a series onto the print panel, a popup window appears. The viewer loads the image specified in the From field, and then every N\textsuperscript{th} image based on the Skip value, until the number in the To field is reached. By default, the Skip value is set to 1, meaning every image is included in the print panel. To include images that were skipped, change the upload selection to Single, find the specific image in the main viewer area or thumbnail panel, and drag and drop it in place.

To remove any or all images in the Print window, click to select the image and then click on the Delete button. If you want to clear all the images, click on the Clear All button. It is not possible to delete more than one image at a time with the exception of deleting all the images.
If you need to reorganize the images in the Print window, click on the image’s top left corner and drag it from its current location and drop it into the destination position.

### 11.2 Print Layout Templates

Two methods exist for defining print layouts. Users with administrator permissions can define system-wide print layouts for DICOM printers, available in all viewer sessions to users with printing privileges. Details for this method are contained in the *eRAD PACS DICOM Print Configuration Manual*.

Users can customize their own print layouts using the print layout templates. These are user-specific templates stored in the user’s profile. They define specific options such as film sheet layout, film type and a specific printer.

#### 11.2.1 Creating a Print Layout Template

To create or modify a print layout template, load a study into the viewer and perform the following steps:

1. Select File→Print to open the print panel.
2. Select the printer type: Windows or DICOM.
3. From the printer list, select the printer.
4. Define printer-specific settings. The available options and procedure for setting them depend on the printer type and default printer. Refer to the print panel documentation for additional details.
5. Click the Save button, ![Save button](image), in the Print Layouts toolbar in the print panel.
6. In the Save Print Layout window, enter the label assigned to the current settings.
7. If this layout applies to specific modality types, check the box labeled *Available for specific modalities* and select the modalities from the list.
8. If this layout is the default layout for one or more modality types, select them from *Use as default for these modalities* list.
9. Click OK.

Print layouts save the following information:

- Printer type
- Printer
- For Windows printers
  - Rows
  - Cols
  - All settings defined by clicking the Settings button
- For DICOM printers
  - All settings defined by clicking the Settings button

Print layout templates can be copied from one user account to another. See the *eRAD PACS Operator’s Manual* for details.

#### 11.2.2 Applying a Print Layout Template

To apply an existing print layout template, including the built-in system default (labeled *System Default*), do the following:

1. Select File→Print to open the print panel.
2. From the Print Layouts toolbar, select the template you want to apply. The assigned settings are applied.
3. Modify the templates settings by editing them. These changes apply to this current print session and will not be saved.
11.2.3 Deleting a Print Layout Template

To remove a defined print layout template from your profile, do the following:

1. Select File→Print to open the print panel.
2. From the Print Layouts toolbar, select the template you want to delete.
3. Click the delete button, δ, in the Print Layout toolbar.

11.3 DICOM Printing

When printing to a DICOM printer, select DICOM in the print panel. This enables all of the DICOM printing options. The pull-down menu lists all of the available DICOM printers. Select the printer you want to send the print job to, and the Layout. The Layout shows the number of columns and rows on a printed sheet of film. The options are represented as column, row.

To review the default printer parameters as defined in the printer configuration file on the server, click on the Settings button. In most cases, the default settings are defined to work with the selected printer and changes should not be necessary. However, there are times when you may want to change a setting for a single print job. Modifying the parameters from this window changes them for the current print job. If you wish to make the change permanent, you must have the system administrator change the setting on the server.

The DICOM print settings consist of three tabbed pages. The Film page contains the settings that apply to the film itself. The Session page contains the settings that apply to the entire print job. The Others page contains miscellaneous settings. Each of these settings is described in the table below.

Many of the settings contain an option to use the default. The default is a value defined in the DICOM printer configuration file. This file is created by the systems administrator, and is available from the Server page in the browser interface. The default settings are usually the best option. Only override the default when you know how it will affect your results.

<table>
<thead>
<tr>
<th>Page</th>
<th>Setting</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film</td>
<td>Film Orientation</td>
<td>Portrait, Landscape</td>
<td>Specifies the orientation of the film. Default is usually portrait.</td>
</tr>
<tr>
<td>Trim</td>
<td>Trim, No Trim</td>
<td></td>
<td>Specifies whether the film sheet is to contain trim. The default is usually no trim.</td>
</tr>
<tr>
<td>Layout</td>
<td>Rows, Columns</td>
<td></td>
<td>Layout options configured for this printer.</td>
</tr>
<tr>
<td>True Size</td>
<td>Printer specific</td>
<td></td>
<td>Print the images at their true dimensional size.</td>
</tr>
<tr>
<td>Decimate/Crop</td>
<td>Request crop, Request</td>
<td></td>
<td>Specified what happens to the image when it does not fit within the defined boundaries of the image box.</td>
</tr>
<tr>
<td>behavior</td>
<td>decimate, Request</td>
<td></td>
<td>FAIL</td>
</tr>
<tr>
<td>Presentation LUT</td>
<td>Identity</td>
<td></td>
<td>Not used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Illumination Set presentation LUT illumination field to the defined value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Default is 2000.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Reflection Set presentation LUT reflection field to the defined value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Default is 10.</td>
</tr>
<tr>
<td>Session options</td>
<td>Film session options</td>
<td></td>
<td>Copies The number of copies to request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Destination If the DICOM printer supports multiple destinations, indicate which one to request.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Priority Specify the print priority, if supported.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Owner Indicate the owner of the print job.</td>
</tr>
<tr>
<td>Annotation options</td>
<td>Annotation</td>
<td></td>
<td>Submit this value to the printer to use as annotation. The application of this string depends on the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Prepend date Prepend the date to the annotation added by the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Prepend printer name Prepend the printer name to the annotation added by the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Prepend illumination Prepend the illumination information to the annotation added by the printer.</td>
</tr>
</tbody>
</table>

Page 127
<table>
<thead>
<tr>
<th>Setting</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium type</td>
<td>Blue film, Clear film, paper</td>
<td>Specifies the type of medium to use in the print request. The application of this value depends on the capabilities of the printer.</td>
</tr>
<tr>
<td>Film session label</td>
<td></td>
<td>Print this value as a header to each sheet printed. By default, this contains the information specified in the print header defined on the Customize Settings’ DICOM field page.</td>
</tr>
<tr>
<td>Others</td>
<td>Film size ID</td>
<td>Specify the default film size.</td>
</tr>
<tr>
<td>Magnification</td>
<td>Printer specific</td>
<td>Specify the default zoom factor applied. This is in addition to any zoom factor already applied to the image when it is loaded into the print panel.</td>
</tr>
<tr>
<td>Smoothing type</td>
<td>Printer specific</td>
<td>Specify the smoothing algorithm to use when interpolating the data.</td>
</tr>
<tr>
<td>Border density</td>
<td>Printer specific</td>
<td>Specify the density of the border. Usually a value of BLACK or WHITE is sufficient.</td>
</tr>
<tr>
<td>Resolution ID</td>
<td>Printer specific</td>
<td>Specify the resolution identifier.</td>
</tr>
<tr>
<td>Config info</td>
<td>Printer specific</td>
<td>Printer-specific configuration parameter to send to the printer.</td>
</tr>
<tr>
<td>Empty image density</td>
<td>Printer specific</td>
<td>Optical density to use in areas where no image exists.</td>
</tr>
<tr>
<td>Max density</td>
<td>Printer specific</td>
<td>Maximum density to use when printing.</td>
</tr>
<tr>
<td>Min density</td>
<td>Printer specific</td>
<td>Minimum density to use when printing.</td>
</tr>
<tr>
<td>Image box magnification type</td>
<td>Printer specific</td>
<td>Override the default magnification for a specific image.</td>
</tr>
<tr>
<td>Image box smoothing type</td>
<td>Printer specific</td>
<td>Override the default smoothing type for a specific image.</td>
</tr>
<tr>
<td>Image box config info</td>
<td>Printer specific</td>
<td>Override the default printer-specific configuration parameter for a specific image.</td>
</tr>
</tbody>
</table>

The one notable print setting is the header used on the printed sheet. The default print header is defined on the Customize Settings panel, under the DICOM Fields tab. Change the default string by editing it in the print panel. Whatever appears in this field will appear at the top of each sheet of film. In order to appear on the film, the DICOM printer must support the Field Session Label feature.

After selecting the printer, the layout and confirming the printer settings, if necessary, click on Print to initiate the print job. A popup window appears notifying you that the print request is in process. Depending on the type of printer, a print request may take a long time. When the printer confirms it has received all the information and can proceed with the print job, eRAD PACS pops up a notice indicating the request is complete. If any errors occurred, an error message appears.

It is possible to obtain detailed information exchanged between the eRAD PACS viewer and the printer during a DICOM print session. This is only necessary when some anomaly occurs, and the print request failed. To enable print logging, open the Customize Settings window from the Settings menu, and go to the Advanced page. Make certain the value in the Keep the last N DICOM print log files is greater than zero. Print logs are stored in the c:\Program Files\PracticeBuilder\dicomprint\logs directory. If print problems exist, a customer support representative may request these files.

11.3.1 True Size Printing

eRAD PACS supports true size printing via its DICOM print interface. The parameter in the printer-specific section(s) of the DICOM Print configuration file, *TrueSize*, controls this setting. Refer to the the eRAD PACS DICOM Printer Configuration Manual for details on DICOM printer configuration. When set to “true”, print jobs submitted to this printer will be printed true size. To override this setting, open the print panel click on the DICOM Settings button, and on the Film tab, check the True Size box to print the image(s) in true size, or clear it to let the print size the images accordingly.
11.4 Windows Printing

When printing to a Windows printer, select Windows in the print panel. The printer and printer settings are available from the Windows print panel that appears after clicking the Print button. The print layout settings are available from the print panel.

The rows and columns settings applied to the print request are available on the print panel. Select the number or rows and columns you want to appear on the printed sheet. Note that the images displayed in the print panel do not necessary conform to this setting.

The default Windows printer settings are configurable for each modality type. To modify the built in default values, do the following:

1. Select File→Print to open the Print Panel.
2. Select Windows as the printer type.
3. To configure default settings, click the Settings button. The Windows Printer Settings panel pops up.
   a. In the Settings For list, select the modality. Use Default to configure the system default values.
   b. To use the modality-independent values for the selected modality, check the Use Default Settings box. Otherwise, define the settings for the selected modality. The available settings are:
      i. Cols – number of columns on each sheet of film/paper.
      ii. Rows – number of rows on each sheet of file/paper.
4. To override the default rows and columns settings, select them from the Rows and Cols fields on the print panel.
5. Click OK.

To preview the print results, click on the Preview button. In the popup window, select the printer and click on OK. A new popup appears showing you what the results should be on the selected Windows printer. You can either select to continue the print from this point, or cancel out to return to the eRAD PACS print panel and click on Print to execute the print job.

11.5 Printing Reports

eRAD PACS can print a copy of the report directly from the viewer to a printer connected to your PC. To print the report, open the full report panel. From the top of the report panel window, select Report and then click on Print. Your standard print window will appear. Click on OK to send the report and the attached key images to the printer.
12 Online Help and Troubleshooting

eRAD PACS viewer has integrated help files explaining the features and functions of the software, plus data collection capabilities when more in depth assistance is required.

12.1 Online Help

eRAD PACS provides an online help system that provides assistance to users while they are using the interface. The online help contains a searchable database containing information on many topics and features, plus a summary of the latest features available in the viewer. From the online help, you can also obtain details on the version of the eRAD PACS viewer you are running, which can be requested if you need to contact support for assistance.

In the event the online help does not provide enough information on the requested topic, please consult the written documentation.

To display the release news, select News from the Help menu. A window appears containing links to a number of subjects, arranged in functional groups. To obtain details on any particular topic, click on the link.

To display the complete help system, select Contents from the Help menu. A window appears consisting of some tabbed pages. The Contents section is an organized collection of the help subjects. This information is useful if you need to obtain an overview of some area of eRAD PACS. For information on a single topic, select the Index tab, and type the subject in the field provided. When you find the specific, double click to open the detailed information on the topic. To get back to the Index, select Help Topics from the details page.

To obtain details about the specific version of the eRAD PACS viewer installed on your workstation, select About eRAD PACS from the Help menu. If asked by a customer support representative which version of the eRAD PACS viewer you have installed on your machine, provide the version number (and the build revision if specified) listed in the popup window.

12.2 Activity Logs

Activity logs record every action performed during a viewer session, including user profile details and information about studies loaded into the viewer, and ending when the session ends. This information is used by support to replay the entire viewer session, to determine what actions were performed and reproduce an anomaly, if present.

Since activity logging can negatively impact the viewer’s performance, it is disabled by default. Enable it from the Settings page in Customize Settings. Check the box labeled Create Log Files. Log files are stored in C:\Program Files\PracticeBuilder\PLogFiles. The filename contains the starting date and time of the viewer session. Log files are purged when they are four days old, or one day after being uploaded to the server.

eRAD PACS servers version 6.0 and later automatically upload activity logs to the server when the viewer encounters an ungraceful termination, i.e., when the viewer crashes. The viewer takes longer to load the first time after a crash because these logs may be large, or the network upload speed may be slow. Uploaded log files are appended with the extension .sent. Support can access uploaded files from the server. Files that were not uploaded, specifically when using an eRAD PACS server prior to version 6.0, have to be collected by the user and sent to support, when requested.
12.3 Crash Logs
When the eRAD PACS viewer experiences an ungraceful termination, it can create a crash log. This log file contains details about the viewer session and the point at which it terminated. Crash logs are useful for support in identifying causes for unexpected anomalies in the viewer.

Crash log generation is enabled by default. To change this setting, clear the checkbox labeled Create Crash Dump on the Settings page in the Customize Settings window. Crash logs are stored in C:\Program Files\PracticeBuilder\PBLogFiles. The crash log contains the starting date and time of the viewer session. Log files are purged one day after being uploaded to the server, or not at all.

eRAD PACS servers version 6.0 and later automatically upload crash logs to the server when the viewer restarts. Uploaded crash logs are appended with the extension .sent. Support can access uploaded files from the server. Files that were not uploaded, specifically when using an eRAD PACS server prior to version 6.0, have to be collected by the user and sent to support, when requested.